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NETWORKING SITE FACEBOOK last month sold a mere
1.6 per cent of its stake to Microsoft—for a substantial
$240 million. The valuation of the popular social net-
working site was pegged at $15 billion. Compare that
with Netscape’s valuation of $2 billion in 1995.

I’m wondering what the valuation indicates.
Could numbers put things in perspective? 

A recent report by UK-based Datamonitor, a
provider of online database and analysis services,
stated that social networking sites will sign up 230
million active members by the end of this year,
attracting new users until at least 2009. The report
titled The future of social networking: Understanding
market strategic and technological developments also
says revenues from social networking services will
go to $965 million this year, to go up to $2.4 billion
by 2012.

Even so, investors in such sites are wary because
long-term growth here is not a guarantee. The report
predicts that growth—in terms of the number of users
signing up—will peak by 2009 and plateau by 2012.

I’m naturally reminded, by this hype, of the dot-
com boom. There are two reasons. First, about net-
working sites currently being fuelled by innovation
around the communication possibilities—can it pos-
sibly be wise to base a business strategy purely around
innovation potential? It doesn’t seem like the sites
can ensure a prolonged period of sustained innova-
tion; so what are Microsoft and the others thinking?

Second, are advertisers willing to spend enough
on networking sites? In fact, do these sites even have
an advertising revenue plan? Facebook’s current
advertising strategy is that it’s developing an adver-
tising strategy... 

Most importantly, these are personal spaces.  Adver-
tising is likely to only distract from, if not disrupt, the
experience.

During a panel discussion of advertisers at a
recent Internet summit, some expressed apprehen-
sion in regards to associating their brands with the
possibly risqué or inappropriate material that gets
generated on such sites. Even if the sites do get adver-
tising, it will, like I said, very probably just annoy site
members and make them migrate to a new one. There
are as many social networking sites as Web mail
providers, it seems; besides, the loyalty and stickiness
of this internet generation is not a given.

Michael Cassidy is president and CEO of Under-
tone Networks, an online ad network. It was he who
gave Netscape the valuation I mentioned. He has now
said in an interview that it is a “big waste of money”
for advertisers to buy ads on social networks like Face-
book and MySpace. Users of those sites “are going
there to interact with their friends and play with their
profile,” he says. “They’re not in the frame of mind to
respond to an ad.” Yes, frame of mind. Take a look at the
now ad-saturated MySpace and you’ll see what I mean.

Ultimately, are social networking sites really the
next-generation portals, or flash-in-the-pan commu-
nities? We can’t make a comparison to the dot-com
event, really; things have changed a lot. From the hard
facts, all we know is that it could turn out either way.
Some—like Microsoft and Google—are betting on the
former possibility. I personally wouldn’t, but it’ll be
interesting indeed to see how it turns out. A new
chapter in Web history might just begin.

editor@thinkdigit.com

Editorial

Deepak Ajwani Executive Editor

Questioning Values

“Are social networking sites really the
next-generation portals, or flash-in-the-

pan communities?”
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to us about
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24
Sadly, more
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it jinxed?
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UMA on your
phone? Find
out if it’s a
good idea!

DIGITAL PASSION
Festive Special
Festive Shopping
Ho-ho-ho (in a desi accent)... ’tis the festive
season, and weep as it might, your wallet’s out.
Here’s exactly what to buy—for yourself or for all
those expectant faces around you 

DIGITAL TOOLS

34

42
Lead Feature
Clickety-Clack:
Googlewhack!
Here’s our Cover Story for this month—a
serious look at what one Indian security
analyst claims is a flaw in Google’s AdSense

25

Enhance
An Improved Office
MS Office is good as it is, and few will dispute that.
But how about slapping a few small things onto it
that will make it—and you—even more productive?
No coding required!

45

Test Centre
The Silicon
Ecosystem
Motherboards and processors
go together—compatibility, optimum
performance, and so on. So here’s
The Great Big Huge Annual
Computer-Fundamentals Shootout!
Besides, it’s the festive season, and
what better time to get a new
computer? (Happy in the knowledge
that you’re making a sound
decision?) Turn to the page!

Bazaar
Featured this month in our
ever-popular products
section: an odd phone, a
weird MP3 player, the
Sennheiser PXC 440
(circumaural), a ViewSonic
projector—and more. You’ll
want to whip out your wallet—
guaranteed!
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Create A Context Menu
Item To Mail An IE Page
Yes, that’s right. And it’s not a trick question—
there is a solution! Not all that useful a
function, but a toughie to crack nevertheless
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but most of us don’t know how
the well-known “silicon chip”
becomes what it is: a real,
working component of a
computer! Well, here’s the story

Droolmaal
An eclectic collection of stuff this month to just ogle at and
forget—our Droolmaal regular. Featuring a new UMPC, a
“portable DJ-ing system,” a porsh gaming wheel (pun
intended), and more—including a luscious cooling system

Tips & Tricks
We go the Flash way this month: something to get
you started with that just-got-to-love-it piece of
software. Then, we demystify all those terms you
come across in Media Player Classic—not to forget
more tips on Windows Vista

40

85

Enter

50
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Get Noticed, Get Clicked
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Learning To Share
Proxy servers are—or should be—used in all
businesses. We’ve spoken about this before, but
here’s a solution for smaller businesses. It uses a
software called Proxy+

108

103
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Are IT recruiters getting the
idea that on-paper
qualifications don’t mean as
much as they used to? Here’s
what some recruiters—of
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experience—think
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More
Tech needs to trickle
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to those who need it
most: the tillers of the
soil and the harvesters
of the sea. Learn how
this is being done
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is, well, just the second
episode—don’t expect too much. But
Portal, Lost Planet and World in
Conlfict are fresh as daisies—and
they won’t disappoint
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We’ve got some pretty overdone stuff this month—sorry!
McCartney is back, now with guitar lessons, and there’s
news about another leaked video (which is said to be “hot”).
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MULTIMEDIA
SONY Vegas Pro 8.0 Build 144

Combines real-time SD, DV and HDV
video editing with unrivaled audio tools
to provide the ultimate all-in-one
environment. Install the .net 3.0
Framework from this DVD before
installing Sony Vegas

Claymation Studio Trial 

Claymation Studio helps you to easily
create stop motion videos.. Capture
images using a digital camera, webcam
or DV camcorder, create characters,
apply small changes, and add background
images and music to create your own
claymation movies.

Comic Book Creator—Self
Publishing Software 1.04
Add text bubbles to your digital
screenshots, as well as classic comic book
features like POWerful action-word
graphics that emphasize the game play.
Select from one of the 500 unique layout
and design templates; drop in your
captured digital images; and insert text

bubbles, icons, captions, and clipart to
bring to life whatever story you can
imagine. Comic Book Creator will work
with any JPEG, BMP or GIF digital image.

■ CyberLink PowerDVD 7
■ Recomposit 1.9
■ Site Studio 6 Pro
■ Toon Boom Studio 4

SYSTEM
Nero 8 8.1.1.0 Ultra Edition

Using Nero 8 Ultra Edition you can now
create and edit, convert and share, rip
and burn, backup and protect your digital
media, all from one easy-to-use interface!

Parallels Workstation
2.2.2204

Parallels Workstation is a powerful
desktop virtualization solution that
empowers IT professionals with the ability
to develop, test and deploy in multiple
operating systems on a single PC.

■ .net Framework 3.0
■ Norton AntiVirus Definitions 9/30/07
■ Office 2003 Service Pack 3
■ FileSee 6.30
■ NOD32 AntiVirus 3.0.414
■ Norton 360 1.0 Final

■ NovaBACKUP 8.0

INTERNET
HP Smart Web Printing 2.0 

“This enhancement to Microsoft Internet
Explorer improves upon IE’s ability to
print what you see on the Web page. HP
Smart Web Printing allows users to:
Select text and graphics easily from any
web site and save a handy list of
clipsSave paper by combining portions
of numerous web pages Preview and
modify clips before printing “

Joost for Windows 1.0 Beta

Joost is a new way of watching TV on the
Internet. You get all the things you love
about TV, including a high-quality full-
screen picture, hundreds of full-length
shows and easy channel-flipping.

■ BitTorrent Mp3 2.5.7.0 (Adware)
■ Skype Recorder 1.2 
■ VoiceMask Pro 1.2

FREE
Dance Mela
Dance Mela is India’s first Multiplayer Online Dancing Game.
Groove to the latest Bollywood hits. Enter the never-ending
party. For Digit readers only: Register at
http://dancemela.kreeda.com/partner/digit/ to get your
free points!

FREE
Vega Strike
Vega Strike is an Open
Source 3D Action-Space-
Sim that lets you trade,
fight, and explore in a vast
universe.

DEMOS
Escape from
Paradise City
The demo gives
players a taste of the
upcoming game which
combines RTS and RPG
elements against a
backdrop of a crime-
infested seaside city.
In the two available
demo missions, taken
directly from the
campaign, players will
be challenged to take over neighborhoods infested with vicious
gangs while earning new skills and hiring henchmen in your quest
to take over the city.

PERSONAL
Lotus Symphony

IBM Lotus Symphony offers
something for everyone—a
community-oriented site, a
template gallery, and tips and
support to help you succeed. Lotus
Symphony supports Microsoft
Windows and Office applications.

Peanut Butter PC 2.2

Peanut Butter PC is used by
parents, grandparents, schools, and
daycare centers. Peanut Butter PC
lowers the barriers to learning by
creating a straight-forward, kid-
friendly interface for your PC.
Adults and children can learn how
to use Peanut Butter PC quickly and
easily without any training.

■ 3D Topicscape Student Edition
Beta_1.0

■ SoftMaker Office 2008 Beta
■ AstroGrav 1.4.2
■ IngoLingo 1.02

DEVELOPERS
KompoZer 0.7.10
KompoZer is a
complete web
authoring system that
combines web file
management and easy-
to-use WYSIWYG web page editing.

■ Microsoft Insider: Bonus Insider
Tip SP1

■ PyPE 2.8.7
■ PostgreSQL Code Factory 7.5.0.1
■ NAntBuilder 1.0
■ RJ TextEd 4

Productivity

Tools

Gaming
FREE

Points for
Digit

Readers!
DUAL LAYER

8,700 MB Of Quality Content!
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INTERACTIVE

MOVIES
Utopia

Utopia is also known as “Atoll K” and
“Robinson Crusoe Land.” This is last film
Laurel and Hardy made together. It was
filmed and produced in Europe in 1951.

MUSIC
Sophomore Jinx by Rob
Costlow—Solo Piano

The artist’s description: “Sophomore Jinx
is my first professional recording effort.
This album is about second chances,
hopes, dreams, and following my
passion.” Preview this album in the Digit
Media Player

Peace in The Valley by
Jennifer Avalon
A collection of songs that are both
spiritual and thought-provoking. A
journey through life, love,
disappointment, triumph and rebirth.

Live at Wood Hall (originals)
by Allison Crowe
Live at Wood Hall is a journey through
the artist’s concert repertoire, recorded
at the Conservatory of Music, (a
converted church chapel), in Victoria,
British Columbia, Canada in March,
2005. Alongside more than an album’s
worth of original songs of love and hope

to social and political commentary,
Allison covers her favourites—in a range
from rock and pop through roots and
blues, folk, jazz and more.

Samadhi by SaReGaMa

The artist’s description: “Samadhi is the
highest state of mental concentration or
absorption that a person can achieve
while still bound to the body and which
unites him with the highest reality”

Wild and Free by DEREK

Wild and Free is an instrumental
compilation of various feelings. An
invitation in the journey where the west
and the east merge varied atmospheres
with guitar for witness.

Entertainment

FREE
Tower Of Goo

The basic aim
of the game is
to build a
tower made of
droplets of
goo (which
you are able
to stretch into

beams of goo to support your tower).
The higher your tower, the better.

■ Letteria
■ Madness Interactive
■ Motocross The Force
■ The Euchmich Legacy
■ Well Of Souls

DEMOS
Scavenger

One human,
one droid and a
Scavenger class
space ship.
Enter the Star
Hulk Icarus on
one last
mission: to

locate and capture the Energy Source.
It was to be a simple job, but nobody
mentioned the alien mass spreading
across the massive vessel’s interior.

MUSIC
Thread Soul by Revolution
Void

Revolution Void
combines electronic
music with live
improvisation to
create a style of
music called

electronic breakbeat jazz.

We Edit Life
The creator’s
description:
“Experimenters in
visual perception are
using computers to

create weird and random patterns that
never occur in real life to find out what
and how people see when these
patterns are shown to them. The art of
computer graphics is only in its
infancy yet it is already stimulating
creative thought in far out areas
where research is likely to get complex
and unwieldy. If offers not only the
means to quicken the pace of
discovery but an ideal of
communicating what we may discover”

MULTIMEDIA
ReValver Mk II

ReValver Mk II is a second generation
guitar amp modeler. It models several
“classic” amps with a lot of detail, and
most of all, capturing the true nature
of the vacuum tube sound. Over 15
programmable features of each tube
stage can be set with a graphical
interface. Every tube in all amps can
be tweaked. As many as 17 tube types
are included to choose from.
■ AVS Audio Editor 3.6.1.30
■ CoffeeCup Flash Firestarter 7.1
■ D’Accord iChords 2
■ Nendo
■ Virtual DJ 5

SYSTEM
Exposer for Windows
Exposer is the revolutionary way to
visually represent all the open
windows on your desktop and expose
them to you.

■ ATI Catalyst
■ CDBurnerXP 4.0.015.277
■ Double Driver 1.0
■ Folding@home for Windows XP/Vista
■ GPU 5.91 Beta 6
■ Mousotron
■ NVIDIA ForceWare
■ NVIDIA nTune
■ TestDisk and PhotoRec 6.8 Beta
■ Vispa 0.1.1
■ Wubi 7.04.04
■ CopyToDVD
■ Desktop3D 1.5
■ SlyControl
■ SpeedCommander 12.00.5130 Beta 3
■ WinForcer 3.2
■ WinPatrol 2007

INTERNET
Orbit Downloader 2.1.5
Orbit Downloader, leader of
download manager revolution, is
devoted to new generation web
application downloading to make
downloads easier and faster. It is a
free all-in-one downloader which can
download streaming media, social
music or video from anywhere
include YouTube, MySpace, iMeem,
Pandora, etc. 

TOOLS

ENTERTAINMENT

GAMING

Ashampoo Burning Studio 2008
Ashampoo Burning Studio has changed the way
CD/DVD/Blu-ray burning software works. 

Ashampoo Office 2006
With Ashampoo Office 2006 you can get your
work done faster, with higher quality and for a
fraction of the cost of some other office suites.

OPENSUSE 10.3 (DVD)
openSUSE provides everything today’s Linux user needs for home computing and computing-on-
the-go. This product includes a Linux operating system plus dozens of essential integrated tools
that showcase the latest that open source has to offer. Boot from this DVD to install openSUSE.

Movie
of the
Month

ENTERTAINMENT

FREE
for Digit
Readers!



By Demand
You get to choose what goes
on Digit Interactive. This
month, you chose:

Sony Vegas Pro 8.0
Size: 73 MB  

OpenSuSE 10.3
Size: 4.1 GB

taste technology at www.thinkdigit.com

This Month’s Question                                                 Vote at www.thinkdigit.com

What do you think of government-imposed security measures in cyber cafés,
such as key loggers, ID checks, and security cameras?

Digit Reader Poll

They’re important for homeland security
They intrude on our privacy
ID checks and cameras are good, key loggers are not
Corrupt government officials may misuse our data

Subscribe
No more snail-mail! No need to visit
post offices! All you have to do is log
on to www.thinkdigit.com/subscribe
and use your Credit Card to make
sure you never miss another issue of
your favourite magazine!

Web Special
On The Lot
All the gear you need to
make your first open
source movie
(Log on to www.thinkdigit.com)

What is your opinion about owning a laptop?

Last Month’s Question

To
ta

l: 
40

32

I have one,
but I use it
quite like a

Desktop
39.41%

They’re
only a style
statement—
not for me
15.52%

I own one and
use it a lot on

the move
17.88%

For a reason
other than
above, I don’t
plan on
getting one
27.2%

Online

FEATURED TUTORIAL FROM DIGIT FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
This month we feature a member tutorial from the forum here.

Create an invisible folder
You ever have a folder on your computer that you really
dont want any one to find? You can make this folder
hidden but then you have to un-hide all the folders
when ever you want to find it. So how can you make a
folder truly invisible? Follow these simple steps and your
unmentionables will stay that way.
1. Right-click where ever you want the invisible folder to

be and select create a new folder.
2. Right-Click on the folder and hit rename. Erase the

name of the folder so there is nothing there.
3. If you try to stop here windows will tell you that you

need to provide a name. So to get around this… with
the name field still active hold down ALT and press
0160 on the number pad (make sure
Num Lock is on), release alt

You should now have a blank name
with nothing but a folder next to it
4. Now click on the nameless folder and

right-click. Select Properties.

5. Go to the Customize tab.
6. Find and press the Change Icon

button. Scroll
through the icons
until you find one
that has no image.

7. Hit OK and you  
have an invisible
folder!
With the invisible

folder you can hide what ever undesir-
ables you have. Be it video games at
work, pictures of your family or any-
thing else you can think of “wink”.

The folder will show up for a brief second if you put
it on your desktop. For that reason it might be smart to
place it inside a folder or amongst a group of folders.

Happy Hiding!
For more visit:
http://www.thinkdigit.com/forum/showthread.ph
p?t=70402

11-10-2007,
10:23 PM

adiCted

Fresh Stock
Join Date:
Nov 2006
Posts: 9

TTuuttoorriiaall::  LLeeaarrnn  HHooww  ttoo  ccrreeaattee  aann  iinnvviissiibbllee  ffoollddeerr  
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The New-age Napster
Napster has changed its revenue model yet again. Now,
subscribers pay a monthly fee to access the catalogue.
Napster said mid-October that it is launching a Web-
based platform that will make Napster compatible with
any Internet-enabled device.

“YouTube Video Identification”
YouTube recently launched a copyright-protection
system for content owners in which they could send in
a master copy of their work, and any infringing videos
relating to that content could be taken off the site if
requested. The filter has received mixed reviews.

Every newbie who
installed Linux came
to know of it the hard

way—Linux needs stable,
working drivers for tons of
peripherals. The current
answer to this is the Linux
Device Driver Kit—
documentation designed by
the Linux kernel
community for
hardware
manufacturers.
Manufacturers could
also choose from the
nearest drivers and
reverse-engineer them to
work with the hardware.

This process was not
always fruitful.
Considering its small
user base compared to
Windows, not many
companies were
interested in dabbling
with Linux drivers. And
then, hardware vendors
have been wary of
opening up their
device designs or
Application Program
Interface (APIs) to the
open source
community. Another
obstacle is the fact
that most companies do
not favour drivers they
didn’t develop themselves.

Now, a project from
Novell is offering to write
free drivers—for any
manufacturer who is
willing to open up the
specifications of their
hardware.

It’s not a new project—it
was announced last year by
the main developer, Greg
Kroah-Hartman, a
programmer at Novell. But

mid-October, Kroah-
Hartman posted an update
on his blog, announcing
that Novell had moved him
onto the project full-time.

Kroah-Hartman is an
influential Linux kernel
hacker; his original blog

post called on
Linux

programmers
to offer their services

for free to any company
that wanted to write Linux-
compatible drivers for their
products. He also proposed
that all that was required
from the companies was
the specs, and perhaps a
technician who could be
frequently e-mailed when
help was needed. He
requested sample devices so
that debugging didn’t have
to be done over e-mail. And
what would the
manufacturers get in
return? A fully-functional

Linux driver that is added
to the Linux kernel
resource tree, and which is
updated with every kernel
revision.

Dangling the marketing
carrot, Kroah-Hartman
went on to say that since
the drivers would be

included in the Linux
kernel, it would be

supported by the
largest number of CPU

types in the history of
computing! 

For manufacturers
wary of sharing their
protocols and
specifications, Kroah-
Hartman clarified that if
required, companies
could approach the Linux
Tech Board to draft Non
Disclosure Agreements
(NDAs) for the
programmers working
on the drivers.
Companies that were
earlier apprehensive
of showing their
proprietary

protocols were now
allowing programmers full
access to their APIs under
the NDAs. Kroah-Hartman
and his team are willing to
sign NDAs for the actual
details of the devices that
the companies give out, all
the code generated will be
licensed under the GPLv2.
Manufacturers therefore
wouldn’t even need to
worry about supporting the
drivers; the community
would take care of that
(since the drivers would be
incorporated in the kernel).

Some Linux community
members are apprehensive,

Enter
DRIVING LINUX

Dumping The Linux Device Driver Kit

■ XBox Live service launched in India ■ Facebook founder Mark Zuckerberg most influential in tech industry, says Silicon Research ■

Vinay Goel
Head of Products

Google India

The Google SMS service has been
launched in India. You can now
send directory-like search queries
to Google via SMS from any
handset—find a pizza outlet near
Peenya, Bangalore, by sending an
SMS to 54664 with the query:
“pizza near Peenya Bangalore”!
We asked Vinay Goel of Google
India about related issues.

Will you extend the service to
smaller cities too? By when?
For now we’re focusing on
Bangalore, Delhi, Hyderabad, and
Mumbai, because users here will
have the fullest access to
information through the service.
Google SMS is also available in
other cities, but not all the search
categories will be immediately
available. As we get more user
feedback, we will add more cities.

Any tie-ups to report?
Google SMS is currently available
on the Airtel, Aircel, BPL, BSNL,
and Reliance networks.

Apart from saving locations,
will the service store personally
identifiable information?
It will, as outlined in our Mobile
Privacy Policy—which can be
found at our Web site. Users can
opt out of personalisation by
sending “Save off” to 54664.

Any plans for a Web directory
service—like AnyWho.com, for
example—for India?
We have also launched Google
Local Search and Local Business
Center as a part of our efforts to
help users find locally relevant
info. This includes listings of local
businesses (movie theatres,
ATMs, restaurants, etc.), weather
forecasts, and more. Local
Business Center allows business
owners to add/edit their business
information for free using a Web
interface—www.google.com/
local/add—so their listings are
easily found by users. 



though: they argue that
any future programmer
updating the Linux kernel
drivers would need the
same level of
understanding that the
original driver developer
received by looking at the
manufacturer
specifications.

It goes to be seen how
far this Linux initiative will
go, but this move by Novell
is, in general, great news
for Linux users—and could
certainly mean better
device support on
various distros. 

GAME BLAME

Chinese
Universities
Ban Personal
Computers

Games like EverQuest
are all the rage in
China, and as you

might have a clue about,
the authorities aren’t very
happy about it. China being
China decided to do what it
does best—apply a ban. So
later this year, when
students join college for the
first time, they will not be

allowed to bring their
laptops or PCs with them—
at the country’s top three
universities: Zhejiang
University, Nanjing
University, and Shanghai
Jiaotong University. The ban
is applicable to all first-year
students, irrespective of
whether or not they are
doing a computer course.

The ban seems rather
unenforceable, considering
that quite a few students
have found ways to install
the games on computers in
university labs (ostensibly so
they can play them at
night). 

A small poll conducted
at Shanghai Jiaotong
University revealed that the
ban will have no effect
whatsoever: after having
spent a year playing the
games in clandestine
fashion, we presume, most
of the students polled plan
to get their laptops or PCs
the next year and continue
with their gaming. Some in
China believe the only way
to be rid of the “menace”—a
word the authorities in
China seem to like to use—is
to approach the root of the
problem and educate
youngsters on the perils of
continuous gaming.

This is not the first time
China has proposed a ban

on gaming—with the hope
of creating the perfect
working-class society. Back
in April, the government
hoped to limit the number
of hours kids spent 
on online games by
reducing game credits for
excessive play.

Essentially, China is
trying hard to wean its
citizens from dependence
on computers and get them
to be more responsible in
the real world. Of course,

Mail,
unlimited
Yahoo!, Rediff,
and Zapakmail
have announced unlimited 
e-mail storage space.
Microsoft bumps it up to 
5 GB for Live Mail. It’s 
pretty much the same old
storyof catch-up.

Stuck on old glory
Gmail, the
original
catalyst of
large
inboxes,
recently upgraded its space
to (just!) 4 GB in spite of
rumours speculating a 9 GB
upgrade. Leaves us not a
little surprised—haven’t they
been following the news?
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Skype Targeted
Skype has reported a
vulnerability that can be
exploited by a Trojan.

The PWS-Pykse Trojan relies
on social engineering
techniques to trick the victim
into executing it; it is usually
posted on dodgy sites or
forums. The Trojan has also
been known to spread through
IMs and spam.

It appears as an installer
with the Skype logo and named
“SkypeDefenderSetup.exe”. It
infiltrates systems when
downloaded.

A fake Skype interface
appears with the username and
password fields. On entering the
details, a message appears:
“Your Skype username and
password are not recognized.
Please check and try again”.
And while the user keeps trying,
the Trojan sends the user’s
Skype credentials along with
other logins and passwords
stored in Internet Explorer to
the attacker.

The Solution
There’s only things you can do—
update your virus definitions,
and avoid clicking on instant
messages with links or read
spam (you wouldn’t, of course).
In addition, just be wary of
installing any add-ons to Skype.

What do you think of government-imposed security measures in cyber cafés, such as key loggers, ID checks, and
security cameras? (You, too, can participate in this poll—at www.thinkdigit.com)

They’re important for homeland security They intrude on our privacy

ID checks and cameras are good, key loggers are not              Corrupt government officials may misuse our dataDC

BA

(You, too, can participate in this poll—at www.thinkdigit.com)

Opinion Poll

I don’t like the idea of passing my personal
details to a stranger. The owner of the
cyber café could forward the
logged information to telemar-
keters for quick money. And I
don’t think key loggers would
help track a terrorist.
Saurabh
Mumbai

C, because I do not think these measures
will help in tracking down a criminal.
These measures are simply a
pain for ‘normal’ users and
personal information could be
misused, leading to harass-
ment or even blackmail.
Rajbir Singh 
Ludhiana (Punjab)

B is a good option. I think the Government
should have a database of verified users.
When a user logs in from a
public system, he should need
to enter his username and
password to log on to the Net. I
don’t like cameras monitoring
me but I can live with them.
P C Shyamshankar Chennai

It’s C for me. I don’t think these security
measures will help in any way. Cyber cafés
will never turn away a cus-
tomer for not producing an ID.
Key loggers may already have
been installed by cyber café
owners illegally.
Kaushik Patowary
Guwahati

B for me. It’s difficult to track down the
culprit if a public computer is used.
Checking of ID is extremely
important, but storing and
retrieval of video from CCTV
could be difficult. 
Yash Maheshwari 
Nagpur

D! I do think the information will be mis-
used. But if implementation of such security
measures is stringent, it will
scare away unethical users
from using
cyber cafés.
Naveed Patel
Casanova
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one could think up theories
of all sorts—get rid of the
Western Influence, perhaps,
or get citizens to believe in
the virtues of regimented
hard work. In any case, half-
baked laws like this one can
only lead to what any old
ban means—Work Around.
But do not forget that the
Chinese government, while
progressive, still wields
power of the sort that can
say, “No more games.” Or
perhaps “No more
American games.”

WE SAW THIS COMING

Health
Records Go
Online…?

Imagine a family doctor
looking up your medical
history online after

you’ve gone to him or her
with a complaint. On the
face of it, it seems a good
idea: everything is
categorised, your doctor
needn’t ask you for too
much extra information,
and so on. HealthVault, a

Web service Microsoft is now
offering, stores your medical
records online. For once, this
comes before—something
we’re now anticipating—
“Google Health.”

The site incorporates a
health-specific search engine
and lets you save your
searches.  The money will
come in to Microsoft
through health-related ads
on the search pages, but
those won’t be targeted ads—
for now. Access to the site
will require a Windows Live
ID and password, which you
can, of course, share with
healthcare providers.

Now the system just
allows you to enter personal
details along with medical
statistics like blood pressure,
blood glucose levels, and so
on. So what happens if you
enter something incorrect?
There’s no way a doctor can
add medical details to your
profile, so it’s hardly a
formal programme—the
information is unverifiable
by a medical expert. As a
matter of fact, the site
proclaims, “HealthVault was
built on the principle that
you should control your own
health records.” Unless we’re

missing something really
obvious here, we thought
doctors should tell us what
we’re suffering from.

In 2001, EPIC (the
Electronic Privacy
Information Center) filed
complaints alleging that the
Microsoft Passport system
facilitates online profiling.
EPIC claimed Microsoft
officials had stated that the
goal of the system was to
create a profile of every
Internet user, to “up-sell”
individuals to subscription
accounts, and to use
targeted advertising.

Some are alarmed: they
can see a problem with too
much information getting
online. It’s all usernames
and passwords as of now;
people tend to reuse
passwords—and then there’s
the idea, pretty much
Passport-like, that you
should have a single sign-in
for all your services. Perhaps
we’ll have something beyond
passwords when we get to
“single sign-on to the Web,”
but that’s another story.

“Whether you need to
search the Web for the most
up-to-date treatments,
catalog existing health

records, receive test results,
or monitor current physical
readings, HealthVault gives
you the control you need,”
goes the verbal jingle.
Search the Web? It’s been
reported that too many
searches bring up porn
results, even searches for
which Google’s general
search engine brings up
fewer porn results.
Catalogue health records?
Why, we do have paper and
files. Receive test results…
how about posting or
e-mailing them over?

It just seems a push to go
online, online, online—with
little justification or even
attraction. Along the lines of
EPIC, we don’t see much but
targeted advertising here.

CATCH-UP

Yahoo!—
More Google
Than Ever!

Various search engine
comparisons and polls
have been done by

people or bodies with

A Round-up Of Technology News From Across The GlobeThe Digital World

JAPAN
Under threat from the
Internet and problems
with maintaining the
home delivery system,
three leading
newspapers have
made an alliance to set
up a common Web site
for their articles.

SOUTH KOREA
Men are turning to the Net
and mobile phones for sex;
there are 11,724 sites and
mobile content operators
involved in prostitution—four
times that in 2005.

AUSTRALIA
The Government has proposed
an energy rating system for
TVs. Current plasma HDTVs
might soon be banned—a
majority of them guzzle too
much power.

SOUTH AFRICA
The Sunday Times now offers
news the easy way via Net-
connected phones. Readers
move their phone cameras over
the front-page bar code to get
access to the respective sites!

FRANCE
The Government is funding the
development of an open source
toolbar for Outlook and Thunderbird
so spam can be reported to ISPs
under a project dubbed Signal Spam.

RUSSIA
All schools in the country
will move to Linux by 2009.
Students as well as teachers
will soon be taught how to
work with Linux.

■ Reliance ties up with OLPC project to bring $100 laptops to India ■ USB drives to appear in record stores to build up sales of physical media
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Image Ashish Tripathy, Chennai

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 
C# 2005
by Adrian and Kathie
Kingsley-Hughes

Published by

Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

Digit Caption
“Quantum leap—from lap
to desk!”

varying authority, and
Google almost always comes
up tops—and, as you know
all too well, Live Search and
Yahoo! seem perennially
locked in a fight for #2.

But slowly and quietly,
Yahoo! is making
improvements to its search
engine, and that has not
gone unnoticed in the
Webosphere. The new
Yahoo! Search incorporates
some slick features which
bestow upon Yahoo! no
bragging rights.

Changes include the
Search Assist tool, a space
that shows up below the
search field and suggests
keywords as you type in
your query. Then there’s
integration of the user’s
query with Flickr photo
tags on the search results
page, audio snippets when
a music band or song name
is searched for, and the
inclusion of inline video
elements on the search
results page.

No-one is very
impressed, because even if
it’s cool, it’s been done
before. Google has had the
blended search option for a

while now. The Search
Assist tool is a clone of
Spotlight in AOL Search
and of Google Suggest, and
Ask.com’s Smart Box
features.

One thing must,
however, be said: in a
recent test conducted by
Web analysis firm
Compete, Yahoo!’s search
query replies generated
more clicks than Google’s
or Microsoft’s. Now how
many competitors are 
there to Compete, we don’t
know, so…

The company says more
improvements are in the
pipeline. We’ll look
forward to them.

SOON UP FOR GRABS

.Asia
Domains—
Finally

The Internet
Corporation for
Assigned Names and

Numbers (ICANN) recently
approved a proposal for

creating .asia as a top level
domain name by 6
December 2007.

Currently, registration
for that domain is limited to
businesses that can prove
they are functioning in the
Asia-Pacific region.
Registration can be done
from the 90-odd authorised
registrars in the region till
15 January 2008. After that,
businesses can register
without the need to prove
that they operate from the
region. Public registration
will begin by February, 2008.

It has been well planned
out. Registration being
limited to bona fide
businesses running out of
the region thwarts the
menace of cyber-squatting—
buying a popular-sounding
domain to sell it later at a
higher price. The ICANN has
decided to continue with
the practice of verifying the
business industry a buyer
belongs to before
registration of a site. All
.asia domain registrations
will be overseen by the non-
profit DotAsia Foundation. 

According to research
conducted by the ICANN, 11

percent of all domain name
registrations occur from the
Asia-Pacific region despite
the region having an online
population of 33 per cent of
all Internet users. The Web
arrived in Asia much later
than in the West; popular
.com and .net domain
names had already been
taken by North American
and EU users, therefore the
push for a .asia domain.
Moreover, it gives a geo-
specific flavour to
businesses. It is interesting
to note that .eu is the only
other regional, non-nation-
specific TLD.

FOR KERALA STUDENTS…

Free
Software
Becomes
Compulsory

The Director of Public
Instruction for
Education in Kerala

has issued an order
informing all schools in

Last Month’s Winner!
Ratish K P
Hyderabad

“CPU: Cool Paan Unit!”

■ Asus officially launches the Eee PC: Linux, 7-inch, Intel, 512 MB, less than 20K ■ China “hijacking” Google, Yahoo!, MS search sites, redirecting to Baidu
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the state to start computer
classes from standard VIII
onwards on open source
software. This comes a year
after the Kerala
government declared that
all schools in the state
would only run on open
source software.

Till last year, schools
had the freedom to
conduct computer
examinations based on free
or Microsoft software.
When the computer
literacy program—
Akshaya—was started in
schools all over the state in
1995, it used Windows.
Licensing costs of Windows
being too high, it was

shelved half a year later. 
Due to popular

demand, the government
had to reinstate the
programme using free
software tools that were
half-baked, not ready for
the classroom
environment. It was then
that the government
announced that all schools
would get a modified
version of open source
software suited for
classrooms within the
next year.

Currently, the schools
run a customised version of
Ubuntu called IT@School
GNU Linux Version 3.0. This
software is available to

students in classes VIII, IX
and X. The syllabus and the
question papers are either
biased towards free software
or they are platform- and
application-neutral. 

The Kerala government
is also doing its bit to
popularise open source
software like The GIMP
and OpenOffice.org by
arranging digital art and
presentation competitions
at the state level, and having
workshops on the
advantages of open source
software.

Open source software
(OSS) seems to be catching
on in India thanks to the
Central and State
Governments’ efforts. The
Karnataka government uses
OSS for all its computers. It
has also mandated the use
of Kannada software—
NUDi—to create government
documents in Kannada.
BSNL uses open source OSes
in all its offices around
India. The Kerala
government is also planning
to network all schools,
postal offices, and district
headquarters with a state-
wide wide area network.
Look at more e-governance
projects being taken up by
the Government at http://
egovindia.wordpress.com.

DOUBLING DRIVES

Storage In
The News—
Again

Western Digital
recently
announced the

world's highest-density
hard disk drive. It has a
capacity of 520 GB.

What’s special here is
that this was possible due
to recent successes in
reducing the size of the
head - the part that reads
and writes data to and
from off the disk surface.
As the size of the head
reduces, it can read from
denser areas of the disk,
thereby increasing the
amount of data you can
store on a platter.

Disk heads of today run
on the Tunnelling
Magneto-Resistive (TMR)
technology, that read and
write data using the
principles of
electromagnetic induction;
with certain advances in
nano-manufacturing,
Western Digital has been
able to shrink the head to
about 50 nanometres.

Hitachi—one of the
other pioneers in hard disk
technology—is, however,
sceptical of TMR for the
future; it has claimed that
TMR is impractical for disk
drives with a capacity of
more than 500 GB. Hitachi
has predicted that by 2011,
disk capacity will reach
4 TB.

This will, according to
Hitachi, be possible using
the 30 nanometre
manufacturing process for
heads. It also plans to do
away with TMR and use a
new technology based on
“Current Perpendicular-to-
the-Plane Giant Magneto-
Resistance” (CPP-GMR). This
will arrange data bits
vertically in smaller
crystalline grains that are
stable at room

Be it a digital camera, mobile phone, PDA, or other
such gadgets, you need to know about the compatible
memory card format. 

Universal Flash Storage (UFS) is a newly-proposed
open standards-based specification for the
standardisation of removable Flash memory. The
standard promises high data transfer speeds, fast
speed access to large media files, greater storage
capacities, and a decrease in power consumption—and
most importantly, it is hoped that it will become a one-

size-fits-all solution. Too good to be true? Could be.
Several mobile phone technology and semiconductor
companies support this specification, but many users
are sceptical—saying it’ll become just another format. 

Besides, what about the billions of gadgets and
consumer electronic devices already sold? Memory card
manufacturers make money off proprietary formats,
and they might not take to UFS too kindly… and we’ll
have to wait until 2009 for even the UFS specification
to get finalised.

Worldwide PC Shipments (in millions) Worldwide, each
day, about 40

billion person-to-
person e-mails,
17.1 billion auto-
alerts, and 40.5

billion spam
mails are sent.

Indian broadband
connectivity

methods: ADSL is
at 83%, followed
by cable at 10%

and Ethernet LAN
at 3.4%. And 1%

actually have fibre
connections!

Legacy data centres use 300
to 400 watts of power per
square foot, and by 2011 this
could rise to more than 600
watts.

Only one out of five PC
monitors sold in the
Asia/Pacific region
(excluding Japan) is now a
traditional CRT

■ Ubuntu 7.1 released ■ Die Hard DVD to also carry DRM-free AVI file ■ Apple to fire up Intel dual- and quad-core Penryn-based Mac Pros
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Universal Mobile Access
What is it?
UMA (Universal Mobile Access)
is a technology that allows you
to use your GSM phone on
accessible WiFi, WiMax, and
Bluetooth networks. The local
network devices become like
mini cell sites.

How does it work?
A UMA-enabled mobile has GSM
and Wi-Fi radios that can work
simultaneously. When the phone
moves into the range of a
Wireless LAN (connected to the
Internet), the user connects to a
UMA Network Controller (UNC).
The UNC authenticates and
authorises the user and updates
the IP and MAC addresses on
the central network of the
mobile service provider. This
done, all GSM services are
routed through IP to the
location of the user. The
switching of network happens
automatically and seamlessly,
without the user’s knowledge. 

Why will anyone be
interested?
UMA reduces the burden on
cellular towers, and covers
poor-coverage areas such as
inside buildings, tunnels, and
basements. It reduces
transmission costs of calls as
well. Customers see fewer call
drops, better voice clarity, and
increased browser speeds. 

Who developed it?
It is a standard accepted by
members of the 3rd Generation
Partnership Project (3GPP). 

Where is it currently
deployed?
T-Mobile has been providing
the UMA system in the US, and
now has 8,500 WiFi hotspots.
TeliaSonera, a telecom
company, provides the service
in Norway, Finland, and
Sweden.

When will you see it in
India?
We don’t know about other
manufacturers, but you can
expect to see India’s first
UMA-enabled Nokia phones in
the first quarter of 2008. 

temperature, and will
allow the creation of
denser drives that will also
last longer.

Back in June 1995,
Fujitsu had announced a
different method of
creating disk drives - by
using an anodised
aluminium coating. This
creates “nano-dots” on the
surface of the disk, which
are later magnetised to
store a single bit of data.
The anodised aluminium
protects each dot
individually, thereby
reducing the
chances of data
corruption. (This is
known as the
patterned media
approach, which
we’ve spoken about in
an earlier issue.)
Currently, the
company has
announced the radius
of each dot to be
around 25
nanometres. Fujitsu
aims to bring that
down to 13
nanometres, which
makes for 4 TB of
data per square inch!
The company hopes
to get this
technology out by
2010.

But while we’re
going on and on
about hard disk
technology, we’re
wondering what happened
to holographic memory!
Last we heard, there was a
lot of buzz around its
capabilities:
4 GB in a volume at the
millimetre range.

Daewoo Electronics had
also designed a working
prototype, and, indeed,
TDK came out with
holographic-storage disks -
but the drive is
ridiculously expensive.

In conclusion, it does
look like there’s plenty to
look forward to when it
comes to the good old hard
disk - it’s not going to die
anytime soon! Unless
there’s a breakthrough in
nanotube storage - but
that’s a big, big “unless.”

AHEAD OF ITS TIME?

Dump Vista,
They’re
Saying

The general consensus
in tech circles for
some time now has

been that Windows Vista
does not deliver what it
promised, or work how it
should, or satisfy. That idea
has now been reinforced by

the Dutch Consumers
Association: it has said all
computer outlets in The
Netherlands must provide
XP “downgrades” to all
Vista users who are not
satisfied with it.

As you might know, this
is not the first time a body
has said, in effect, “Perhaps
Vista isn’t good”; in April,
Dell had buckled (in the
US) under consumer
pressure to give users the
option to select between XP
and Vista after having
made Vista the only
operating system available
on new laptops and
desktops.

The fact that Microsoft
has extended the
availability of Windows XP

by five months—up until
June 2008—also isn’t going
to help the sales of the new
operating system. As if
attesting to the tech
community’s claim that
the OS was released before
it had been sufficiently
tested for bugs, the
company offered to give
disgruntled Vista
customers a copy of
Windows XP.

A recent survey by an
independent specialist
business and consumer
technology research

company, Context,
indicated that sales
of Vista have
actually dropped by
17 per cent in the
last few months,
contrasting with
steady sales of
Windows XP.

Vista has been
plagued by product
launch delays—the OS
was supposed to have
been launched in June
2006, and eventually
only became available
in January 2007—and
poorly-performing
drivers (such as those
for NVIDIA graphics
cards). Bucketsful of
bugs will be addressed
in Service Pack 1.

Vista critics stand
redeemed: Microsoft
plans to release Service
Pack 3 for Windows XP

by early 2008, which will
borrow features from Vista!

Microsoft’s constant
patch releases for the
seemingly ill-fated OS has
not stopped well-known
bloggers like Om Malik
from dismissing Vista as
being unstable and an
unnecessary upgrade.

“Reinstall XP, Remove
Vista,” goes the header of
one of Malik’s posts dated
May 2007. In fact, who has
said Vista is just great?
People know it’s pretty, and
some eminent Netizens
have said they’d gotten
“very used to it,” but that’s
about it. Still, Service
Pack 1 might just
change everything, let’s
not forget.

Illustrations Harsho Mohan Chattoraj

■ Apple opens up to developers—the iPhone and iTouch will get an SDK Feb 2008 ■ Users can now shape and share ideas in 3D in MS Virtual Earth
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“Google is God,” many are apt to
declare. And they are, really, close to
being right… in certain senses. For

example, you get a .odt file from someone
when you expected a Word document. You
scratch your head for a while—“open document
something?”—and then you give up and do the
usual thing: www.google.com. Type in just “.odt”
without the quotes, and you’re in business: a
link to a forum, a link to a page, and seconds
later, via a link you find, you have a Word doc-
ument. Try it!

Now go to, for example, Yahoo! Search. Otago
Daily Times. Not so helpful…? Next up: some
world maps. Not so helpful…?

That example graphically demonstrates why
Google is the most popular search engine. No-
one can say it is “the best,” because that’s a
much tougher question.

Now, back to the clicks: all this fabulous
search technology, all the power that Google
has come to be known for, all its great products,
rest on one edifice—its advertising pro-
grammes, AdWords and AdSense. (We’re
focusing here on AdSense.) It seems money is
just a click away—to be precise, a few thousand
clicks. Those clicks can be engineered.

The Working
For those of you hearing the word for the first
time, AdSense is Google’s word for the pro-
gramme whereby they place ads on a site or
blog based on its content. Anyone can have an
AdSense account, though to actually make
money off it, you’ll probably need a blog or site
with good, extensive content.

The concept is simple: after you sign up for an
AdSense account, bots “look” at your page and
place relevant ads on it. Those are the “Ads by

Shrikrishna Patkar

Clickety-Clack:
Googlewhack!

Lead Feature

Starting off from an Indian security analyst’s claim,
we try and look at exactly how secure
Google’s AdSense programme is
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Examples of invalid clicks, according to
Kamangar, include manual clicks on an ad to
purposefully increase the ad spend; deliberate
clicks on an ad to increase profits by site owners
hosting the ads; and clicks that arise from the
use of automated clicking tools, bots, or other
deceptive software.

The CEO
In May of 2005, Google CEO Eric Schmidt had
said, in regards to click fraud, as reported by
zdnet.com (emphasis placed by us): “One of
the great technical challenges, which our com-
puter scientists like, is detecting these at scale.
We have been able to detect them, so it
appears as though the problem, which I don’t
think will ever go away, is both manageable
and from a financial perspective at the com-
pany it’s not material.”

That was Google’s third lawsuit in the con-
text of click fraud. But 9th August, 2006, at the
Search Engine Strategies Conference, as
reported by Google themselves at google.com,
Schmidt was quizzed about click fraud by
David Krane, then director of Corporate Com-
munications at Google.

He had this to say: “As part of a litigation,
which was settled, we produced a technical
report which actually analysed this, which is
now public information. We also have chosen
to disclose what we estimate is the bad click
rate on a per advertiser basis… I’ve also been
misquoted by a number of people as somehow
saying that this was not an important issue. It
is an important issue that is under control. We
have very good technical people. We have very
good computers. We’re monitoring it. It’s not
material to the company. It is important, and
it’s not going to go away.

“It’s hard to know [the precise extent of
click fraud] because we only know what we
detect, but based on our estimates, the problem
is manageable. And we have a lot of ways of
detecting it, but I can’t make you an absolute
guarantee, because you never really know.”

In other places, Schmidt has been reported
as indicating that he didn’t think click fraud
was a big deal in the long run. He is quoted as
saying that the “perfect economic solution” to
click fraud is “to let it happen.” This is perhaps
what Schmidt was referring to when he said “I
have been misquoted…”

Schmidt’s theory, as reported in July 2006
at blogs.zdnet.com: “Eventually, the price that
the advertiser is willing to pay for the conver-
sion will decline, because the advertiser will
realise that these are bad clicks, in other words,
the value of the ad declines, so over some
amount of time, the system is in fact self-cor-
recting. In fact, there is a perfect economic
solution, which is to let it happen.”

We will not comment on Schmidt’s theory,
but during that “eventually,” advertisers are
paying for fraudulent clicks. Google gets
“smarter” with each breach—at the cost of
advertisers, of course.

And now, Manish Arora seems to have
come up with something they haven’t gotten
over yet...

Google” links you see. The advertiser pays Google
when someone clicks on one of his ads (on your
site). Google pays the “publisher”—that is, you—
some of that money, and keeps some for itself.

The Problem
The obvious thing here is, if clicks on ads mean
money, minds of the money-grubbing type find
ways to generate clicks. Well, if you’re the pub-
lisher, you can’t just click on your own ads,
sorry—Google just detects those as “invalid”
clicks. Tell your office co-workers to click on
them? Sorry again: same IP range, so they’re
detected as invalid. Yes, Google does keep
updating its technology to detect invalid clicks.

But it goes like this: someone—let’s call him
a hacker—comes up with a new technique to
make money off clicks. He uses his method and
makes lots of money, in the time that Google fixes
that newly-discovered problem with AdSense.
And in that time, the advertiser loses money.

Which, naturally, leads to lawsuits. You’ve
probably heard this headline at least once:
“Google sued for click fraud.” Click fraud is it: the
potential Google-killer. As a matter of fact, May
2004, there was this article by Garrett French
(Managing Editor of Search Engine Lowdown) titled
Click Fraud: The Google Killer. And the text went on:
“Google listed click fraud as one of the potential
‘worries’ that would-be investors should consider.
In fact, they admitted to regularly paying refunds
because of click fraud and stated that they may
have to make retroactive payments.”

Formally, from www.clickz.com, Yahoo! Spon-
sored Search defines click fraud as “clicks arising
for reasons other than the good-faith intention
of an Internet user to visit a Web site to purchase
goods or services or to obtain information.”

Google is more specific, defining click
fraud, “or invalid clicks, as any method used to
artificially and/or maliciously generate clicks or
page impressions,” as Salar Kamangar, Vice Pres-
ident of Product Management, once defined it.

In May 2006, the following appeared on networkworld.com: “Google has
agreed to settle a class action lawsuit brought against it over the issue of

click fraud, which some industry experts believe could seriously threaten
the company’s main source of revenue: pay-per-click advertising. Google
will pay as much as $90 million to affected advertisers in attorneys’ fees
and credits as part of the settlement.

“The case was filed in an Arkansas court against Google and other
search engine operators and providers of pay-per-click ads, such as Yahoo
and AOL. The lead plaintiff is Lane’s Gifts & Collectibles, which sells items
such as dolls, figurines and teddy bears online, over the phone and by
mail.” Now $90 million is material—refer Schmidt’s comments alongside.

On Google’s official company blog, Nicole Wong, then associate general
counsel at Google, wrote: “This agreement covers all advertisers who claim
to have been charged but not reimbursed for invalid clicks dating from
2002 when we launched our ‘cost per click’ advertising program through
the date the settlement is approved by the judge.”

It works the other way round, too. 15 November 2004, Google filed a
suit against an Internet operation that it claimed “systematically” (from
news.com) clicked on text ads. That case was amongst the first civil
lawsuits to relate to click fraud. It charged that Texas-based Auctions
Expert International signed up for a Google AdSense account, then
“fraudulently clicked on the ads to profit from its pay-per-click system.”

The Lawsuits
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Trying To Help
Arora is a security analyst. Google still doesn’t
seem to have been able to find a solution to his
method of committing click fraud—which he’s
reported to Google, and to no avail. It seems to
us that Arora has been doing this with entirely
benign intentions, but as a disclaimer, we must
say that we cannot verify every single fact.
However, we have little reason, from our inter-
action with him, that Arora ever had any inten-
tions to make money off AdSense.

We looked up the Net—in fact, we Googled
a lot—to see if anything similar to what Manish
did has been done before by anyone, and it
hasn’t, to the best of our knowledge. That said,
here’s the story.

Naturally, we can’t tell you how Arora’s
“AdSense Crack”—our term— works; but here’s
what happens. You have a blog. You sign up for
an AdSense account—for that, Google first
“approves” your blog for the programme. Once
they confirm that your blog is fit for an
account, your account is activated, and the “Ads
by Google” start appearing on your page.

And then, if you
have Arora’s script
(a set of commands
that automate a
task), you run it on
your site—any site
you own. You then
send out mails to
people you know,
inviting them to
visit—not your
blog—but just
about anything
they’ll find inter-
esting, like a
YouTube video, or
pics of yours, etc.
Those people you
mail don’t even
need to know about
the existence of

your blog (where the AdSense ads are).
When they click on your links and watch,

say, the video you linked to, Google credits your
AdSense account!

Yes, you read that right—read it again for
the full impact. The AdSense ads are on your
blog; you send links to, say, videos, to people
you know; they click and watch that video; and
you get paid.

Arora can control the scene, as it were: if he
chooses to, he can stop all activity by ceasing to
send out his mails. Google’s bots detect the
drop in click activity—and usually disable the
account. Arora can then open a new account,
and get back into “business.”

When he first created and ran his script, he
“made” thousands of dollars—“made” is in quotes
because he never actually took any of the money.

Google says he was lying, and that what he
claimed is impossible. Now Arora also tells us he
received gifts from Google—two, to be precise—
one of which is pictured on this page. It’s not for
us to decide if the picture has been doctored, but
let’s just leave it at “We don’t now.”

In November 2006, Arora to Google: “I
would be glad to provide you the complete
mechanism, which will take one hour a day to
produce thousands of dollars a month from
Adsense. I would like to explain this model to
any of your representatives.” And later the
same month, from Google to Arora: “We’ve
investigated your claim. At this point, all we
can verify is that our automated systems ter-
minated your accounts as a result of your
trying to inflate the clicks. This is exactly how
the system is designed to work. If (sic) supply
us with the code and technical details of the
method you mention below, we will investigate
further.” That was Cory Altheide, Incident
Response Lead, Google Security Team. We’ll
have more to say about this later.

Manish Arora, a security
analyst who claims it’s very
easy to make money off
Google AdSense

A map—followed by country-wise figures—of what Arora claims is the report for
September 2007 for his AdSense account

One of the gifts Arora claims Google sent him for being a valuable AdSense customer
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The Test
Arora’s “earnings” screenshot—which Google
claims is doctored—is the first screenshot
below. Then, we tested the script; it works like
Arora claimed it would. (Second screenshot
below.) Our account was disabled when Arora
stopped sending out his e-mail invitations to
click on his links.

To prove that he had full control, Arora
started yet another account into which money
is still flowing in. See on the previous page a
slightly outdated screenshot of where the
clicks are coming from. Make no mistake: this
method—which involves a simple script and
lots of connections to people—is powerful.

Naturally, we contacted Google and told
them about how we had tested a certain click
fraud script. Andrew Kovacs, a Google
spokesman, got back and told us he’d
like to speak with us. The only thing he asked
us was, “When you ran the script, was it
Manish Arora’s?”

Clearly, his is a name they’re familiar with.

The Actual Rate…?
Click fraud happens all the time—it’s so easy.
Some people quote it at a ridiculous high of
50 per cent; some say it is 10 per cent, some
analysts quote figures in between. Shuman

Ghosemajumder, Business Product Manager
for Trust And Safety at Google, says… well,
there’s a wee bit of controversy here. He has
been quoted as saying that the click fraud rate
is less than 2 per cent. But here’s how he clar-
ifies what he actually said, at shumans.com:

“… I never said that our click fraud rate is
less than 2 per cent. Instead, what I said is that

the quantity of invalid clicks which we detect
as a result of reactive investigations is a ‘negli-
gible proportion’ of the total number of invalid
clicks. Andy (Beal) asked me if that percentage
is less than 2%. I told him that I was not able to
provide a bound, but yes, ‘negligible’ certainly
means less than 2% of invalid clicks.

“So what is our overall ‘click fraud rate’? …
it is virtually impossible to know the intent of
every click. However, we can do a very effective
job using statistical techniques to detect poten-
tially malicious behavior, and the total number
of invalid clicks we detect—whether for sus-
pected malicious or non-malicious intent—is in
the single digit percentages.”

(Andy Beal is a blogging and search engine
marketing consultant. “Overall Click Fraud
Rate” is commonly used to refer to the number
of fraudulent clicks as a percentage of all
clicks that happen, regardless of whether
Google issues a refund or doesn’t bill,
according to Danny Sullivan of
searchengineland.com.)

Kovacs informs us: “Less than 0.02% of
clicks that are billed to the advertiser turn out
to be fraudulent.” That corroborates with a
March 2007 claim by Google that less than
0.02% of all clicks slip past its filters and are
caught after advertisers request reviews.

But there are plenty of things we can’t get
into here—including the idea that there are
sceptics who don’t like that figure. If you’re
interested, you should visit http://tinyurl.com/
yrh87l for a detailed explanation by Sullivan.

But The Questions…
There are a lot of these, not entirely clear. Let’s
take a look at all of them.

Q. Why has Google said Arora is lying?
Proposed answer: We don’t know. Arora could
be lying. But then we tested his system
ourselves and found that it works. Google
categorically tells us it’s “impossibe” for Arora
to have “earned” how much he did, but there’s
no explanation—while they could have given us
one: Arora spelt out on his blog what he’d
been doing.

Q. How can Digit be sure that Arora’s system works?
A. We’re referring to the fact that we “got”
paid, as in, the money accrued in our AdSense
account. However, would the clicks have been
later detected as invalid and we wouldn’t have
been paid? We asked Kovacs about this, and
there has been no response.

Q. Is Google taking Digit seriously?
A. We believe so. Kovacs has been our point of
contact; he invited us to speak to
Ghosemajumder about the issue. In one e-
mail, he said our questions were “top prior-
ity.”

Q. Is Google taking Arora seriously?
A. On the one hand, consider the alacrity with
which Kovacs called us to ask if it was Arora’s
script we had been using. He said they had
“dealt” with him before. On the other hand,

The total number of
invalid clicks we
detect—whether for
suspected malicious or
non-malicious intent—
is in the single digit
percentages”

Shuman
Ghosemajumder

Business Product Manager
for Trust And Safety

Google

A report of  Arora’s earnings as of 18 December 2006—his screenshot

A report of our earnings in the AdSense account we used to try out Arora’s method
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when we got into the details and began e-
mailing him, there has been only one
concrete response. Why the reticence here?

Q. Why do they all say “that’s the way it’s supposed
to work”?
A. (Our italics) Refer what Cory Altheide said
to Arora: “This is exactly how the system is
designed to work.” Then here’s what Kovacs
said to us in the last communication we
received: “When we learn about fraudulent
accounts we terminate them before the indi-
viduals earn any money. This is exactly how the
system is designed to work.” Then, like we’ve
asked earlier, would our clicks have been
later detected as invalid—and we would have
ended up not being paid? Why have we not
received a response on this? And second, if
everything is working “exactly the way it’s
supposed to work,” why does click fraud
occur at all?

Q. Finally, does Google have a mechanism in place
to prevent activity of the type Arora claims to have
been successful in doing?

A. We’re not sure. Kovacs says: “Do we
have (sic) multiple ways to distinguish
between clicks that originate on a site
approved for AdSense and those that origi-
nate on other sites.” There’s no further expla-
nation, and we have to ask: how did money
come into our account? Were we to try and

cash into it, would we have been told that our
clicks were fake? It doesn’t seem that way to
us, but we don’t know.

Something’s missing along the way.

The Moral Of The Story
So what’s our point? Just this: that each time
someone comes up with a new method to
exploit a problem with AdSense, some people
lose money. Each time Google fortifies its
defences, and it gets better. But the pro-
gramme, therefore, is far from perfect. Did we
mention that click fraud is the potential
Google-killer?

And that is the reason we’re reporting this:
it’s not just to say “someone found an
exploitable loophole in AdSense.” It is to
inform you of the fact that AdSense is far from
perfect—and that we think Google should not
underestimate the gravity of the situation.
Will it need one more class action suit to wake
Google up? Should it?

We certainly hope—in fact, we’re almost
sure—that Google will find a way to patch the
AdSense exploitation method that Arora has
found. For the sake of all of us—so that Google
remains what it is today, a benign giant, organ-
ising the world’s information.

But in this instance, they’re taking rather
a long time to respond—we wish them 
God Speed! 

editor@thinkdigit.com



Day 1  
It’s here! I’m sitting right in front of it and I feel like adwarf in comparison. One really has to place a regularscreen—even including 21-inchers—next to a 32-incherto get an idea of the size difference. This one isn’texactly elegant like the Bordeaux range of TVs fromSamsung, which have the smooth glossy finish and all.This one has a black matte finish with a standard,grey border. The speakers at the bottom of the screengive it an even larger look. I can even mount it on mywall, if I want to.

Day 5 
It’s been four days now and it looks like someone movedthe TV a little. I try and adjust the position a tiny bitand it starts wobbling in giant-globule-of-jelly fashion.I’ve also noticed the f limsy plastic on the poorly-builtback cover. A mildly punch and you can easily make ahole in it.

Day 10
The novelty has begun to wear off. One of the majorflaws has to be the display itself! It’s got this ripplingwave effect that originates from the top centre andradiates to the bottom, and it’s fairly prominent andrather distracting. Viewing angles are surprisinglygood, and there are no signs of any kind of motionblurring either. Contrast ratio is pretty good too. Thereis a backlight feature to turn down (or up) the

brightness of the
screen more

effectively.

Day 14
Connected the Xbox 360 Elite to the TV—that’s where itshould shine. There are two HDMI connectors along withan array of others including VGA input and audio. I’mpleased—playing games on an Xbox 360 sitting a few feetaway is rather enjoyable. 1366 x 768 is good as long aslong as you sit at a decent distance. Unlike computer LCDmonitors, you can count the pixels on the screen—that’show coarse it is! Still, it would be the same with anyother LCD of this size and resolution. The games run at1080p but the TV doesn’t support it, so it downscales1080p to its native resolution.

Day 20
Sound: not great. Loud enough for the daily-type TV, butnot crisp. I’d say if you want to watch high-definition,action-packed movies, you’ll definitely want to connectbetter, external speakers.

Day 25
I’m busy punching away at the remote wonderingwhere they’ve gone terribly wrong. Its light and doesn’tfeel nice in my hand. The volume and channel-changingdirectional buttons are clunky and get stuck. The on-screen menu interface is easy to navigate, though.

Day 29
The end of the “joyride”. I’m not really going to miss it asmuch as I thought I would. I’m told the price issomewhere around Rs 40,000. I’m not totally blown awayby the quality of the video or the sound—forget aboutbuild quality. This is just a good entry-level LCD TV foranyone wanting to make that leap—one of the cheapest32-inch LCDs you can get. Would I buy it? I think not.

Rossi Fernandes
I’ve been given a month, more or less, to enjoy this humongous (32-inch!) LCD TV from Akai. That company may not be on the same

level as Sharp or Sony, but then it’s still something to have a 32-incher staring back at you

Akai 32LW7 LCD Television

Digital Passion l 30 days with...
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rossi_fernandes@thinkdigit.com



Microsoft
Xbox 360 Elite

This black beauty comes with an HDMI-out—per-
fect if you’re planning on getting an LCD HDTV.
The Elite sports a full 1080p HD resolution; it also

comes with a 120 GB hard drive, and unfortunately, not
much more in terms of features than the regular Xbox
models. But well, you’ll be able to actually use it as a
media centre to play back movies on your HDTV.
Besides, with the Elite you get digital audio. And more... 

The Elite is supposed to be backwards-compatible
with previous Xbox and Xbox 360 games, but this does-
n’t hold true all the time. However, if you want to enjoy
the games you buy in full HD splendour, the Elite is
your only option when it comes to the Xbox 360. The
Elite is being sold in India at www.indiatimes.com for
Rs 34,990. We’re mentioning both the Elite and the PS3
because choosing between them often comes down to

what games you like to play.
We suggest you look at the
games available for each plat-
form, decide on which has
more of the games you’d like to
own, and only then make your
purchase. Also, the Xbox 360
Elite is available in the Gulf for
considerably less than the Indi-
an price.

Sony PSP

I
f it’s portable entertainment, nothing beats
the Sony PSP (PlayStation Portable).
There’s a new version out called the PSP

Slim, widely available with your local grey
market vendor. Price varies between Rs 7.5
and 8.5K. So what’s so good about it? Well, the
Slim (PSP 2000) is lighter than the PSP (PSP
1000)—down to 189 gm with batteries. It has
been optimised to use less power. The RAM
has been doubled to 64 MB. The screen
remains unchanged—480x272 (16:9) wide-
screen TFT LCD. The buttons are more respon-
sive and stick out a little further from the
body. The drive seems a little less noisy. The
Slim features a video-out connector. When
you’re at home or in a Wi-Fi hotspot, you can
connect and start surfing.

For the price, nothing beats the PSP if
you’re into gaming on the move. If you’re a
movie buff, however, move on to Entertain-
ment (three pages down).

Robert Sovereign-Smith

You’re probably already sick of all the ads screaming out
to you from billboards as you navigate your way through
rush hour traffic. (And also those in papers, mags...)

Every year around Diwali (or Deepavali), companies put every-
thing up on sale, advertise like mad and hope to win your
heart over, along with your Lakshmi (money, wealth, paisa,
etc.). Friends and relatives all act as facilitators when it comes
to decision time—except when it’s something from the tech

domain. Here, the majority of we Indians depend a lot on ads.
Most of us have friends who know less (or at best, as much)
about technology as we do. Those of you who read Digit ought
to know better than to base a decision on an ad, and should
whip out those old issues of Digit, or head on over to our site
(www.thinkdigit.com) to look at our tests and decide on a prod-
uct. But this year, we’re making it even easier—with our holi-
day shopping list, sourced from those in the Digit editorial
team: “If you had a million rupees, this Diwali you would
buy...”. Answers varied across categories, and we present what
we’re calling “Digit’s Ultimate Holiday Shopping Guide.”

’Tis the time to be
spending, but what to buy?
Tech shopping over
the holidays
can get confusing.
Allow us to suggest
a few things
for you to splurge on

Gaming
Because everyone loves gaming!



89DIGIT NOEMBER 2007

Digital Passion l Festive Special

Apple iPod Touch

Rumoured to be launched officially some time
before Diwali, the iPod Touch is what everyone
wants—at least until the iPhone is officially

launched here. So what is the iPod Touch? Think the
iPhone, without the phone function! There are two vari-
ants to the Flash memory-based Touch: 8 GB and 16 GB.
Already available and quite popular in the grey market,
the iPod touch is retailing at around Rs 15,000 for the
8 GB and 19,000 for the 16 GB models. Featuring the
already famous Apple Multi-touch interface, a 3.5 inch
480 x 320 touch-screen, the Safari Internet browser,
WiFi access to connect the browser to the Net, and the
ability to download songs from iTunes, this is a must
buy for those who can afford it. Regular specifications
are: Weight 120 gm; Display 3.5-inch; Audio AAC, MP3,
Apple lossless, AIFF, and WAV; Video capabilities M4V,
MP4 and MOV; Other Features 3.5 mm headphone jack,
22 hours of music playback, etc. Heard  enough? If all
the specifications and pictures are making you drool
over this magazine, close mouth, run to your tech retail-
er and get one of these!

Nokia N95

Looking to buy a stylish phone? If you have a budget of about Rs 25,000 for
a phone, the Nokia N95 is your best bet. This 3G phone weighs in at just 120
gm, features a 240 x 320 TFT screen, a camera that is capable of 5 mega pixel

pictures, with a Carl Zeiss lens, and an almost unlimited supply of phonebook
space, and much more.

What’s that “much more”, you ask? For starters, quad-band GSM, class 10 GPRS
(48 Kbps), EDGE (296 Kbps), HSPDA (3G), WiFi
(b/g) and Bluetooth are the options you have
for connectivity to networks and other devices.
It features a 3.5 mm audio jack so you can con-
nect a decent set of headphones without wor-
rying about proprietary formats. The built in
GPS navigation ensures you never lose your
way, while the 5 mp (2592x1944 pixel) camera
let’s you capture every trip you take. The cam-
era with Karl Zeiss optics lets you capture VGA
(640x480) video at 30 fps, more than enough
for capturing your family frolicking on a holi-
day. The phone provides 160 MB of internal
memory, comes with a 128 MB microSD card,
which you can safely ignore because you know
you’re going to want to buy a multiple-GB
microSD replacement for it! With over six
hours of talk time and over 200 hours of
standby time, you’ll rarely find yourself run-
ning low on charge between plug points. The
phone is running Symbian OS 9.2, and hooks
up to your PC via the mini USB port, so file
transfers are easy. As for looks, take a look at

the picture alongside—you
know you want this cool slider
from Nokia!

Sony PS3

Coming to the PS3, we wonder if we really need to explain any further. Well, here’s
a look at its spec sheet: Cell processor (capable of 218 GFlops); Full HD capability
(1080p); 2xHDMI ports; Dolby 5.1/DTS capable audio; Blu-ray DVD player

(CD/DVD/BD); wireless controllers; and more... What makes the PS3 special is its
native support for HDTV using the two HDMI inputs and the mind-blowing sound expe-
rience it offers. The PS3 has always been full HD compatible (1080p), so you can enjoy
it on any HDTV out there. The inbuilt Blu-ray DVD player is a huge bonus, making you
quite future-proof. Incidentally, you can get an HD-DVD player for the 360 Elite, to
future-proof it, but it’s an external player and will cost you about Rs 8,000 more—
huge advantage for Sony’s PS3 here. Currently, the game selection for PS3 available in
India makes it a formidable force, and considering that you get Dolby 5.1/DTS, a Blu-
ray player, 2 HDMI ports... the choice when buying from India is simple—get the PS3
for Rs 34,990 (MRP, and a little cheaper at certain stores). The PS3 will cost between
Rs 25,000 to 30,000 abroad, so it might not be worth losing support for it.

Overall, this Diwali, make sure you get yourself a gaming console—an Xbox via
friends or relative from abroad or a PS3 right here. Nintendo fans will complain about
us not mentioning the Wii, but lack of official availability and games forces us to
ignore it at this time—maybe next Diwali!

personaltech
What good is it to earn if you can’t
splurge on yourself?
Go ahead, pamper away!
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Nikon D40x 

T
he D40x is our personal favourite camera. We suggest you use
this as a benchmark for other “Diwali offers” you might find.
This is a 10.2MP camera that seems to fit perfectly in your hands.

It’slight—a mere 495 gm without the battery. Even professional pho-
tographers have showered praises on the camera’s image quality at
its low price. The D40x is in India available for around Rs 29,000. We
should warn you that the older D40 (6.1MP) is also still being sold in
India for around Rs 22,000, so make sure you don’t get confused
between the D40 and D40x. Although the older D40 is a very good
camera in itself, the D40x comes with an 18-55 mm Nikkor lens bun-
dled, so it’s actually a way better deal. The D40x uses SD memory
cards to store pictures, which is good because SD flash memory prices
are plummeting. The camera features auto white balance, Nikon’s

Multi-CAM 530 autofocus technology, five shooting modes, Nikon’s 3D
Color Matrix Metering II exposure control system, and a lot of shoot-
ing controls to give you a perfectly exposed and timed picture. Shut-
ter speeds range from 30 to 1/4000. The pop-up flash is good for
indoor-low-light shooting. The D40x uses a custom Li-ion battery
that has a decent life, but shutterbugs who shoot in excess of 500 pics
on a single charge might need a spare battery. Overall, any semi-pro-
fessional shooter would be quite happy with this camera.

Sony Cyber-shot DSC W200

For those of you on a smaller budget, or if you just want a pock-
et-able camera that gives you great quality and ease of use, we
recommend the DSC W200. This Cyber-shot camera from Sony

is really compact for its 12MP rating. The DSC W200 features Sony’s
Super SteadyShot optical image stabilisation technology, face detec-
tion and 9-point autofocus. This translates to an easy to use camera
that very rarely gives you blurry shots. Video capture is possible at
30 fps VGA. The camera has a Carl Zeiss lens with 3x optical zoom,
which provides good results in well-lit scenarios. At 142 gm, the cam-
era is as light as you’d expect it to be, but still feels good and steady
in your hands. The design also helps you get a good grip of the thing
when you’re shooting, and coupled with the image stabilisation soft-
ware you’re not likely to get motion blurs. Apart from standard USB
and AV connectors, the camera features a HD output jack, so you can
hook it up directly to your HDTV. Software running on the camera
lets you set up slide-shows for viewing on your HDTV. The DSC W200
is available at quite a varied price—between Rs 13,000 and Rs
16,000—because some dealers sell only the camera, some sell it with
a carry pouch, and some even throw in a 2 GB Memory Stick Pro Duo.

Sony Ericsson S500i

Not everyone will set themselves a budget as high as Rs 25K for a phone. Most of us Diwali shoppers
will look for more mid-range phones... so we decided to recommend something new, something that
will let your purchase stand out from the crowd. Sony Ericsson launched the S500i in the beginning

of October, and at first glance, this phone looks really cool. Of the four colours available—Mysterious
Green, Ice Purple, Contrasted Copper and Spring Yellow—our favourites are the first two. The phone is a
slider; the 2-inch TFT display works at 240 x 320, with 262K colours. It’s EDGE-capable, has quad-band GSM
capability and supports Bluetooth (A2DP stereo, for wireless headphones). The phone weighs just 92 gm,
and is 14 mm thick. Onboard memory is scarce—just 12 MB—but you can upgrade to 2 GB using the Memory
Stick Micro (M2) slot. The phone features Sony’s Walkman software for phones, so your music experience
will be good. The 2MP camera offers decent pictures, and is on par with other phones in this range. The
buttons are small, but well-designed and tactile enough. Talk time is 9 hours and standby time is 370
hours. The menu is exciting to play with, and Sony Ericsson says, “...S500i keeps you in harmony with the
world around you. Let desktop and menu themes change with the season; or as day turns to night.” So your
phone menu looks different on different days and even changes between day and night! You can person-
alise the phone’s “light effects”—the way the phone lights up when a call comes through. In
terms of specs, the phone is quite what you’d expect for the price—nothing extraordinary.
However, if you’d like to make a style statement with your phone, the S500i can be the centre
of attention... if you want it to be.

Digital Passion l Festive Special

Cameras
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professional to
point-and-click
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Samsung Bordeaux
LA32R81B

Chances are you’re going to get a pretty good offer on this TV
these holidays. The 32R8 is a black beauty from the Samsung
Bordeaux collection, and is one revision up from its prede-

cessor the LA32R71B. The newer model is slightly sleeker looking
(not that any improvement was required to begin with), and the
contrast ratio has been beefed up from 5000:1 to 8000:1 on the
new range. Prices have fallen as well, and the TV was retailing for
Rs 52,000 the last time we checked, and may even fall further dur-
ing the shopping season.

The display is not true HD, and is 1080i (1366 x 768), which
shouldn’t be much of a problem for most, because we hardly have
any 1080i capable outputs. If you own a PS3 or Xbox though, you
might want to look at full HD displays.

The brightness is rated at 550 cd/m2, and coupled with a view-
ing angle of 178 degrees, this makes the TV well viewable from
everywhere in your room. The inbuilt speakers aren’t great, and at
10 watt RMS don’t pack a punch—but you can’t have everything
now can you?

There are 3 HDMI inputs, so those of you who want to be able
to simultaneously connect multiple HD sources are in luck here.
There’s PC connectivity as well, via a D-sub port that connects
directly to your graphics card. We love the picture-in-picture imple-
mentation on this TV though, which comes in handy when you’ve
connected your PC up and want to watch the cricket match while
you work. Picture quality is good and this is a good buy for most
people. 

Also available in the Indian market are the older R7 models of

this 32-inch TV, and you should check carefully what you’re buying.
There’s nothing wrong with the R7 series per se, and if you get a
good deal on one, they’re still great buys. The difference is that
the R7s feature just a single HDMI port and a reduced contrast ratio
of 5000:1. A good idea would be to look for clearance sales of the
R7, and if you get lucky, you could get them for Rs 42,000 or less—
a good buy if you’re not interested in hooking up too many HD
sources (of which we have so few anyway in India). Those of you
with friends / relatives going to the gulf might want to ask them to
check for the R7s there—one of our colleagues got an LA32R71B
for a mere 27,000 at a clearance sale in the gulf!

Now there are those of you who will want larger than 32 inch
TVs, or just insist on full HD (1080p) TVs. Be prepared to pay a
steep price though. If you’ve got a budget of over 1,50,000, you
may want to take a look at full HD LCDs and Plasmas from Philips,
Sony and Hitachi. The Philips Ambilight LCE TVs are also something
you may want to look at—they’re different and definitely a good
looking addition to any wall. Speaking of good looking, the Sony
Bravia line has some really nice full HD TVs, and they’ve got some
good discounts and offers lined up this Diwali.

Bose QuietComfort 3

With all that shopping you’re planning, chances are you’re
going to have a lot of new audio-visual gear at home—all
of which is useless at 2:00 AM when you want to catch

that flick on TV or when you just want to chill to some loud music.
If your family doesn’t kill you first, your neighbours will. The only
option is to take your entertainment to more personal level, and
get headphones. However, not just any headphones, because
what use is it watching your favourite movie or listening to that
Beethoven/Van Halen/Madonna/Linkin’ Park/(we could go on
forever) CD on a substandard pair of headphones.

Audio quality is something you can stop worrying about as
soon as the word Bose is mentioned. We all know they’re good,
period. Bose’s QuietComfort 3 Acoustic Noise Cancelling Head-
phones are something everyone should have, but not just anyone
can afford. Priced at Rs 21,263, these headphones cause most of
us to sputter in awe when we hear the price tag. “Why?” is gen-
erally the next question we all ask; here’s the answer:

The headphones are really noise cancelling, and putting them
on isolate you from the noise around, as well as ensure that any

noise in your music is electronically cut out. They also feature
active equalisation—electronics in the headset analyse and con-
trol the frequency response of the headphones, on-the-fly, to
ensure the best audio quality always.  In short, you have to hear
them to believe them. Only for those with money to splurge
though, or those who have ears as sensitive as professional com-
posers. They do make for some serious flaunt value though!

Time To Open The Goodies
We certainly hope that this article has inspired you to go out and look
for good deals… Remember, there are plenty more great ones out
there in every segment we've mentioned; these are just suggestions. 

If you do buy any of the products we've mentioned, write in and let
us know about your experience. We'd also love to hear what you did
buy this Diwali, even if it's not on our list! ■

robert_smith@thinkdigit.com

Entertainment
High-fidelity and high-definition here
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Nimish Chandiramani

If you’ve ever handled a transistor—in your
college lab, for instance—you’ve probably had
a brain cell or two pop trying to imagine 291

million of them inside the diminutive package
that is the Intel Core 2 Duo. And if it isn’t enough
to imagine just transistors on that little chip, try
to imagine that those transistors are actually
connected to each other in circuits, which ulti-
mately power all our PCs. Hurts, doesn’t it?

So how do you design circuitry when millions
of transistors are involved? And how do you fit the
lot on a chip that’s barely the size of a fingernail? 

Drawing Board
Before the actual design of your microchip
commences, you first have to decide what it’s
going to do—and not just in vague terms like “Oh,
it’ll decode video files.” You’ll have to draw up
algorithms for how exactly the chip will decode
video—which codec it’ll use and so on. 

The next step is dividing the chip’s job into
hardware and software—what tasks will be
performed by the chip directly, and what you’ll
write drivers or software for. If you implement all
the chip’s functionality on the hardware itself,
you’ll have yourself a real cracking performer, but
you won’t be able to add to those functions later.
For example, your mobile phone manufacturer
could very well incorporate all the functions of
your phone on to the same chip, but if they had
to make even the simplest change to the phone—

like adding an FM radio function—they’d have to
design and manufacture a whole new chip: an
embarrassingly expensive proposition. Instead,
they build a chip with all the essential features—
making phone calls, for instance—and write soft-
ware to implement the rest of the functions.

Once the hardware’s role in the Big Picture is
fixed, it’s time to design. 

Drawing Board, II
We talk about circuitry with millions of transis-
tors, but the truth is that even in the early days of
chip manufacture, designers never had to bother
with individual transistors—the smallest units
they had to care about were logic gates; this was a
time when digital circuits weren’t nearly as
complex as today’s. If you were to design a micro-
processor at that minute level today, it would take
years to just finish the design, let alone test and
refine it. The solution? Don’t bother with circuit
diagrams at all—tell a computer what you want,
and let it do the dirty work. 

Today, designing hardware has become a
matter of writing code—using a special “Hardware
Descriptive Language” (HDL), you describe every
function of the chip you’re designing—right down
to what the chip does in each clock cycle. That
code, once interpreted (by a logic synthesiser),
results in a circuit diagram—which can now be
refined by hand, if necessary. Before your design
is shipped off for manufacture, it’ll need manual
looking-over to see if the design can be optimised
beyond what the logic synthesiser brought up.

How processors
go from idea to
your PC
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Finally, it’s tested in a simulation to see if it really
does what it’s supposed to.

And now, it’s off to the fabrication plant...

In The Clean Room
Even the smallest speck of dust can turn an IC into
a worthless piece of silicon, so everything we’re
talking about here takes place in a “cleanroom,”
which is, well, a very clean room. We’re talking
millions of dollars worth of dust filters, special
furniture that won’t leave particles, even
specialised cleaning materials.

It all starts with a wafer of pure silicon; the
wafers are rinsed in pure water and a special
cleaning solution. The huge number of transistors
that will be made on this chip are going to be
packed together real close, so it’s necessary to
isolate them from each other using an insulating
material. Rather than slap on a layer of material
on the silicon wafer, the wafer is exposed to heat
and oxygen to create a layer of silicon dioxide on
it. Now, we’ll remove the oxide only from those
areas that we need to create the transistors on. 

The layer of silicon dioxide is then coated with
a material called photoresist, which turns into an
incoherent goo when exposed to ultraviolet light.
Here’s where you use the circuit diagram that
came out of the design process. The circuit’s
layout is etched on to a mask, which is then placed
on the layer of photoresist. This is then exposed to
ultraviolet light, which causes the photoresist
under the mask’s transparent areas (which is
where the transistors need to be) to turn gooey so
it can be washed away. The wafer is then doused
in acid, which eats up the exposed portions of the
silicon dioxide layer, giving us access to the silicon
underneath; this is called etching. 

Now, through a process called ion implantation,
ions are diffused into the silicon to create transis-
tors. Note that we’re talking only transistors here—
even resistors and capacitors are created using
transistors connected in special configurations;
the gory details are too much to fit in here.

So we’ve created our components on the
wafer; now it’s time to bring in the wiring. 

Digital Passion l Insight

Inevitably even C
will fall short in
the face of the
complexity of
newer hardware,
so manufactur-
ers are looking
to newer meth-
ods to make
processor design
easier

Connecting Them All
We use the term “wiring” rather loosely, but we
are following the intention. The components have
been created, but they’re not connected. The first
thing to do is to close up the transistors inside insu-
lating material—more silicon dioxide. This time,
the process of masking and etching is repeated,
only the mask is creating windows that lead to the
transistors’ terminals. A layer of metal is deposited
now, which establishes the connections. 

This is only the first layer of metal, which
establishes only part of the connections that
need to be made—another cycle of insulating,
masking, etching and metal depositing follows,
creating the next set of connections—this goes
on for up to twenty layers. This is how they’re
able to connect so many components in such a
small area.

And speaking of small... 

The Nanometre Kerfuffle
If you’ve been following technology news for the
past few months—specifically the antics of the
processor giants—you’ve most likely encountered
talk about the old 90 nm (nanometre) process, the
on-its-way-out 65 nm and the new wave of 45 nm
processes. What are these numbers and what’s
the big deal?

To put it in non-engineering terms, these
numbers represent the effective length of the
transistors on the chip—so in the same chip area,
it’s possible to put more 45 nm transistors than 60
nm. However, it’s not just that bit that’s causing
the hype—it’s the transistors themselves (more
specifically, the transistors that you’ll see on
Intel’s upcoming Penryn and Nehalem proces-
sors). The transistors are called high-k metal gate
transistors, and their design reduces the amount of
current wasted in the transistor, which in turn
pulls down the power they consume and the
amount of heat dissipated by them. A more
detailed explanation would fill up a few issues of
this magazine, so we won’t go that deep. 

Ahead
Even with the new technologies, processor
designs are getting more complex—HDLs have
become cumbersome, and designers now prepare
their specifications in variants of the C program-
ming language. Inevitably, though, even C is
going to fall short in the face of the complexity of
newer hardware, so manufacturers are looking to
newer methods to make processor design easier. 

One way is to modularise the processor—break
it into parts in such a way that they can be added
or removed as necessary. An approach that looks
promising is AMD’s Fusion, which enables them
to give you processors with as many CPU or graph-
ics cores you want on the same chip. With the
earlier method, if they wanted graphics and CPU
on the same chip, they’d have to design it from
the ground up—with Fusion, all they need to do is
add the extra graphics core to an existing CPU
core design, and voila!

And then there’s talk of offloading even more
of the design to computers. Who knows, maybe
we’ll soon see processors whose sole purpose is to
design better processors... 

nimish_chandiramani@thinkdigit.com
The process we’ve described above—how we start with a piece of silicon, go through
the process, and end up with circuits etched on top of silicon dioxide
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n a world of HDTVs, HD audio with giant LCDs and
audiophile sound systems, all available at a retail
store near you, nothing seems to awe us anymore.

Until now, that is. The $300,000 (Rs 1,20,00,000) Goldmund
U-room will make you want to smash your LCD and sound
system. Here’s why: The U-room consists of a 6-metre screen
that is 1080p compliant, a 64-channel surround sound setup
that outputs 130db of sound with a frequency range from
5Hz to 50kHz. If you have Rs 1.2 crore to spare, give the
Goldmund crew a call. 

Goldmund U-room

P recently bought VoodooPC, and already
we’re seeing the effects of that in the way
new systems are designed. The Blackbird

002 PC is one of the most amazing looking designs
from HP in a while now. With a price range of
anywhere between $2,500 and $7,000 (Rs 1,00,000
to Rs 2,80,000)—depending on configuration—there
better be power under the hood. 

You can get an over-clocked Core 2 Extreme
QX6850, SLI-ed 8800 Ultras and 4GB of memory. All
that hot hardware is cooled using liquids, heat pipes
and heat sinks. You can customize your
configuration and opt for AMD instead. A special HP
Blackbird Dedicated Edition will be released soon,
which will add on a Voodoo keyboard and mouse
and the Half Life 2 Orange Box. What’s subtracted is
the overclocking on the QX6850 and a mere 2 GB of
RAM instead of 4. The price for the Dedicated
Edition is $5,500 (Rs 2,20,000).

HP Blackbird 002 PC
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The good stuff   z Stuff to lust after  z Stuff for the well-moneyed

iRobot ConnectR

o, this gadget will not save a life; it will,
however, let you party wherever you go. It’s
a cool looking portable DJ-ing system with

120 GB storage. You can mix music easily, and on
the move. All the well known audio formats—MP3,
WMA, AAC, WAV, Ogg Vorbis and even the lossless
FLAC are supported!

The Pacemaker has a set of effects like crossfade,
bend, pitch, etc., which can be controlled using the
multifunctional touchpad. Outputs include headphone
and line-out, and the device lets you control two
channels individually. Even if you aren’t a DJ, its huge
storage capacity lets it double up as a really good
portable music player!  We’re clueless about the price
but we’ll assume that the rumours hold some truth—
around Rs 30,000 is what it might be.

Fanatec Porsche
911 Turbo Wheel

e all love cars, but not all of us can afford a Porsche, can we?
Thanks to Fanatec, you can own something by Porsche that
your grandchildren will not still be paying for! The Fanatec

Porsche 911 Turbo Wheel is brilliantly designed for racing game
enthusiasts. The steering has hand stitched leather, an H-pattern
gear shift, force feedback and the wheel has a turning angle of 900
degrees. It connects wirelessly, but you have to power it to get force
feedback. The battery operated pedals are designed to feel just like
the real thing—no plasticky nonsense here. The USB dongle and wheel
have neat Porsche badges. Price? A mere $350 to $420 (Rs 14,000—
Rs 16,750) depending on where you plan on buying it.

W

QO model e2 is a new comer in the UMPC market. It’s powered by a VIA
1.6 GHz processor, 1 GB DDR2 memory and comes with Wi-Fi. The 5-
inch screen is capable of a resolution of 800 x 480, and if this doesn’t

suffice, you’re free to connect to a display using the VGA, DVI or HDMI outputs
for a maximum resolution of 1920 x 1200. Did we mention that it runs
Windows Vista?

There’s an option of a 120 GB hard drive, or a 32 GB solid state drive. A
QWERTY keyboard (with a number pad) are designed into it—all in the size of a
small notebook. At 450g, it’s heavy only to the weakest of geeks. Price is
another matter, and the rumoured figure is between £846 and £1,359 (Rs 47,782
to Rs 76,756)—making it heavy on your pocket. Pun not intended.

Digital Passion l Droolmaal

Pacemaker

he iRobot ConnectR might look like a hi-tech
baby potty at first, but is in fact a very smart
gadget. The ConnectR uses the power of the

Internet (and a webcam and microphone) to allow
its users to talk with others. Spy on your loved
ones, or keep an eye on your toddler using this little
robot. It moves around the house, controlled over
the Net using a joystick or a mouse. So how much
does a walking, talking, potty seat cost? A mere
$499.9 (Rs 20,000). 

T

OQO model e2
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and win
Introducing Maya 8
3D for Beginners
by Dariush Derakhshani
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Readers are requested to

send in their answers by the
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publication.
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trying to solve the problem.

Solution To Last Month’s Challenge
One of the easiest ways to do this is using a
software called pebuilder. Using it, you can
create an XP Live CD in just about 15 minutes!

Here’s all the software you’ll need:

1. pebuilder3110a1.exe, from
ftp://dl.xs4all.nl/pub/mirror/nu2files/pebuilder3110
a.exe

2. Plugins:
xpe-1.0.7.cab (the GUI shell) from 

http://sourceforge.net/project/downloading.php?gr
oup_id=126922&use_mirror=nchc&filename=xpe-
1.0.7.cab&10619721
(http://tinyurl.com/2ct72t)

Other plugins from www.bootcd.us/
BartPE_Plugins_Complete.php
3. Nero Burning ROM
4. A (bootable) XP CD

Step 1: Download pebuilder3110a1.exe and
install it.

Step 2: For the wallpaper, replace
C:\pebuilder3110a\bartpe.bmp with the
image you want as your wallpaper. You can
find the default XP wallpaper at
C:\WINDOWS\Web\Wallpaper\bliss.bmp.
(Both these, of course, assume the C drive as
the installation location.)

Step 3: Download the plugins:
xpe-1.0.7.cab: This will create the XP start

button and taskbar. It is the GUI shell of the
XP Live CD.

Network Driver Plugin Pack: This provides
many network card drivers

FreeAV Virus Scanner: This integrates
FreeAV

diskexplorer_for_ntfs.cab: A very good file
explorer

And more… you can choose what you want
to download to add functionality. There are
537 plugins right now to choose from!

Step 4: Open pebuilder. Specify the source
path to the Windows installation file. This
should be your Windows XP installation
bootable CD, where the i386 folder resides.

Step 5: Click Plugins and add the plugins
you’ve downloaded. Since you’ve included
xpe-1.0.7.cab, disable nu2shell and the startup
group.

Step 6: Specify the ISO image file, and click
Build.

Step 7: After that’s done, use Nero (or any
other burning software) and burn the image
file to a CD. You’re done! 

THIS MONTH’S CHALLENGE

Win!

Gaurav
Anna University

Chennai

LAST MONTH’S WINNER

How would you e-mail a
page in Internet Explorer by
right-clicking on it?

Send in your solution with
the subject “Take a Crack”,
and your postal address, to
takeacrack@thinkdigit.com

Create A Context
Menu Item To Mail
An IE Page

Disable nu2shell and the startup group

Click Close after the ISO has been created, then burn it

Create An XP Live CDLAST MONTH’S CHALLENGE
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Asfaq Tapia

W
hen it comes to Microsoft Office,
we are normally a happy lot. How-
ever, we like the idea of being able
to do more than what is possible,

or possibly accomplishing a set task faster than
normal. Since Office allows you to add third-
party functionality in the form of add-ons, we
decided to go out and find the best Microsoft
add-ons that will help you augment MS Office to
make your daily tasks easier.

OUTLOOK
VCard4Outlook
At some point, all of us have needed
to (or will need to) transfer a large

amount of contacts from the Outlook address
book to another program; this could be to or
from a mobile device, another e-mail client or
even to a Webmail account.

Outlook allows you to convert your contacts
into the vCard format (this will be a .vcf file).
This is a standard file format that can be read
by most personal information management
(PIM) software. So, for example, if you want to
send someone your contact details, you send
them your vCard file—which contains your
address, telephone numbers, e-mail address,
and more. This file can be read in Outlook or
even on a mobile phone. The only disadvantage
of using the vCard format in Outlook is that
you can convert only one contact at a time. 

Using the vCard Wizard software, you can
easily convert all your contacts (or even a few
of them) to the vCard format with a few clicks.
Transferring address books becomes easier and
faster, and you can even import multiple vCard

entries into the Outlook address book using
this add-on.

To import vCard entries into Outlook: click
on the Import-Export icon in the Outlook file
menu, go into the folder where the vCard entries
are stored, and click OK.

In order to convert contacts into the vCard
format, click on Contacts, and either select all
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on your address book who weren’t on LinkedIn
have signed up; if they do, it informs you about
their presence.

Besides just updating details, if you haven’t
interacted with any contacts for over 60 days,
you are reminded to keep in touch with them—
this could be really good or really irritating
depending on who the contact is!

When someone on your address book
updates contact information on the site that was
not listed in your Outlook address book, it asks
you if you want to effect the update—sweet!

WORD
WordToys
For those of you who  often find
yourselves struggling with the Win-

dows Character Map to insert special characters
in Word, we bring great news. No more strug-
gling to find that Euro sign—just install Word-
Toys! The add-on works with Word 2000, XP and
2003—no Microsoft Word 2007 support yet,
unfortunately.

There are plenty of useful features here.
Using WordToys you can save multiple Word doc-
uments all in one go. You can also save all open
documents as a workspace, and then close them;
when you return, all you have to do is choose to
restore your workspace—and all the files you had
open will be opened up again. You can also

choose navigate through your open documents
using tabs!

After you’ve installed it, you will see that
WordToys takes over your Word Toolbar and
allows you to set favourite fonts, symbols, bullet
menus, and more. You will also now have the
ability to save any document as a PDF even if you
don’t have Acrobat installed. By default, Word
2000 displays all the options on its toolbars, just
greying out the unusable ones. WordToys will
remove these to help you unclutter the toolbar. If
you want to remain anonymous when ratting out
your boss—or in any similar scenario—you can use
WordToys to remove information such as Author,
Organisation, and more from the Word docu-
ment. There’s so much more this software can do,

of them by pressing [Ctrl] + [A], or select
each contact individually and press the Export
icon on the toolbar.

You can find the trial version of vCard Wizard
on this month’s CD. It is available for $14.95 (Rs
590) from http://vcard4outlook.4team. biz/ .

LinkedIn Outlook Toolbar
The most common problem you’ll have faced
with your Outlook address books is that your
contacts change their contact details and neg-
lect to inform you. Now, you can’t be informed
about changes in each contact’s details, but you
can at least know when your LinkedIn friends
update their contact details.

The LinkedIn Outlook toolbar allows you to
integrate your Outlook address book with the
LinkedIn database. When you install it, it will
compare all the e-mail addresses in your address
book with the LinkedIn database.

A new icon will be created next to each
e-mail address that matches the database, and if
and when they update their details, the add-on
will ask you whether you want to update the
information in your contact list. In addition, the
software keeps checking to see if those people

WordToys: the most feature-rich add-on for Office
2000 to 2003

What better way to keep your business contacts up-to-date?

The trial version of VCard Wizard allows you to convert
five contacts at a time
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you’re going to have to try it to learn any more!
It is available at http://tinyurl.com/ysyaer (or

you can just search Download.com for it) for
free. It’s also on our June 2007 DVD.

POWERPOINT
Shortcut Manager For 
PowerPoint
If you are a keyboard warrior (and

that’s a good thing), you will love Shortcut Man-
ager for PowerPoint software made by
OfficeOne. The Shortcut Manager allows you to
configure innumerable keyboard shortcuts for
PowerPoint. You can configure all these key
combinations to do tasks like closing all
slideshow windows, selecting pen colour while
presenting slideshows, and more. You can also
run individual macros based on the assigned
keyboard shortcuts. What’s more, you can
download OfficeOne Shortcuts, a free add-on to
Shortcut Manager that provides additional
functionality.

Shortcut Manager is priced at $30 (Rs 1,180)
and can be downloaded from http://tinyurl.com/
38unsl. You can also download the free OfficeOne
Shortcuts from http://tinyurl.com/ 2ve7m5.

EXCEL
Excel Conditional 
Formatting

The ability to achieve conditional formatting
when working with a lot of numbers is a real
boon in Excel. The only challenge here is that
you can have a maximum of three conditional

formatting options at any given point of time.
This restricts you from getting more out of your
worksheet. Not any more! 

The Excel Conditional Formatting add-on,
which you can find on this month’s CD, allows
you to create an unlimited number of rules in
a worksheet. Maths functions such as SUMIF
and COUNTIF can also be used to create new
sets of rules. Another advantage of this add-on
is that you can freeze more than one row or
column in a worksheet, this gives you greater
control over all the the static data you want dis-
played on your worksheet.

CX Now
So you’re stuck with the boring task of making
Excel documents full of graphs showing the per-
formance of your company over the last quarter.
Let’s face it, how many of your viewers actually
look at those graphs in detail? If you use CX Now,
they probably will!

This tool is not really an add-on in the true
sense. When you install it, it shows up under its
own interface, from where you can choose the
type of chart you want to create—from the dif-
ferent pie charts to the more commonly used bar
graphs and loads more. An interesting feature
here is the dashboard function, which allows you
to see your data represented in the form of ana-
logue dials! 

Using CX Now, you can make your charts
more interactive by adding sliders to them when
you input different values on the X and Y axis,
the charts change. All this can be done without
having to recreate the chart from scratch.

You can edit the
data in tables
just like you
would in an Excel
worksheet

Using the mouse will no more be necessary (well, almost!)

Excel Conditional Formatting allows you to add an infi-
nite number of conditional formats to a worksheet!

Make your spreadsheets interactive

Why increase your presentation file size by embedding videos in it
when you can stream them off the Internet right inside your

slideshow? YouTube Video Wizard (available at skp.mvps.org/
youtube.htm) does just that. All you do is provide the YouTube video URL—
and the add-on automatically converts this data to an embedded object
format. When you start your slideshow and click on the Play button in the
frame, the video starts streaming over the Net. Need we say more?

YouTube Video Wizard 
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After the chart is made, you can export it 
to Excel.

Having said that, do bear in mind that 
this add-on is not for beginners. It takes a 
fair bit of ingenuity and chart-making experi-
ence to get the most out of CX Now, but 
once you’ve used it, it’s hard to get back 
to Excel’s inbuilt chart options! Download 
the free version of CX Now from
http://www.businessobjects.com /jump/cxnow/.

THE MICROSOFT
OFFICE SUITE
Zoho Add-on for
Microsoft Office

This one allows you to write a document or
compile a spreadsheet offline and upload it to
your Zoho account without leaving the safe
confines of your Office applications. The add-
on works with Word and Excel but is not com-
patible with the DOCX and XLSX formats in
Office 2007. 

When Outlook is restarted after installing
the Zoho add-on for the first time, you 
are prompted to save your Zoho account
details in the software. You can access 
your Zoho documents from the “Open 
from Zoho” menu on the toolbar. After you’re
done writing a document or creating a spread-
sheet, you can upload it online by going to the
same menu. 

The Zoho Add-on uploads heavily-formatted
and large documents fairly quickly, and when
these are accessed online, the formatting is
mostly similar to the originals. Find this tool on
this month’s CD.

Classic Menu For Office 2007
With the launch of Office 2007, the classic tool-
bars are replaced by the Ribbon. If you’ve been
using Office for some time now, moving over to
the Ribbon could be daunting.

Classic Menu for Office 2007, available on
this month’s CD, will work with Word, Excel

and PowerPoint, bringing back the classic tool-
bars you were so familiar with. It’s a useful tool
if you intend to migrate to 2007 and have the
initial intimidated feeling about it.

Microsoft’s Save As PDF
This add-on from Microsoft allows you to
export and save files to PDF in all Office pro-
grams. It also automatically sends files as e-
mail attachments after having performed the
PDF conversion.

Before this add-on came along, the only way
to save documents as PDF from within MS Office
applications was to use CutePDF—freeware that
is still downloadable from www.acrosoftware.com/
Products/CutePDF/writer.asp.

Find this add-on on this month’s CD.

Office Update Inventory Tool 2.2
This one comes across as a real boon to system
administrators everywhere. The days of man-
ually noting the updates rolled out to 
computers in an office are long gone: the

Office Update Inventory Tool enables admin-
istrators to check several computers for the
status of Microsoft Office 2000, XP, 2003 and
2007 updates.

From a central location, administrators
can run this add-on on client computers to
find which Office updates have already been
installed, which haven’t, and which updates
require administrator privileges. Of course,
the add-on needs to be installed on every com-
puter before the sys-admin gets to use his new-
found powers. We’ve provided the tool on this
month’s CD.

Add-outs?
We’ve tried to restrict the add-ons mentioned
here to freeware and trial versions. However,
these should only whet your appetite: there
are a plethora of paid add-ons too, which you
can find at www.office-addins.com.

If you liked any of the tools we’ve men-
tioned here, you’re going to love the ones at
that site! 

asfaq_tapia@thinkdigit.comThe easiest way to back up all your documents online!

You need now never miss updating Office on 
any workstation
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All relationships in life are based on compatibility…when it’s there—it works! When
absent—kaput! Same goes for our test subjects—the inseparable twosome—
motherboards and processors. This time 21 processors and 48 motherboards
compete for the space in your cabinet

Shrikrishna Patkar
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Sanket Naik and Michael Browne

I
t’s oft said that the best things in life come
in pairs. Even here—in the world of the per-
sonal computer, where philosophy and
romance take a nose dive out of the win-
dow—you’ll find this adage holding good. If

you’ve ever shopped for a computer part-by-part,
chances are you’ll spend a good deal of time decid-
ing on which processor is right for you—matching
processing power with purchasing power.

We at Digit feel the relationship between
motherboard and processor is akin to the rela-
tionship between chassis and engine, where
the choice of one essentially limits the capa-
bilities of the other. Thankfully akin to
Maruti’s and BMW’s—there’s something to suit
every extremity of demand, with a whole lot of
options in between!

THE ENGINE
The drops in processor prices—both from Intel
and AMD—in the past year have made comput-
ing power ridiculously cheap. For Instance, the
Intel Core 2 DUO E6700, which retailed at
Rs 27,500 when we first tested it, (it was the sec-
ond-best processor you could buy then) is now
available for just Rs 8,250! The cheapest proces-
sor that’s available today comes for a paltry
Rs 1,600—of course, it’s an AMD—and the sub-Rs
10,000 PC isn’t a myth anymore. 

Intel’s Core architecture has paid good divi-
dends, while AMD is still stuck with their older
K9 architecture. The newer K10 architecture will
debut on the desktop within the next two
months, so stay tuned for an update. It’ll be
interesting to see whether the new architecture
will topple Intel’s dominating Core. 

The Core 2 Duo and Athlon X2 have pushed
desktops into the realm of dual-core comput-
ing, and now, it’s quad-core that’s making its
presence felt. Last year, Intel’s Core 2 QX6700
was atrociously priced at Rs 52,000, but it’s
now down to a meagre Rs 11,750. While Intel
was first to market with their quad-core
processors—two dual-cores slapped on to a sin-
gle die—AMD is taking their own time to come
with a native quad-core processor—designed
from the ground up to be quad-core, unlike
Intel’s smart approach.

Multi-core might be the future that both
Intel and AMD are projecting, but as it stands
today, the software we use can hardly tap into
power on offer. The software industry will take
another two to three years to catch up to the
hardware, and it’ll be worth the wait. 

We’ve rounded up twelve processors from
AMD, from the very basic Semprons to the
Athlon64 X2s and the special BE series of
power-efficient processors. From Intel, we have
most of the updated Core 2 Duos, the Q6600
quad-core, and the top-of-the-line QX 6850. For
reference, we have included the older genera-
tion Core 2 Duos from our last test—but they
aren’t available in the market anymore. 

Performance
We start with real-world applications like
audio / video encoding, games and 2D / 3D ren-
dering—the performance of these application
depends quite heavily on the processor. After
that come the synthetic benchmarks—
Wprime, Sciencemark 2.0, WinRAR 3.7 and
SiSoft Sandra 2007.

Gaming
Company of Heroes
In this RTS game, we see the Core 2 Duo
E6850 at the top spot, outdoing even its quad-
core sibling—the QX6850—by a small 5 fps.
The same peculiarity turns up with the E6600

and Q6600—for some reason, the quad-core
processors are taking a hit in this particular
game. The top spots are all taken by Intel
processors, with fabulous frame rates. The
Athlon64 6400+ doesn’t quite make a mark
here, and there is a difference of 67 fps
between it and the E6850. Interestingly, the
Athlon64 X2 BE2350 (the power efficient
series) processors keep up well with rest of
the Athlons—a proper balance of power effi-
ciency and performance. 

Far Cry
Again, very similar results—the quad-core
processors are barely able to deliver better
scores than their Core 2 Duo counterparts.
Unless games are programmed to take advan-
tage of multi-processor environments, we’ll
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see negligible performance gains. Except for
the E4400, all other Intel processors gave us
better fps scores than AMD’s top-end proces-
sors. The Athlon64 5600+ fell just shy of the
E4400 by one fps, and we think it offers the
best value for money among the AMD bunch.

Doom 3
The results for Doom 3 are quite similar to other
two games—the quad-core processors from Intel
fall short of expectations. 

Intel’s processors are clear winners in the
gaming arena; no gaming PC should be without
one. Interestingly, AMD’s Athlon64 X2 5200+
does come close to Intel’s new E4400, and offers
similar value.

DivX Encoding
The graph you see is more the shortcoming of the
DivX encoder than the processors’—the encoder
hasn’t incorporated code for multiple processors.
We see better results with increasing clock
speeds, and not multiple cores. Again, the quad-
core processors trail their dual-core counter
parts, albeit by a very small margin. All the top-
end Intel processors outdo AMD by a significant
margin. The duel between Athlon64 X2 5200+
and E4400 should be noted again—they’re sepa-
rated by a hair’s breadth. The Athlon64 X2 BE
2350 and 2300 trail behind the Semprons—this
again is because the encoder favours higher clock
speeds, so the lower-clocked BEs take a hit. 

Machine Configuration
All Intel LGA 775-based processors are tested on an ASUS P5K Deluxe
motherboard, based on Intel’s P35 Chipset. For AMD processors, we
use an ASUS M2A-VM HDMI motherboard, based on AMD’s 690
chipset. Corsair stays our choice for memory—we used 2 GB of 1066
MHz RAM at 4-4-4-12 settings (wherever possible). An XFX 8800 GTX
graphics card was used on this rig, with NVIDIA’s ForceWare version
158.22. On the software front, Windows XP with SP2 was freshly
loaded on a Hitachi 7200 RPM, 250 GB SATA drive. Coolermaster Real
Power Pro 550 watt powered the rig. The drive was defragmented
before each new processor run. The motherboards used were
updated with the latest available BIOS patches; driver releases for
chipsets and other critical peripherals were updated as well.   

Benchmarks
PCMark 05 and 3DMark 06: These benchmarks from FutureMark
are widely used to gauge performance on a system- as well as sub-
system-level. Though mostly related to graphics performance, each
of these benchmarks has a really well-developed CPU test that taxes
the processor to the maximum. We used the default settings and run
only the CPU test. Each test was run thrice.
Far Cry and Doom 3: Both these games boast high graphic details,
and are quite taxing on the processor, making them ideal processor
benchmarks. We ran both of them at 640 x 480 and 800 x 600 to
put more stress on the CPU.
Company of Heroes: This is the latest in the breed of RTS games
and one that can bring the best of machines down to their knees
with its ultra. Settings were kept at high, and since the game doesn’t
allow 640 x 480, we used 800 x 600 and 1024 x 768. The built-in
benchmark gives the resulting fps.

DivX Encoding: We encoded a 100 MB VOB file to DivX using the
DivX 6.2.5 video converter. This benchmark is run thrice for each
processor, and the final score is an average of the three encoding
times. 
CINEBENCH 10.1: CINEBENCH 10.1 is a free benchmarking tool for
Windows and Mac OS. It is based on the CINEMA 4D engine.
CINEBENCH 10 tests processors for OpenGL processing,
multithreading and multi-processing. 
POV-Ray 3.6: The Persistence Of Vision raytracer, a tool that creates
an image by mathematical calculation. The number-crunching
involved is processor-intensive, making it a great processor
benchmark. In the default installation, we used the “Chess2” and
“landscape” scenes to be rendered at 1024 x 768 resolution without
anti-aliasing. 
ScienceMark 2.0: ScienceMark 2.0, as the name suggests, is a
benchmark based on scientific calculations. This benchmark consists
of multiple benchmarks that test the various aspects of a processor.
We use the Molecular dynamics, Primordia, Cryptography, Stream
and Memory benchmarks. 
WinRAR 3.7: WinRAR 3.7 offers a built-in benchmark, operating on
random data that is processed in the memory—this prevents hard
disk performance from affecting the test results. 
W Prime: A small freeware utility that calculates square-roots
of large of numbers. This utility is multi-threaded, so takes good
advantage of multi-core processors. We use the 32 M
calculations option.      
SiSoft Sandra 2007: This is the good old benchmarking tool with
newer tests. We logged scores particularly related to the CPU, such
as Dryhstone, Whetstone, Multimedia index (Integer and Float) and
Cache performance for a 4 MB data block. 

How We Tested
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expected, the quad-cores have a
clear lead. Except for the E4400,
all other Intel processors are clear-
ly ahead of their respective AMD
counterparts. 

3D Mark 06 And PC Mark 05
The quad-cores are at the head of the pack, fol-
lowed by the top end dual-cores from Intel.
AMD’s 6400+ also comes very close to third
position in the 3DMark benchmark. These
benchmarks serve as a good indicator of how
well applications optimised for multi-core
processors scale when presented with the right
environment. AMD’s Athlon64 X2 5200+ man-
ages to stay ahead of Intel’s dual-core E4400,
and that’s commendable.  

Verdict
Overall, the scene hasn’t changed much—Intel
clearly dominates most of the benchmarks,
except for scientific calculations where AMD’s
traditionally strong FPU gives them a small
lead. If you want the best CPU available, it’s
Intel’s Core Quad QX6850 which retails for Rs
52,000. However, we’re all looking for value
within our budgets, so read on to find out
which processors give you the best perform-
ance for your budget. 

Decision Maker
In this graph, we’ve normalised both price and
performance with respect to Intel’s QX6850,
which is the best processor you can buy. 

Reading the graph is quite simple—in a par-
ticular price range, compare two adjacent
graphs. For example, let’s take the Athlon64
4200+ and the Sempron 3800+. For a two-unit
rise in price, you can get up to thirteen more
units of performance from the 4200+, making it
a better buy than the 3800+. Similarly, you can
compare other models to figure out which
processor gives the best bang for the buck. 

We’ve divided the graph into three price
ranges. The best performer in each category is
used as a point of reference. 
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CineBench 10
The graph has two bars—the top bar represents
CineBench’s using all cores and the bottom bar
is the performance achieved with just a single
core. Intel’s QX6850 rips apart the competition,
as does the affordable Q6600. For the first time,
the Athlon64 X2 6400+ makes it to the top
league. Interestingly, X2 5200+ beats the Intel
E4400 by a fair margin in both Single as well as
multi-core environments. 

WPrime
This time we choose Wprime over Super-Pi—it
scales better with multi-core processors and
clock speed.  The results are a mixed bag, with
Intel’s quad-cores taking the top slots—they are
able to work with four threads each time, and
hence complete the calculation faster. On the
dual-core front, higher clock speeds determine
the results—the AMD 6400+ and 6000+ follow,
ahead of the E6850 and E6750.

ScienceMark 2.0
Scientific calculations have always been AMD’s
strength and we’ve seen this happen in all proces-
sor comparisons. AMD’s FPU completely domi-
nates—the Athlon64 X2 6400+ comes out top, fol-
lowed by the 6000+. Intel’s QX6850 and E6850 are
separated by a small margin for third place. 

WinRAR 3.7
WinRAR’s built-in benchmark gives a good indi-
cation of processors’ capability at compressing
files, and it also supports multi-threading. As
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Over Rs 10,000
In this category, both the E6850 and Q6600 are
equally good. The E6850 has a clear lead in sin-
gle-threaded applications (which dominate our
everyday lives), but on multi-threaded applica-
tions, the Q6600 trounces the E6850—it’s the
more future-proof option. The Athlon64 X2
6400+ does perform well, but on price / per-
formance scale we won’t recommend it. Intel’s
poster boy—the QX6850—is the ultimate num-
ber-cruncher money can buy today; if you have
dough, go for it. 

Of course, behind every good processor is a
motherboard—read on to find the perfect
match for your purchase.

Under  Rs 5,000
In the sub-5000 category, we find only AMD
processors. It’s quite clear that the Athlon64
X2 4200+ offers the best bang for the buck.
Both the BE2350 and BE2300 offer relatively
less performance, but with a TDP (Thermal
Design Power) of 45W, they’re aimed at power-
conscious users.

Semprons, though good processors, should
only be considered if you want the bare mini-
mum configurations. 

Rs 5,000-10,000
This is an important category—most of us end
up buying processors in this range. The cate-
gory is fairly large with a wide distribution, so
we’ll subdivide it into Rs 5,000-7,500 and
Rs 7,500-10,000. In the Rs 5,000-7,500 category,
AMD’s Athlon64 X2 5000+ offers the maxi-
mum value, followed by the Athlon64 X2
5200+. In the Rs 7,500-10,000 bracket, Intel’s
E6750 offers good value for money and should
be considered over all other processors in this
category when building a gaming or enter-
tainment system. 
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BRAND 
MODEL

Price (Exclusive Of Taxes)
Comments

Performance (Out Of 100)
Features
Single/Dual/Quad Core
CPU Frequency
L2 Cache
Performance
ScienceMark 2.0 

Molecular Dynamics
Primordia
Cryptography
Stream
Memory Benchmark

WinRar 3.3
Resulting Rate
SiSoft Sandra 2007
Arithmetic Benchmark 

Dhrystone
Whetstone

Multimedia Benchmark 
Integer
Float

Cache Memory (4MB score)
Wprime (32 Million)
Cinebench 9.2 
CPU Benchmark 

Rendering 1 CPU
Rendering 2 CPU

Graphics Benchmark
PovRay 3.16

Chess2 (1024 x 768)
Landscape (1024 x 768)

DIVX Encode (sec)
PCMark 05 (CPU Score)
3DMark 06 (CPU Score)
Games
Far Cry
640 x 480
800 x 600
Doom 3
640 x 480
800 x 600
Company Of Heroes
800 x 600
1024 x 768

Scoreboard                      Intel
Intel

Intel E6850

12,500
+ Good performance

– Relatively expensive

68.64

Dual Core
3 GHz
4 MB

1469.17
1539.89
1421.32
1876.05
1853.42

1470 KBps

27,694
19,299

165430
90,030
39,110
29.92 sec

3090
5928
6178

240.69 sec
116.66 sec
69 sec
7715
2692

142 fps
160 fps

264 fps
262 fps

215 fps
194 fps

Intel
Intel QX6850

52,000
+ Superb performance

– Very expensive 

81.69

Quad Core
3 GHz
8 MB

1457.11
1514.82
1421.4
1894.05
1864.91

2029 KBps

55356
38682

330984
180097
81288
14.96 sec

3089
10819
6233

240.97 sec
116.33 sec
70 sec
9688
4729

141 fps
161 fps

262 fps
263 fps

210 fps
190 fps

Intel
Intel E6750

8,250
+ Good value for money

– NA

62.73

Dual Core
2.66 GHz
4 MB

1305.47
1364.14
1269.72
1884.7
1824.46

1422 KBps

24608
17182

147046
80036
34892
33.6 sec

2750
5271
5877

266.7 sec
130.86 sec
76 sec
6873
2401

129 fps
146 fps

243 fps
239 fps

199 fps
182 fps

Intel
Intel E6700

NA
EOL*

61.53

Dual Core
2.66 GHz
4 MB

1306.88
1350.68
1267.86
1578.56
1663.35

1386 KBps

24,625
16,984

147199
80,074
34,781
33.7 sec

2752
5197
5927

269.72 sec
131.56 sec
77 sec
6863
2385

128 fps
142 fps

235 fps
234 fps

194 fps
179 fps

Intel
Intel Q6600

11,750
+ Excellent value for money

– NA

67.32

Quad Core
2.4 GHz
8 MB

1167.55
1213.43
1141.2
1573.85
1641.04

1817 KBps

44348
30896

264838
144085
65423
18.62 sec

2481
8779
5080

314.28 sec
145.55 sec
84 sec
7769
3808

118 fps
133 fps

220 fps
219 fps

175 fps
170 fps

NOVEMBER 2007NOVEMBER 2007

* EOL (End of life)

* EOL = End of Life Product: included for reference
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Intel
Intel E6600

NA
EOL*

56.76

Dual Core
2.4 GHz
4 MB

1173.41
1221.25
1142.73
1583.34
1654.85

1331 KBps

22134
15301

132519
72168
31472
37.39 sec

2484
4693
5412

299.67 sec
145.8 sec
83 sec
6166
2151

117 fps
132 fps

220 fps
219 fps

180 fps
173 fps

Intel
Intel E6400

NA
EOL*

49.37

Dual Core
2.13 GHz
2 MB

1044.3
1088.84
1015.75
1585.04
1612.63

1209 KBps

19681
13608

117764
64112
5120
41.54 sec

2186
4134
4699

359.44 sec
163.97 sec
94 sec
5490
1905

102 fps
114 fps

182 fps
184 fps

142 fps
144 fps

Intel
Intel E4400

5,500
+ Relatively inexpensive

– Mediocre perfrormance

44.40

Dual Core
2 GHz
2 MB

974.45
1024.52
951.2
1186.11
1273.71

985 KBps

18489
12891

110384
60110
4308
44.95 sec

2043
3919
4441

364.8 sec
174.1 sec
103 sec
5140
1781

91 fps
100 fps

160 fps
161 fps

123 fps
126 fps

Intel
Intel E6300

NA
EOL*

44.52

Dual Core
1.87 GHz
2048 KB X 2

914.32
957.17
890.68
1578.94
1586.38

1138 KBps

17234
11887

102834
55989
5015
47.42 sec

1917
3648
4292

382.92 sec
187.41 sec
105 sec
4809
1673

93 fps
103 fps

165 fps
164 fps

125 fps
128 fps

AMD
Athlon 64 X2 6400+

10,500
+ Good performance

– Not so good for gaming

57.85

Dual Core
3.2 GHz
2 MB

1634.23
1546.16
1629.79
1894.98
1810.05

1257 KBps

23,225
19574

60,226
66,328
3360
25.5 sec

2707
5284
4887

241.9 sec
120.6 sec
90 sec
6543
2454

99 fps
112 fps

191 fps
190 fps

148 fps
149 fps

AMD
Athlon 64 X2 6000+

7,200
+ Reasonable performance

– NA

54.16

Dual Core
3 GHz
2 MB

1528.46
1506.18
1529
1778.85
1711.84

1196 KBps

21767
18303

56491
62096
3282
28.7 sec

2550
4991
4523

259.3 sec
128.9 sec
94 sec
6130
2301

93 fps
105 fps

178 fps
178 fps

134 fps
139 fps

AMD



Scoreboard AMD
AMD

Athlon 64 X2 5200+

5,300
+ Better than E4400

– Average performance

47.40

Dual Core
2.7 GHz
1 MB

1366.73
1298.17
1372.19
1675.27
1613.24

1061 KBps

19592
16464

50791
55903
3466
31.95 sec

2212
4280
4225

293.31 sec
179.61 sec
104 sec
5491
2055

80 fps
90 fps

153 fps
153 fps

111 fps
111 fps

AMD
Athlon 64 X2 5000+

5,000
+ Affordable

– Mediocre performance

45.44

Dual Core
2.6 GHz
1 MB

1323.86
1256.26
1322.04
1630.19
1565.53

1013 KBps

18845
15869

48909
53830
3355
33.19 sec

2133
4140
3896

301.59 sec
193.64 sec
108 sec
5277
1979

76 fps
87 fps

147 fps
148 fps

102 fps
106 fps

AMD
Athlon 64 X2 5600+

6,300
+ Good value for money

– Mediocre gaming performance

51.84

Dual Core
2.8 GHz
2 MB

1424.39
1357.15
1428.52
1772.58
1706.36

1191 KBps

20330
17168

52767
58044
3615
30.76 sec

2387
4681
4507

282.36 sec
137.91 sec
98 sec
5723
2158

90 fps
102 fps

175 fps
176 fps

134 fps
134 fps

AMD
Athlon 64 X2 5400+

6,000
+ Good performance for the price

– 1 MB cache

50.15

Dual Core
2.8 GHz
1 MB

1423.98
1358.28
1430.74
1794.65
1763.31

1156 KBps

20332
17208

52780
58062
3670
30.68 sec

2314
4486
4317

277.7 sec
170.2 sec
100 sec
5720
2145

84 fps
97 fps

165 fps
164 fps

122 fps
121 fps

BRAND 
MODEL

Price (Exclusive Of taxes)
Comments

Performance (Out Of 100)
Features
Single/Dual Core
CPU Frequency
L2 Cache
Performance
ScienceMark 2.0 

Molecular Dynamics
Primordia
Cryptography
Stream
Memory Benchmark

WinRar 3.3
Resulting Rate
SiSoft Sandra 2007
Arithmetic Benchmark 

Dhrystone
Whetstone

Multimedia Benchmark 
Integer
Float

Cache Memory (4MB score)
Wprime (32 Million)
Cinebench 9.2 
CPU Benchmark 

Rendering 1 CPU
Rendering 2 CPU

Graphics Benchmark
PovRay 3.16

Chess2 (1024 x 768)
Landscape (1024 x 768)

DIVX Encode (sec)
PCMark 05 (CPU Score)
3DMark 06 (CPU Score)
Games
Far Cry
640 x 480
800 x 600
Doom 3
640x480
800 x 600
Company Of Heroes
800 x 600
1024 x 768



AMD
AMD

Athlon 64 X2 4200+

3,200
+ Excellent value for money

– Relatively slow

40.60

Dual Core
2.2 GHz
1 MB

1120.58
1069.52
1124.32
1541.23
1493.3

990 KBps

15977
13501

41469
45624
3270
39.07 sec

1826
3575
3623

357.9 sec
214.8 sec
119 sec
4512
1698

69 fps
79 fps

137 fps
138 fps

93 fps
95 fps

AMD
Athlon 64 X2 BE-2300

4,000
+ Low wattage (45w)

– Mediocre performance/price

35.42

Dual Core
1.9 GHz
1 MB

964.05
916.11
967.72
1359.23
1374.53

900 KBps

13783
11583

35710
39285
3260
45.34 sec

1574
3094
3282

416.95 sec
250.84 sec
137 sec
3875
1470

61 fps
70 fps

121 fps
122 fps

78 fps
81 fps

AMD
Athlon 64 X2 BE-2350

4,300
+ Low wattage (45w)

– Mediocre performance/price

37.86

Dual Core
2.1 GHz
1 MB

1070.36
1013.81
1063.15
1442.11
1361.53

908 KBps

15210
12808

39485
43437
3018
41.09 sec

1732
3392
3385

376.8 sec
230 sec
128 sec
4282
1611

64 fps
74 fps

126 fps
126 fps

82 fps
85 fps

AMD
Sempron 3800+ 

2,200
+ Affordable price

– Single Core

30.25

Single Core
2.2 GHz
256 KB 

902.07
827.51
1076.24
1730.24
1658.06

505 KBps

7969
6735

20693
22706
2999
78.21 sec

1765
NA
3774

356.33 sec
355.14 sec
120 sec
3216
856

64 fps
64 fps

88 fps
89 fps

64 fps
64 fps

AMD
Sempron 3600+ 

1,800
+Affordable price

– Low cache

28.50

Single Core
2 GHz
256 KB

809.31
752.03
982.44
1685.95
1657.29

505 KBps

7243
6109

18823
20641
2940
85.95 sec

1627
NA
3634

394.42 sec
362.91 sec
128 sec
2908
785

61 fps
62 fps

84 fps
85 fps

61 fps
63 fps

AMD
Sempron 3600+ 

1,600
+ Cheapest processor

– Low on performance

27.97

Single Core
2 GHz
128 KB

806
780.84
983.57
1744.94
1796.75

482 KBps

7249
6117

18825
20628
2955
85.6 sec

1559
NA
3483

388.64 sec
371.78 sec
129.65 sec
2858
774

59 fps
59 fps

78 fps
77 fps

55 fps
57 fps
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THE CHASSIS
A couple of years ago, if you thought a good
motherboard was a luxury, we’d have forgiven
you. Today, because of the slew of motherboard
vendors who have flooded our markets over the
last year, it’s not any more—in terms of neither
availability nor cost. We’re not talking about
just a small brand office in a couple of metros,
but actual market availability.

We’ve busted another myth this year as
well—motherboards based on the latest
chipsets aren’t as expensive as you’d expect
them to be anymore! Vendors in India have tra-
ditionally categorised the market into two sec-
tions—those who can afford good boards and
those who can’t. The former section of PC users
have been wooed with expensive premium offer-
ings, while the latter section have to be content
with value boards that are wafer-thin on fea-
tures. This time round, we’ve truly seen some-
thing for everyone, and it’s you—the cus-
tomers—who are to be thanked for this!

You’ve become more discerning and you
know what you want—during one of our
sojourns to Lamington Road (Mumbai’s hard-
ware hub) we were pleased to see customers
actually asking for boards on the basis of
chipsets and brands. In fact, they’d Googled
up the specifications and features of the
boards they were interested in, and weren’t
moved by the shopkeeper who was trying to
placate them with other offerings.

INTEL P35-BASED
MOTHERBOARDS
Intel’s P35 chipset is their replacement for the
older (and excellent) P965 chipset.
Motherboards based on this chipset have native
support for the 1333 MHz FSB that the new
Core 2 Duo processors (E6x50) support.
Additionally, they will also support the upcom-
ing 45 nm Penryn. The memory controller sup-
ports DDR3, but Intel has left it to vendors to
decide whether to provide DDR2 or DDR3 slots.
The Southbridge—ICH9R—is also rumoured to
be better; the P965’s used the ICH8R.

Features
Of the 15 boards in this category, we chose to
compare only 14 on the same platform. The ASUS
P5K3 Premium is a luxury even among luxurious
boards (a Bentley among Mercs, if you will). It’s
the first board we’ve seen embedded with 2 GB of
DDR3 memory—there are no memory slots.
There’s enough copper on the board for it to be
used as a very heavy albeit costly weapon! Priced
at Rs 70,000, this is a sin-
ful indulgence—not to
mention the sad fact
that you cannot upgrade
to 4 GB of RAM whatever
you do!

All the ASUS P35
boards had excellent lay-
outs and were exception-
ally well built, with good
quality components. We
had one major grouse—

the first two SATA ports are blocked (though not
completely so as to prevent their use) by large
graphics cards like our 8800GTX. ASUS provides
dual Gigabit LAN ports and integrated Wi-Fi on
their Deluxe and Premium boards. The ASUS Blitz
series is part of their Republic of Gamers fran-
chise, which means they are more overclocker-
friendly than the other boards, have a lot of most-
ly flashy and sometimes useful LEDs, and cost,
well, a lot (Rs 17,000 and above)! The Blitz mother-
boards also had water blocks on the Northbridge
cooling solution for extreme tweakers who plan
on using liquid cooling solutions. Furthermore,
the Blitz boards have a special LCD screen to dis-
play the POST (Power-on Self-test) status—instead
of the regular hexadecimal POST display, ASUS
offers an LCD that converts the hexadecimal value
to regular English—nifty, but you pay a premium
for this feature.

Abit’s IP-35 Pro Off Limits has a very useful
CMOS reset switch on the back panel (something
ASUS does with a button on their Blitz series).

The IP-35 Pro is very overclocker-
friendly—very well laid out and

numerous BIOS options. It
even has a HEX error

code poster to
make debug-

ging easier.
The IP-35 E

is aimed at the
general audience—

and although it overclocks
well, it misses out on some of the

finer nuances (like the CMOS reset button).
Gigabyte’s P35 DQ6 comes with a lot of cop-

per in the form of an elaborate heat-pipe solu-
tion that we found downright ugly. Compared to
the ASUS P5K Deluxe and Premium—which dis-

sipate the same amount of heat and are aimed at
the same audience (overclockers)—we don’t see
the need for such a massive cooling solution. It
also boasts of Gigabyte’s “6 Quad” features—
though this is more marketing speak than any-
thing significant. While a 12-phase power supply
to the CPU sounds good, this is a novelty rather
than a very useful feature, and a six- or eight-
phase design will do just fine. We did like the
high quality, solid state capacitors, which should
improve durability significantly.

MSI’s P35 Diamond is another good looker
(though the ASUS boards definitely look better).
The BIOS also has a very annoying setting for
increasing voltages—you have to keep using the
plus (+) and minus (-) keys to change them.
BioStar’s P35 doesn’t allow the CAS latency to
go lower than 5—this is a bane for overclockers,

ASUS
P5K Premium
The ultimate premium board

NOVEMBER 2007

Traditional SATA connects interfere with bigger
graphics cards and cause clutter

SATA ports that face outwards like this prevents cable
clutter and won’t foil larger graphics cards
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and does affect performance during bench-
marking. There’s a flaw with the layout of this
board—the 24-pin power connector is placed
bang in the middle of the motherboard, and
right between the CPU and graphics card—two
very hot components; we have to wonder what
BioStar was thinking!

In terms of overclocking features, all these
boards allow you to play around, but ASUS’ BIOS
is very newbie-friendly—and you can safely over-
volt your CPU with minuscule increments of
0.00625 volts!

ECS’ P35 doesn’t support memory frequencies
above 800 MHz—a pity for those who happen to
have fast memory—and hence limits overclocking.
Additionally, the BIOS doesn’t allow you to fix the
multiplier and there’s no option to enable or dis-
able EIST (Enhanced Intel SpeedStep—a standard
option on boards for Core 2 Duo processors).

MSI’s P35 Neo is a nice value offering at
Rs 6,600 after all the Rs 12,000-plus offerings
from ASUS and Gigabyte. It’s well laid out,
though shy on some of the extra frills like E-
SATA, POST displays and power buttons on the
board, copper heatpipes etc.

Performance
We noticed that the DDR3 motherboards per-
formed slightly better—this shows that the
Intel Core 2 Duo is sensitive to bandwidth

changes (800 MHz vs. 1066 MHz) in spite of the
slower timings that plague DDR3.

ASUS’ Blitz Formula, P5K Premium, and
Gigabyte’s GA-P35 DS3R were the best performers,
followed closely by ASUS’ P5K Deluxe and Abit’s
IP-35 Pro and MSI’s P35 Platinum. We aren’t
really looking at the DDR3 based solutions as
viable till the cost of DDR3 memory falls off its
current lofty perch.

Incidentally, the Abit IP-35 Pro cheats a lit-
tle by keeping the FSB at a default of 272 MHz,
and you must manually get it down to 266 MHz
(which should be the default speed)—this does

We categorised our motherboards based on the way customers
like to buy them—on the basis of the all important chipset: 

� Intel P35-based
� NVIDIA 680i / 650i-based
� Intel P965-based
� All boards  with integrated graphics (for those who can’t be
bothered with an add-on graphics card

We used the following test components:

In addition, we installed the latest BIOS updates and drivers,
downloaded from the manufacturers’ sites.

Features
Besides all the regular features, we also took a special look at the
layout of the motherboards, and rated them on general component
layout—capacitors around the CPU region, placements of IDE and
SATA connectors, power connectors, memory slot placement, the
type of VGA slot retention mechanism and so on. Due to space
restrictions in these pages, we’ve shown an average score of all
these parameters.

We also looked very carefully at overclocking options that
many motherboards today provide. With overclocking becoming
very idiot-proof, anyone can play around with BIOS settings safely.
Enthusiasts will also find a lot of valuable information as far as
CPU and memory voltage parameters go.

We haven’t talked about RAID support—all boards
today support RAID 0, 1, 0+1, 5 and 10, so this data is redundant
and unnecessary.

Performance Tests
Synthetic Tests
PC Mark 2005: This benchmark runs 48 discrete tests to test each
performance-related subsystem—the processor, memory, video
and storage. Finally, it throws out a final score—which is a
weighted average of the individual results.

SiSoft Sandra 2007 Engineer: Sandra 2007 has specific
benchmarks to test all the subsystems of a PC. It tests a CPU’s

floating point crunching ability under both
arithmetic and multimedia applications. The
application supports multiple cores and scales well
in this regard. It also tests the read and write
performance of the storage subsystem, and the
memory’s bandwidth. 

3D Mark 2005: Our graphics benchmark of
choice, mainly because it allows for greater variation

in results than the newer 3D Mark 2006. 

Real World Tests
Video encoding: This is a CPU-intensive test and tells us exactly
how optimised the motherboard in question is.

File transfer test: We copy a single 4 GB file from one physical
hard disk to another. This tells us a lot about Southbridge data
path optimisations on each motherboard, and how fast data is
moving around between hard disks.

Doom 3 And Splinter Cell Chaos Theory: Doom 3 uses a
very sensitive engine that even responds to changes in
memory timings or a hard drive change! Chaos Theory is
very scalable and very CPU- and shader-intensive. At a
resolution of 640x480 with all details off, we’re basically
allowing the CPU to run wild while limiting the role of the
graphics card. At 1600x1200—the maximum settings—any
game becomes CPU-limited and any increase in frame-rate can
be attributed to the graphics card and its respective data
paths on the motherboard.

How We Tested

Processor
Memory

Graphics
HDD 

OS
VGA Driver version

Intel
Core 2 duo X6800 @ 2.93 GHz
Corsair Dominator PC2 8500 @ 800 MHz (4-4-
4-12) / Kingston PC3 8500 @ 1066 MHz (7-7-7-24)
NVIDIA 8800 GTX @ 575/1800 MHz
Western Digital Raptor 10,000 rpm 74 GB x 2

Windows XP Prof SP2
Forceware 158.22

AMD
Athlon X2 6400+ @ 3.2 GHz
Corsair Dominator PC2 8500 @ 800
MHz (4-4-4-12)
NVIDIA 8800 GTX @ 575/1800 MHz
Western Digital Raptor 10,000 rpm 74
GB x 2
Windows XP Prof SP2
Forceware 158.22
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give it a slight edge, as the Core 2 Duo X6800
runs at 2992 MHz instead of 2933 MHz.

A surprise was in store when the MSI P35
Diamond and P35 Platinum came up with very
good CPU performance in our video encoding
test, in which a difference of one second is
huge—especially when you consider the fact
that all speeds and voltages were kept identical.

Verdict
We’re impressed by the sheer performance pro-
vided by ASUS’ P5K Premium. The fact that it’s
a superb looker and comes with an excellent
bundle of connectors and add-ons just ampli-
fies our decision to award a Digit Best Buy Gold to
this excellent product.

Gigabyte’s GA-P35-DS3R stuck close to the
ASUS P5K3 Deluxe (a DDR3-based board)
throughout the tests and we’re awarding these
two a joint Digit Best Buy Silver.

Other boards that impress on the perform-
ance front are the P5K Deluxe and Blitz
Formula from ASUS, Abit’s IP-35 Pro Off Limits
and Gigabyte’s GA-P35-DQ6.

If you’re looking for an enthusiast solution
that overclocks well and simplifies the process,
select any of the ASUS boards we’ve mentioned.

If you want something a little cheaper, take
a look at Abit’s IP-35 Pro Off Limits, Gigabyte’s
GA-P35DS3R or MSI’s P35 Platinum.

If you’re looking for value we suggest either
MSI’s P35 Neo or Abit’s IP-35 E Off Limits priced
at Rs 6,600 and 8,500 respectively.

We suggest avoiding the cheaper offerings—
unless you have an absolute shoestring budget
and must have a P35 chipset based board.

NVIDIA 680I/680I LT/650I SLI
AND 650I ULTRA-BASED
MOTHERBOARDS
NVIDIA’s 680i has been around for a while, but
it was a path breaking chipset when launched,
and thanks to some future-proofing on

NVIDIA’s part, it still has the goods to take on
the P35-based boards. The high-end 680i boards
are the exclusive domain of the lightning fast
Core 2 Duo processors from Intel, so you’ll see
no AMD based solutions here.

The 680i LT is a lower version of the 680i core
logic, and manages to do without faster memory
profiles—the 680i is optimised for 1200 MHz SLI-
ready memory. These platforms support SLI and

a full 16 PCI Express
lanes to each

graphics
card.

The 650
SLI offers 8 lanes

to each card, while the
650 Ultra is a single PCI Express.

The 6xx family from NVIDIA also has
one very important feature for overclockers—they
allow for overclocking independent of memory
dividers. This means you no longer have to both-
er with maintaining memory to FSB ratios while
overclocking like you have to with Intel boards.
This is a boon for those who have cheaper RAM
but want to overclock their machines. On Intel
boards, as the FSB speed is bumped up, your
memory also has to match up to maintain a pre-
defined ratio—typically 2 : 1 or 3 : 1. For example,
for an FSB of 266 MHz your memory should be
capable of running at 800 MHz (266 x 3) if the
memory divider is set at 3.

Besides this, the 680i/LT allows overclockers
to set memory reference voltages, as well as set
reference voltages for the Northbridge and
Southbridge as well as overvolt them (which
most chipsets provide an option for).

Features
ASUS’ P5N32-E SLI had perhaps one of the best

ASUS Striker Extreme
The SLI demon

NOVEMBER 2007

ASUS P5K3 Premium: Is it worth the money?

Every once in a while, a product comes along that makes us go
“Ooh, let’s give this one a special box, shall we?” Why the

ASUS P5K3 Premium? Well, for one, it’s four times as expensive
(Rs 70,000) as most of its other (already expensive) siblings! For
another, it’s got this ultra-large and cool-looking heat-pipe
solution that immediately gets the drool out (before we
saw the price tag of course)! And then we noticed there
were no memory banks for RAM…wha...?

This board comes with 2 GB of DDR3
memory integrated—and fast
memory at that (1333 MHz). The
fact that the memory is integrated,
and very obviously matched to the
board means that it performs better
than external DDR3 RAM running at the
same speed. ASUS also guarantees that
this integrated memory will overclock to
1,500 MHz. It’s evident that the memory used
is top-class, simply because we were able to
set very tight timings (1333 MHz at 7-6-6-17 at
1.7 volts), which is pretty incredible considering our 1066 MHz

DDR3 ran at 7-7-7-24!
We got an overall PC Mark score of 8,535 and a memory

score of 6,112, and at the above mentioned timings we got
6329—a very good showing. The only demerit is

that you cannot upgrade memory, which
remains at 2 GB. If ASUS had come out

with a 4 GB variant the board would
probably cost close to a lakh, if not

more…
We honestly believe ASUS

didn’t really expect any takers
for such an expensive

board. Instead, it’s more
like a statement—“Look

at what we can do!”—
something we’ve come to expect from

enthusiast brands.
This is one indulgence we recommend you miss—

considering you could build two healthy PCs for the price of this
board. If you’re insanely rich (or just insane) then you’d probably
discount this bit of advice.



looking cooling solutions ever, and also was brilliantly laid
out. With discrete heat-pipes and sinks for the Northbridge
and Southbridge, this board looks better than the Striker,
which has a lot more copper and deviates from a clean look.

We like copper heat-pipes and heatsinks, but in moder-
ation, please! Just to prove a point, the P5N32-E SLI also ran
cooler than all the other 680i and 680i LT boards. In fact,
despite NVIDIA’s 680i Northbridge’s reputation for heat,
this board didn’t even break the proverbial sweat!

The PCBs of the 680i / 680i LT chipset-based boards are ref-
erence NVIDIA design—in fact, XFX and Galaxy use stock
NVIDIA PCBs. This is why all the benefits of the reference 680i
layout are seen along with its demerits. For one, the power
connector pins on the XFX and Galaxy boards are placed
between the memory slots—something we complained about
when we reviewed the 680i as a platform last year.

Abit’s Fatal1ty FP-IN9 SLI bears the “Approved by
Jonathan ‘Fatal1ty’ Wendel” mark—but we couldn’t find
anything that stands out about this board—right from its
layout to the choice of components (read capacitors) to the
bundle. ASUS’ P5N-E SLI uses the Jurassic SLI switch PCB to
toggle between SLI and single card mode.

The Zebronics 650 SLI uses a reference NVIDIA PCB—
which has a less cluttered layout than the heavily feature-
laden 680i. Galaxy and XFX came up with 650 Ultra
boards—the 650i LT and MB-N650-IUL9 respectively. These
boards allow a variety of overclocking and tweaking
options, and are suitable if you want to stick with a single
graphics card.

Performance
Although there’s no must-have among the 680i/LT and 650
SLI boards in terms of pure performance, we see the ASUS
Striker Extreme edging out all the others by a tiny margin.
Abit’s FP-IN9 SLI does very well in the video encoding test,
and it’s a whole four seconds faster than XFX’s MB-N680-
ILT9—very good CPU performance! The ASUS Striker
Extreme does manage to utilise the Core 2 Duo better when
it comes to real-world gaming—it was consistently 4 to 5 fps
ahead of the other boards under both games. 

Verdict
Let’s face it—enthusiasts don’t have many reasons to go for
a 680i-based board, especially considering Intel’s latest P35
and the just-released X38 chipset. The major reason for this
isn’t performance or features—the 680i is both an excellent
performer and as future-proof as the P35 chipset, which is
a year newer: it’s the price (the P35 is much cheaper). The
680i/LT chipset was targeted at enthusiasts who want SLI or
just an excellent overclocker that allows fine tuning of
every component.
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Scoreboard NVIDIA 680i / 650i chipset based boards
Abit

Fatal1ty FP-IN9 SLI

NVIDIA 650i SLI

LGA 775

650i SLI

nForce 430i

8,000

Good overclocker

Build Quality

69.17

26.40

37.07

5.70

1333 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 2

N / NA

N

2 / 2 / 0

SLI / x8 / x8

Realtek ALC888/8/Y

N / Y

1 / G

N

4 / 1

N

7.08

Y / Y / Y

Y / Y / Y / Y / Y

1.325~1.7v

1.8~2.5v

3 / 1

NA

SLI Connector, SLI

Retention, FireWire

Bracket

7522

6076 / 12706

7512

8552

27169 / 18637

161260 / 87743

70 / 8 ms

5661 / 5640

16981 / 9510

68.54 sec

53.47 sec

231.4 / 118.8 fps

231.4 / 117.2 fps

ASUS

P5N-E SLI

NVIDIA 650i SLI

LGA 775

650i SLI

nForce 430i

8,280

Good layout, price

Ancient SLI switch

71.20

28.24

37.46

5.51

1333 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

Y / 1

N

2 / 1 / 0

SLI / x8 / x8

Realtek ALC885 / 6 / Y

Y / N

1 / G

N

4 / 1

N

6.71

Y / Y / Y

Y / Y / Y / Y / Y

0.83125~1.6v

1.92~2.517v

3 / 1

NA

SLI Connector

7522

6197 / 12738

7033

8560

27158 / 18728

161360 / 87882

72 / 8 ms

5874 / 5859

17103 / 10214

70.71 sec

52.35 sec

244.4 / 118.6 fps

234.6 / 118.5 fps

NOVEMBER 2007 NOVEMBER 2007

ASUS

Striker Extreme

NVIDIA 680i

LGA 775

680i

MCP55

21,400

Very fast, great bundle

Very expensive

74.34

34.45

37.76

2.13

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

6 / 1

N / NA

N

2 / 2 / 1

SLI / x16 / x16

ADI 1988B / 8 / Y

Y / Y

2 / G+G

N

4 / 1

Y

6.92

Y / Y / Y

Y / Y / Y / Y / Y

Upto 1.9v

1.8~2.6v

6 / 1

GRAW, 3D Mark 2006

Cooling Fans,

USB Bracket

7558

6220 / 12652

7251

8556

27084 / 18783

161655 / 88038

86 / 8 ms

5770 / 5789

17084 / 10192

70.76 sec

51.8 sec

248.2 / 119.1 fps

236.2 / 117.9 fps

XFX

MB-N680-ILT9

NVIDIA 680i LT

LGA 775

680i LT

MCP55

11,000

Reasonably priced

Skimpy bundle

69.16

27.89

37.13

4.15

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

6 / 1

N / NA

N

2 / 2 / 0

SLI / x16 / x16

Realtek ALC888 / 8 / Y

N / Y

2 / G+G

N

4 / 1

N

6.71

Y / Y / Y

Y / Y / Y / Y / Y

1.2~1.6V

1.8 ~ 2.5V

3 / 1

NA

USB Bracket, SLI

Connector

7538

6111 / 11968

7195

8362

27012 / 18754

161465 / 87901

79 / 8 ms

5746 / 5771

16946 / 9942

72.53 sec

53.1 sec

243.1 / 119.2 fps

233.1 / 117.9 fps

ASUS

P5N32-E SLI

NVIDIA 680i

LGA 775

680i

MCP55

13,800

Great cooling solution

Electrolytic capacitors

73.03

32.48

37.25

3.30

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

6 / 1

N / NA

N

2 / 2 / 1

SLI / x16 / x16

ADI 1988B / 8 / Y

Y / Y

2 / G+G

N

4 / 1

N

7.13

Y / Y / Y

Y / Y / Y / Y / Y

Upto 1.9v

1.8~2.6v

6 / 1

NA

SLI Connector

7526

6099 / 12874

7266

8516

27093 / 18764

161513 / 87931

84 / 8 ms

5707 / 5725

16934 / 9691

71.97 sec

52.98 sec

237.6 / 118.7 fps

229.8 / 118.4 fps

Brand

Model No.

Chipset

Socket

Northbridge

Southbridge

Price (Rs)

+

-

Grand Total (Out Of 100)

Features (Out Of 50)

Performance (Out Of 40)

Price (Out Of 10)

Features

Front Side Bus Speed 

Memory Type / Max Freq. Supported

Memory Supported / No. Of slots

No. Of SATA / PATA Ports

E-SATA Support / No. Of Ports

Integrated Graphics (Y / N)

No. Of PCI / PCI x1 / PCI x4 Slots

Multi GPU Support (SLI / CrossFire / N)

Audio Controller / Channels / HD Compliant (Y / N)

S/PDIF / Optical Port

No Of LAN Ports / Type (10/100 / Gigabit)

Integrated WiFi (Y / N)

No. Of Rear USB / FireWire Ports

All Solid State Capacitors (Y / N)

Component Layout (Scale Of 10)

Overclocking Options

CPU / FSB / Memory

Overvolting (CPU/Memory/FSB/PCIe/Northbridge)

CPU Voltage Range (Volts)

Memory Voltage Range (Volts)

Package Bundle

No Of SATA / PATA Cables

Software Bundle

Other Accessories

Performance

PC Mark 2005

CPU

Memory / Graphics

HDD

Overall

SiSoft Sandra 2007

CPU Arithmetic (Dhrystone / Whetstone)

CPU Multimedia (Integer / Floating)

Drive Index (MBps) / Random Access Time (ms)

Memory Bandwidth Score (Integer / Floating)

3D Mark 2005

3D Marks / CPU Score

Real World Tests

Video Encoding (DivX 6.2) 100 MB File

File Transfer - 4 GB File

Doom 3 (640x480 / 1600x1200, 4xAA, 4xAF)

Splinter Cell Chaos Theory (640x480 / 1600x1200)

Galaxy

680i LT SLI

NVIDIA 680i LT

LGA 775

680i LT

MCP55

9,200

Well priced

Skimpy bundle

69.65

27.44

37.26

4.96

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

6 / 1

N / NA

N

2 / 2 / 0

SLI / x16 / x16

Realtek ALC888 / 8 / Y

N / Y

2 / G+G

N

4 / 1

N

6.71

Y / Y / Y

Y / Y / Y / Y / Y

1.2~1.6V

1.8~2.5V

3 / 1

NA

4 Port USB Bracket

7521

6109 / 12013

7290

8354

27012 / 18751

161404 / 87870

79 / 8 ms

5752 / 5769

16982 / 9989

70.84 sec

52.25 sec

242.1 / 118.3 fps

232.6 / 117.9 fps
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If you want the best SLI solution that won’t bottleneck two 8800 GTX
/ Ultra graphics cards and money isn’t an issue, pick up the ASUS Striker
Extreme for Rs 21,400. There is also a non-extreme version available,
which is equally good and around Rs 2,500 cheaper. 

If you want a really affordable SLI solution, look at Zebronics’ ZEB-
650i SLI—at Rs 4,800, you can pick up two 8600 GTs for the amount you’ll
save from the ASUS Striker Extreme!

If you want a 680i/LT motherboard for the plethora of overclocking
options but don’t want to spend above Rs 15,000, pick up ASUS’ P5N32-E
SLI or Galaxy’s 680i LT SLI for Rs 13,800 and 9,200 respectively.

Our winners are the excellent 680i-bearing ASUS Striker Extreme
(Gold) and ASUS P5N32-E SLI (Silver), for their mixture of raw perform-
ance and overclockability that will deliver the goods to these fraternities.

INTEL P965-BASED MOTHERBOARDS
An older chipset, the P965 still is an excellent product but it finds itself
at the end of its life cycle, and therefore largely redundant with P35-
based boards costing a few hundreds more. Do remember that the P965
unofficially supports the 1333 MHz FSB through BIOS updates, so will
work with the upcoming Penryn processors. The fact that we have seen
P965 boards running at an FSB of over 1600 MHz (overclocked) means
that while the P965 platform may be older, toothless it’s not!

Features
The very term features is synonymous with one board here—the ASUS P5B
Premium Vista Edition, and about the only grouse we can come up with is
its extremely long name! A near-perfect layout, detailed BIOS complete
with superb overclocking options (second only to the ASUS Commando),
and supreme build quality. But wait… there’s also a remote control unit
that allows you to control several functions including the ability to hiber-
nate, power down and even play music. Then there’s the additional tiny
LCD screen unit (that looks like a PMP, by the way) that allows you to view
important pop-ups such RSS feeds and will sync with Web sites when your
PC is on. All this data can be viewed later even when your PC is off!

ASUS’ Commando is another “Republic of Gamers” product complete
with extra overclocking options, LED POST display and LED backlit
power, restart and CMOS reset buttons on the PCB. The P5B Deluxe is a
feature-rich offering that shares an identical layout (right down to the
cooler) with the P5B Premium Vista Edition. The P5B-E is a
lower version of the P5B Deluxe without a wireless access
point and minus a few other frills.

MSI’s P965 Platinum was the only other feature-rich board in
this group—the MSI P965 Neo and Biostar Tforce P965
were the proverbial plain
Janes—all the regular fea-
tures you’d need in
a motherboard
w i t h o u t
the addi-
tional pizzazz
that the costlier
boards show off.

Performance
The sheer toppers in
terms of overall perform-
ance were the ASUS
Commando and the P5B Deluxe—no
wonder these were the kings of the ring before the P35 based mother-
boards came out—and the performance increments are almost insignifi-
cant. In fact, all the ASUS boards gave better 3D Mark 2005 scores than the
other boards in this category, proving that if you want a gaming platform
based on the P965 chipset, you should consider ASUS. Memory bandwidth
scores in SiSoft Sandra’s test suite are also noticeably higher.

For some reason, both the MSI boards took a dip in the SiSoft Sandra
CPU Multimedia tests. The difference isn’t alarming and won’t be really
noticeable in day-to-day applications, but these boards aren’t the best per-
formers around.

Zebronics

ZEB-650i SLI

NVIDIA 650i SLI

LGA 775

650i SLI

nForce 430i

4,800

Well priced

Skimpy bundle

72.36

26.70

36.16

9.50

1333 MHz

DDR2 / 800 MHz

8 GB / 4

5 / 2

Y / 1

N

2 / 1 / 0

SLI / x8 / x8

Realtek ALC885/8/Y

Y / N

1 / G

N

4 / 1

N

6.67

Y / Y / Y

Y / Y / Y / Y / Y

1.2~1.510v

1.8~2.01v

2 / 1

NA

SLI Connector

7518

5686 / 11872

7438

8400

27043 / 18582

161185 / 87781

70 / 8 ms

5126 / 5132

16508 / 9230

71.4 sec

56.2 sec

229.5 / 116.4 fps

230.5 / 116.3 fps

Galaxy

650I LT

NVIDIA 650i Ultra

LGA 775

650i Ultra

nForce 430i

4,800

Well priced

Skimpy bundle

71.57

24.89

37.18

9.50

1333 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

N / NA

N

3 / 2 / 0

NA / x16

Realtek ALC885/8/Y

N / N

1 / G

N

4 / 1

N

6.79

Y / Y / Y

Y / Y / Y / Y / Y

0.83125~1.6v

1.92~2.517v

2 / 1

NA

SLI Connector

7527

6078 / 12660

7470

8525

27071 / 18764

161557 / 87962

70 / 8 ms

5793 / 5783

16880  / 9686

69.67 sec

53.1 sec

236.9 / 119.7 fps

231.5 / 117.8 fps

XFX

MB - N650 - IUL9

NVIDIA 650i Ultra

LGA 775

650i Ultra

nForce 430i

5,700

Good overclocker

Skimpy bundle

71.41

26.44

36.97

8.00

1333 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

N / NA

N

3 / 2 / 0

NA / x16

Realtek ALC885/8/Y

N / N

1 / G

N

4 / 1

N

6.79

Y / Y / Y

Y / Y / Y / Y / Y

0.83125~1.6v

1.92~2.517v

4 / 1

NA

SLI Connector, USB

Bracket

7282

6082 / 12220

7510

8369

27182 / 18728

161206 / 87829

70 / 8 ms

5728 / 5722

16820 / 9692

69.24 sec

53.61 sec

237.2 / 118.5 fps

232.2 / 118.1 fps

NOVEMBER 2007

ASUS P5B Premium Vista Edition
Features galore
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Scoreboard Intel P965 chipset based
ASUS

P5B-E

Intel P965

LGA 775

P965

ICH8R

9,300

Good layout

No solid capacitors

72.22

26.23

41.17

4.83

1066 MHz

DDR2 / 1066 MHz

8 GB / 4

6 / 1

Y / 1

N

3 / 3 / 0

N / x16

ADI 1988B/8/Y

Y / Y

1 / G

N

4 / 1

N

7.00

Y / Y / Y

Y / Y / Y / Y / Y

1~1.6v

1.8~2.6v

6 / 1

NA

NA

7272

6028 / 11723

7108

8219

26493 / 18293

161823 / 88128

78 / 8 ms

5582 / 5538

16930 / 11029

69.32 sec

53.1 sec

239.4 / 120.2 fps

232.8 / 116.9 fps

Biostar

Tforce P965

Intel P965

LGA 775

P965

ICH8R

4,400

Awesome value

None in particular

71.68

20.30

41.18

10.20

1066 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

N / NA

N

3 / 1 / 1

N / x16

Realtek ALC888/8/Y

N / N

1 / G

N

4 / 1

N

6.04

Y / Y / Y

Y / Y / Y / Y / Y

1.1~1.5v

1.85~2.3v

2 / 1

NA

NA

7521

5820 / 11890

7194

8302

26873  / 18607

161199 / 87845

78 / 8 ms

5447 / 5465

16579 / 11128

70.5 sec

52.98 sec

237.1 / 122.2 fps

230.7 / 117.3 fps

MSI

P965 Neo

Intel P965

LGA 775

P965

ICH8R

5,400

Good value

Slightly slower

71.41

22.44

40.66

8.31

1066 MHz

DDR2 / 800 MHz

8 GB / 4

5 / 1

N / NA

N

3 / 2 / 0

N / x16

Realtek ALC888/8/Y

N/N

1 / G

N

4 / 1

N

6.54

Y / Y / Y

Y / Y / Y / Y / Y

+0.025 ~ 0.175v

1.9 ~ 2.2v

3 / 1

NA

NA

7268

5752 / 12432

6961

8264

26820 / 18636

156368 / 87890

78 / 8 ms

5323 / 5329

16756 / 9934

69.2 sec

53.7 sec

231.2 / 118.9 fps

232.6 / 118.2 fps

ASUS

P5B Premium Vista

Edition

Intel P965

LGA 775

P965

ICH8R

14,750

Very feature rich, fast

Expensive

76.53

31.95

41.54

3.04

1066 MHz

DDR2 / 1066 MHz

8 GB / 4

7 / 1

Y / 1

N

3 / 1 / 1

N / x16

ADI AD1988B/8/Y

Y / Y

2 / G

N

4 / 1

Y

7.00

Y / Y / Y

Y / Y / Y / Y / Y

1.1~1.6v

1.8~2.6v

6 / 1

NA

IR Remote unit, reciev-
er, Array mic, firewire
and USB brackets, LCD
screen

7526

6028 / 11827

7120

8390

26932 / 18722

162893 / 88532

78 / 8 ms

5573 / 5542

17013 / 11032

69.91 sec

52.53 sec

244.8 / 121.2 fps

235.2 / 117.6 fps

ASUS

P5B Deluxe WiFi-AP

Intel P965

LGA 775

P965

ICH8R

12,420

Features, performance

Slightly expensive

75.55

30.23

41.70

3.61

1066 MHz

DDR2 / 1066 MHz

8 GB / 4

7 / 1

Y / 1

N

3 / 1 / 1

N / x16

ADI 1988B/8/Y

Y / Y

2 / G

Y

4 / 1

N

7.00

Y / Y / Y

Y / Y / Y / Y / Y

1~1.6v

1.8~2.6v

6 / 1

NA

Cooling Fan (x2), Array

Mic

7599

6012 / 11825

7173

8592

26434 / 18552

162932 / 88932

78 / 8 ms

5583 / 5526

17120 / 11193

69.37 sec

52.37 sec

244.2 / 121.5 fps

235.2 / 117.4 fps

Brand

Model No.

Chipset

Socket

Northbridge

Southbridge

Price (Rs)

+

-

Grand Total (Out Of 100)

Features (Out Of 43/50*)

Performance (Out Of 45/37*)

Price (Out Of 12/13*)

Features

Front Side Bus Speed 

Memory Type / Max Freq. Supported

Memory Supported / No. Of slots

No. Of SATA / PATA Ports

E-SATA Support / No Of Ports

Integrated Graphics (Y / N)

No. Of PCI / PCI x1 / PCI x4 Slots

Multi GPU Support (SLI / CrossFire / N)

Audio Controller / Channels / HD Compliant (Y / N)

S / PDIF / Optical Port

No Of LAN Ports / Type (10/100 / Gigabit)

Integrated WiFi (Y / N)

No. Of Rear USB / FireWire Ports

All Solid State Capacitors (Y / N)

Component Layout (Scale Of 10)

Overclocking Options

CPU / FSB / Memory

Overvolting (CPU/Memory/FSB/PCIe/Northbridge)

CPU Voltage Range (Volts)

Memory Voltage Range (Volts)

Package Bundle

No Of SATA / PATA Cables

Software Bundle

Other Accessories

Performance

PC Mark 2005

CPU

Memory / Graphics

HDD

Overall

SiSoft Sandra 2007

CPU Arithmetic (Dhrystone / Whetstone)

CPU Multimedia (Integer / Floating)

Drive Index (MBps) / Random Access Time (ms)

Memory Bandwidth Score (Integer / Floating)

3D Mark 2005

3D Marks / CPU Score

Real World Tests

Video Encoding (DivX 6.2) 100 MB File

File Transfer - 4 GB File

Doom 3 (640x480 / 1600x1200, 4xAA, 4xAF)

Splinter Cell Chaos Theory (640x480 / 1600x1200)

ASUS

Commando

Intel P965

LGA 775

P965

ICH8R

15,870

Great overclocker

Expensive

75.21

30.49

41.90

2.83

1066 MHz

DDR2 / 1066 MHz

8 GB / 4

6 / 1

N / NA

N

4 / 1 / 1

N / x16

ADI 1988B/8/Y

Y / Y

2 / G

N

4 / 1

Y

7.21

Y / Y / Y

Y / Y / Y / Y / Y

1~1.9v

1.8~3.4v 

6 / 1

GRAW, 3D Mark 2006

Cooling Fan (x2),

Array Mic

7592

6182 / 12372

7103

8591

27422 / 18720

162921 / 88926

78 / 8 ms

5587 / 5582

17210 / 11161

68.94 sec

52.83 sec

245.2 / 122 fps

235.3 / 117.6 fps

NOVEMBER 2007

* Intel Integrated Graphics solutions
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Digital Tools l Processor and Motherboard Test

NOVEMBER 2007

MSI

P965 Platinum

Intel P965

LGA 775

P965

ICH8R

7,400

Good performer

No solid capacitors

75.78

28.51

41.20

6.06

1066 MHz

DDR2 / 800 MHz

8 GB / 4

6 / 1

N / NA

N

2 / 2 / 1

N / x16

Realtek ALC888/8/Y

Y / Y

1 / G

N

4 / 1

N

7.29

Y / Y / Y

Y / Y / Y / Y / Y

+0.025 ~ 0.175v

1.9 ~ 2.5v

4 / 1

NA

NA

7269

5687 / 12562

6882

8237

27025 / 18729

158392 / 87265

78 / 8 ms

5478 / 5489

16993 / 10800

69.1 sec

52.2 sec

238.2 / 120.6 fps

232.3 / 118.5 fps

Gigabyte

GA-G33M-S2H

Intel G33

LGA 775

G33

ICH9R

5,950

Good value for money

None in particular

64.09

25.85

33.78

4.46

1333 MHz

DDR2 / 800 MHz

8 GB / 4

3 / 1

Y / 1

Y, Intel GMA 3100

2 / 1 / 0

N / x16

Realtek ALC889A/8/Y

N / Y

1 / G

N

4 / 1

N

6.46

Y / Y / Y

Y / Y / Y / N / N

1.0~ 1.75v 

1.8~2.5v

2 / 1

NA

NA

7513

5724 / 11932

7120

8233

26928  / 18293

161478 / 87637

78 / 8 ms

5584 / 5562

16792 / 11326

71.1 sec

56.32 sec

237.3 / 122.5 fps

226.3  / 117.4 fps

MSI

G33M

Intel G33

LGA 775

G33

ICH9R

6,400

Good overclocking options

Slighty pricey

63.59

25.83

33.62

4.15

1333 MHz

DDR2 / 800 MHz

8 GB / 4

3 / 1

Y / 2

Y, Intel GMA 3100

2 / 1 / 0

N / x16

Realtek ALC888/8/Y

N / N

1 / G

N

6 / 1

N

6.58

Y / Y / N

Y / Y / Y / N / Y

1.275 ~ 2.0625v

1.8 ~ 3.3v

1 / 1

NA

NA

7414

5562 / 11844

7122

8101

26126 / 18627

169191 / 87267

78 / 8 ms

5456 / 5425

16363 / 11389

70.92 sec

55.43 sec

235.3 / 120.1 fps

228.2 / 116.5 fps

ECS

P33T-A

Intel G31

LGA 775

G31

ICH7

3,600

Extremely affordable

Low on features

57.95

17.48

33.10

7.38

1333 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

N / NA

Y, Intel GMA 3100

3 / 2 / 0

N / x16

Realtek ALC885/6/Y

N / N

1 / G

N

4 / 1

N

6.25

Y / Y / N

N / N / N / N / N

NA

NA

2 / 1

NA

NA

7272

5252 / 11324

7012

7681

26232 / 17912

166292 / 86128

78 / 8 ms

5235 / 5212

16218 / 11292

70.23 sec

55.63 sec

225.2 / 119.2 fps

231.2 / 115.5 fps

MSI

G965MDH

Intel G965

LGA 775

G965

ICH8R

6,300

Decent performer

Older solution

63.12

25.23

33.68

4.21

1066 MHz

DDR2 / 800 MHz

8 GB / 4

6 / 1

N / NA

Y, Intel GMA 3000

2 / 1 / 0

N / x16

Realtek ALC888/8/Y

N / N

1 / G

N

4 / 1

N

7.13

Y / Y / Y

Y / Y / Y / N / Y

+0.025 ~ 0.175v

1.9 ~ 2.1v

3 / 1

NA

NA

7463

5707 / 12539

6987

8335

27019 / 18604

161140 / 87192

78 / 8 ms

5113 / 5059

16789 / 10318

70.1 sec

53.2 sec

231.5 / 118.1 fps

233.4 / 118.1 fps

Abit

Fatal1ty F-190HD

ATI 690G

LGA 775

Radeon x1250

SB600

7,500

Well laid out

Expensive solution

60.33

23.85

32.94

3.54

1066 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

N / NA

Y, Radeon x1250

1 / 1 / 0

N / x16

Realtek ALC888/8/Y

N / Y

1 / G

N

4 / 1

N

5.67

Y / Y / Y

Y / Y / Y / Y / Y

1.325~1.5V

1.8~2.5V

3 / 1

NA

HDMI Connect (HDMI as

DVI supported)

7102

6001 / 11729

7102

8029

27019 / 18579

161053 / 87715

69 / 8 ms

5061  / 5077

16527 / 9528

70.4 sec

55.29 sec

229.6 / 116.5 fps

230.2 / 116.4 fps

Gigabyte

GA-G33-DS3R

Intel G33

LGA 775

G33

ICH9R

9,500

Very good layout

Expensive

68.78

32.15

33.84

2.80

1333 MHz

DDR2 / 800 MHz

8 GB / 4

6 / 1

Y (Bracket) / 2

Y, Intel GMA 3100

3 / 2 / 0

N / x16

Realtek ALC889A/8/Y

Y / Y

1 / G

N

4 / 1

Y

6.75

Y / Y / Y

Y / Y / Y / Y / Y

0.5 ~ 3.25v

1.8~3.3v

3 / 1

NA

NA

7534

5861 / 11908

7162

8280

27029 / 18623

161543 / 87958

78 / 8 ms

5595 / 5555

16782 / 11245

70.3 sec

56.36 sec

234.2 / 121.7 fps

229.4 / 117.2 fps

Intel Integrated Graphics solutionsNOVEMBER 2007 NOVEMBER 2007



Scoreboard
Gigabyte

GA-MA69G-S3H

ATI 690G

AM2

Radeon x1250

SB600

6,900

Well built, feature rich

None in particular

63.39

28.75

30.79

3.85

1600 / 2000 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

Y (Bracket) / 1

Y, Radeon x1250

2 / 3 / 1

N / x16

Realtek ALC888 / 8 / Y

N / Y

1 / G

N

4 / 1

N

6.75

Y / Y / Y

Y / Y / Y / Y / Y

0.75~1.6v

1.8~2.4v

4 / 1

NA

DVI To HDMI Connector

7522

7828 / 11061

6923

7505

23279 / 19587

60419 / 66410

74 / 8 ms

8150 / 8102

16339 / 7600

82.55 sec

53.62 sec

189.1 / 117.8 fps

182.4 / 103.2 fps

MSI K9AGM2 (690G)

ATI 690G

AM2

Radeon x1250

SB600

4,000

Superb value for money

Only 2 DIMM's

55.50

17.55

31.31

6.64

1600 / 2000 MHz

DDR2 / 800 MHz

4 GB / 2

4 / 1

N / NA

Y, Radeon x1250

2 / 1 / 0

N / x16

Realtek ALC888 / 8 / Y

N / N

1 / G

N

4 / 1

N

6.83

N / N / N

N / N / N / N / N

NA

NA

2 / 1

NA

NA

7624

7507 / 11777

6855

7624

23184 / 19480

60127 / 66137

78 / 8 ms

8040 / 8005

16653 / 8357

82.25 sec

52.74 sec

199.6 / 117.5 fps

183.6 / 103.4 fps

NOVEMBER 2007

ASUS

M2A-VM HDMI

ATI 690G

AM2

Radeon x1250

SB600

5,225

Good value

None in particular

58.77

23.38

30.31

5.08

1600 / 2000 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

N / NA

Y, Radeon x1250

2 / 1 / 0

N / x16

Realtek ALC883 / 6 / Y

N / N

1 / G

N

4 / 1

N

6.63

Y / Y / Y

Y / Y / Y / Y / Y

0.8~1.55V

1.8~2.1V

2 / 1

NA

NA

6525

7723 / 11621

6832

7603

22727 / 19192

59274 / 64829

72 / 8 ms

7992 / 7983

16562 / 7524

82.26 sec

56.56 sec

188.2 / 117.3 fps

181.2 / 100.3 fps

Brand

Model No.

Chipset

Socket

Northbridge

Southbridge

Price (Rs)

+

-

Grand Total (Out Of 100)

Features (Out Of 50)

Performance (Out Of 37)

Price (Out Of 13)

Features

Front Side Bus Speed 

Memory Type / Max Freq. Supported

Memory Supported / No. Of slots

No. Of SATA / PATA Ports

E-SATA Support / No. Of Ports

Integrated Graphics (Y / N)

No. Of PCI / PCI x1 / PCI x4 Slots

Multi GPU Support (SLI / CrossFire / N)

Audio Controller / Channels / HD Compliant (Y / N)

S/PDIF / Optical Port

No Of LAN Ports / Type (10/100 / Gigabit)

Integrated WiFi (Y / N)

No. Of Rear USB / FireWire Ports

All Solid State Capacitors (Y / N)

Component Layout (Scale Of 10)

Overclocking Options

CPU / FSB / Memory

Overvolting (CPU/Memory/FSB/PCIe /Northbridge)

CPU Voltage Range (Volts)

Memory Voltage Range (Volts)

Package Bundle

No Of SATA / PATA Cables

Software Bundle

Other Accessories

Performance

PC Mark 2005

CPU

Memory / Graphics

HDD

Overall

SiSoft Sandra 2007

CPU Arithmetic (Dhrystone / Whetstone)

CPU Multimedia (Integer / Floating)

Drive Index (MBps) / Random Access Time (ms)

Memory Bandwidth Score (Integer / Floating)

3D Mark 2005

3D Marks / CPU Score

Real World Tests

Video Encoding (DivX 6.2) 100 MB File

File Transfer - 4 GB File

Doom 3 (640x480 / 1600x1200, 4xAA, 4xAF)

Splinter Cell Chaos Theory (640x480 / 1600x1200)

ASUS

M2A-VM

ATI 690V

AM2

Radeon x1250

SB600

3,765

Great Value

None in particular

60.79

23.38

30.36

7.05

1600 / 2000 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

N / NA

Y, Radeon x1250

2 / 1 / 0

N / x16

Realtek ALC883 / 6 / Y

N / N

1 / G

N

4 / 1

N

6.63

Y / Y / Y

Y / Y / Y / Y / Y

0.8~1.55V

1.8~2.1V

2 / 1

NA

NA

6541

7723 / 11554

6908

7657

22746 / 19100

59152 / 64886

72 / 8 ms

8121 / 8072

16455 / 7504

82.73 sec

56.34 sec

189.6 / 117.3 fps

181 / 101.5 fps
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MSI

K9AGM2 (690V)

ATI 690G

AM2

Radeon x1250

SB600

3,100

Very good deal

Only 2 DIMM's

57.21

17.55

31.09

8.57

1600 / 2000 MHz

DDR2 / 800 MHz

4 GB / 2

4 / 1

N / NA

Y, Radeon x1250

2 / 1 / 0

N / x16

Realtek ALC888 / 8 / Y

N / N

1 / G

N

4 / 1

N

6.83

N / N / N

N / N / N / N / N

NA

NA

2 / 1

NA

NA

7621

7575 / 11541

6914

7500

23120 / 19572

60129 / 66162

78 / 8 ms

8025 / 7980

16235 / 8271

82.32 sec

52.3 sec

192.2 . 117.3 fps

181.9 / 102.7 fps

Jetway

JM2A692-GDG

ATI 690G

AM2

Radeon x1250

SB600

3,950

Well priced

Less expansion options

58.77

21.38

30.68

6.72

1600 / 2000 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

N / NA

Y, Radeon x1250

2 / 0 / 0

N / x16

Realtek ALC861 / 8 / Y

N / N

1 / G

N

4 / 1

N

6.96

Y / Y / Y

Y / Y / N / N / N

1.4~2.0v

1.75~2.55v

2 / 1

NA

NA

6571

7849 / 11624

6903

7635

23346 / 19724

60602 / 66676

78 / 8 ms

7562 / 7524

16482 / 7974

82.28 sec

55.04 sec

192.2 / 117.6 fps

181.2 / 101.3 fps

Abit AN-M2HD

NVIDIA 7050PV

AM2

GeForce 7050PV

nForce 630a

5,300

Good performer

Slightly costly

60.31

24.39

30.91

5.01

1600 / 2000 MHz
DDR2 / 800 MHz

8 GB / 4

4 / 1

N / NA

Y, GeForce 7050PV

2 / 1 / 0

N / x16

Realtek ALC861 / 8 / Y

N / Y

1 / G

N

4 / 1

N

6.71

Y / Y / Y

Y / Y / N / N / N

1.4~2.0v

1.75~2.55v

2 / 1

NA

DVI to HDMI converter,

extension cable

6529

7892 / 11898

7041

7820

23171 / 19477

60158 / 66137

78 / 8 ms

7762 / 7692

16317 / 7435

82.25 sec

54.85 sec

193.2 / 117.2 fps

193.4 / 108.5 fps

Galaxy AN68M

NVIDIA 7025

AM2

GeForce 7025

nForce 630a

3,300

Good value for money

Only 2 DIMM's

58.93

20.44

30.45

8.05

1600 / 2000 MHz

DDR2 / 800 MHz

4 GB / 2

4 / 1

N / NA

Y, GeForce 7025

2 / 1 / 0

N / x16

Realtek ALC861 / 8 / Y

N / N

1 / G

N

6 / 1

N

6.58

Y / Y / Y

Y / Y / N / N / N

1.4~2.0v

1.75~2.55v

2 / 1

NA

NA

6334

7232 / 11216

7020

7023

23102 / 19248

60824  / 66032

78 / 8 ms

7663 / 7529

16389 / 7837

82.12 sec

54.24 sec

195.3 / 118.2 fps

191.2 / 101.4 fps

Jetway M28GT3-SDG

NVIDIA 7025

AM2

GeForce 7025

nForce 630a

3,950

Decent overclocking options

Overpriced

57.41

20.34

30.35

6.72

1600 / 2000 MHz

DDR2 / 800 MHz

8GB / 4

4 / 1

N / NA

Y, GeForce 7025

2 / 0 / 0

N / x16

Realtek ALC861 / 8 / Y

N / N

1 / G

N

4 / 1

N

6.58

Y / Y / Y

Y / Y / N / N / N

1.4~2.0v

1.75~2.55v

1 / 1

NA

NA

6524

7712 / 11237

7122

7182

22992 / 19192

60193 / 66272

78 / 8 ms

7632 / 7532

16243 / 7332

82.34 sec

54.37 sec

191.1 / 116.2 fps

188.3 / 100.2 fps

Zebronics ZEB-N61M2

NVIDIA 6100

AM2

GeForce 6100

nForce 410

2,150

Good value for money

Older solution

62.32

19.55

30.42

12.35

1600 / 2000 MHz

DDR2 / 800 MHz

4 GB / 2

2 / 1

N / NA

Y, GeForce 6100

2 / 0 / 0

N / x16

Realtek ALC861 / 8 / Y

N / N

1 / G

N

4 / 1

N

6.08

Y / Y / Y

Y / Y / Y / Y / Y

+0.025~0.375v

+0.05 ~ 0.35v

1 / 1

NA

NA

6579

6583 / 11254

7028

7694

23310 / 19715

60507 / 66577

72 / 8 ms

7412 / 7362

16618 / 8116

83.21 sec

55.23 sec

194.1 / 118.5 fps

181.3 / 99.2 fps

ECS AMD690GM-M2

ATI 690G

AM2

Radeon x1250

SB600

3,100

Well priced

Only 2 DIMM's

58.45

19.38

30.51

8.57

1600 / 2000 MHz

DDR2 / 800 MHz

4 GB / 2

4 / 1

N / NA

Y, Radeon x1250

2 / 1 / 0

N / x16

Realtek ALC861 / 8 / Y

N / N

1 / G

N

4 / 1

N

5.38

Y / Y / Y

Y / Y / Y / N / N

+0.0125 ~ 0.05v

+0.05v ~ 0.15v

2 / 1

NA

NA

6539

6373 / 11634

6890

7592

23243 / 19616

60319 / 66350

78 / 8 ms

7427 / 7420

16573 / 7601

82.35 sec

52.4 sec

189.2 / 117.2 fps

182.2 / 103.1 fps



Digital Tools l Processor and Motherboard Test

Scoreboard
ASUS

Blitz Extreme

Intel P35

LGA 775

P35

ICH9R

19,550

Very fast

DDR3 is costly

73.98

34.65

37.04

2.28

1333 MHz

DDR3 / 1333 MHz

8 GB / 4

6 / 1

N / NA

N

2 / 3 / 0

CF / x16 / x4

ADI AD1988B / 8 / Y

Y / Y

2 / G+G

N

6 / 1

Y

6.50

Y / Y / Y

Y / Y / Y / Y / Y

1.00~1.9v

1.5~3.0v

6 / 1

3D Mark 2006 +

S.T.A.L.K.E.R game

Liquid cooling kit

pipes and connects,

LCD Poster

7523

5957 / 12647

7198

8462

27100 / 18796

161927 / 88168

78 / 8 ms

5666 / 5681

16985 / 11368

71.1 sec

52.12 sec

244.9 / 122.4 fps

232.4 / 117.3 fps

ASUS

P5K Premium

Intel P35

LGA 775

P35

ICH9R

15,870

Feature Rich

Expensive

74.73

34.55

37.36

2.81

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

6 / 1

Y / 2

N

3 / 2 / 1

CF / x16 / x4

ADI AD1988B / 8 / Y

Y / Y

2 / G+G

Y

6 / 1

Y

6.50

Y / Y / Y

Y / Y / Y / Y / Y

1.2~1.7v

1.8~2.5v

6 / 1

NA

Cooling Fan (x2)

7637

5995 / 12719

7171

8582

27010 / 18806

162082 / 88161

78 / 8 ms

5676 / 5692

17036 / 10936

68.21 sec

50.98 sec

247.2 / 129.8 fps

236.2 / 117.9 fps

ASUS

P5K Deluxe WiFi-AP

Intel P35

LGA 775

P35

ICH9R

14,750

Feature Rich

Expensive

74.32

34.50

36.80

3.03

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

6 / 1

Y / 2

N

3 / 2 / 1

CF / x16 / x4

ADI AD1988B / 8 / Y

Y / Y

2 / G+G

Y

6 / 1

Y

6.50

Y / Y / Y

Y / Y / Y / Y / Y

1.2~1.7v

1.8~2.5v

6 / 1

NA

Cooling Fan (x2)

7546

5901 / 12525

7172

8472

27109 / 18825

163204 / 88351

78 / 8 ms

5683 / 5667

17035 / 10818

71.2 sec

51.93 sec

243.5 / 121.5

227.2 / 115 fps
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Abit

IP-35 Pro Off Limits

Intel P35

LGA 775

P35

ICH9R

13,500

Great for enthusiasts

Expensive

71.62

31.48

36.84

3.31

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

6 / 1

Y / 2

N

3 / 1 / 1

CF / x16 / x4

Realtek ALC888/8/Y

N / Y (in & out)

2 / G+10 / 100

N

4 / 1 (on addon card)

Y

6.58

Y / Y / Y

Y / Y / Y / Y / Y

1.3250 ~ 1.8950v

1.800 ~ 3.000v

6 / 1

NA

FireWire and USB

bracket

7612

5824 / 12673

7316

8485

27670 / 19183

164838 / 89455

79 / 8 ms

5710 / 5731

17105 / 10725

68.53 sec

56.37 sec 

236.7 / 121.6 fps

234.4 / 118.1 fps

ASUS

P5K3 Deluxe WiFi-AP

Intel P35

LGA 775

P35

ICH9R

17,100

Well laid out, feature rich

Expensive

74.64

35.05

36.98

2.61

1333 MHz

DDR3 / 1333 MHz

8 GB / 4

6 / 1

Y / 2

N

3 / 2 / 0

CF / x16 / x4

ADI AD1988B / 8 / Y

Y / Y

2 / G+G

Y

6 / 1

Y

6.50

Y / Y / Y

Y / Y / Y / Y / Y

1.2~1.7v

1.3~2.3v

6 / 1

NA

Cooling Fan (x2)

7410

6000 / 12103

7101

8460

27157 / 18679

162020 / 88290

79 / 8 ms

5739 / 5982

17030 / 11572

70.24 sec

51.24 sec

243.6 / 120.1 fps

232.1 / 116.3 fps

Brand

Model No.

Chipset

Socket

Northbridge

Southbridge

Price (Rs)

+

-

Grand Total (Out Of 100)

Features (Out Of 50)

Performance (Out Of 40)

Price (Out Of 10)

Features

Front Side Bus Speed 

Memory Type / Max Freq. Supported

Memory Supported / No. Of slots

No. Of SATA / PATA Ports

E-SATA Support / No. Of Ports

Integrated Graphics (Y / N)

No. Of PCI / PCI x1 / PCI x4 Slots

Multi GPU Support (SLI / CrossFire / N)

Audio Controller / Channels / HD Compliant (Y / N)

S/PDIF / Optical Port

No Of LAN Ports / Type (10/100 / Gigabit)

Integrated WiFi (Y / N)

No. Of Rear USB / FireWire Ports

All Solid State Capacitors (Y / N)

Component Layout (Scale Of 10)

Overclocking Options

CPU / FSB / Memory

Overvolting (CPU/Memory/FSB/PCIe/Northbridge)

CPU Voltage Range (Volts)

Memory Voltage Range (Volts)

Package Bundle

No Of SATA / PATA Cables

Software Bundle

Other Accessories

Performance

PC Mark 2005:

CPU

Memory / Graphics

HDD

Overall

SiSoft Sandra 2007:

CPU Arithmetic (Dhrystone / Whetstone)

CPU Multimedia (Integer / Floating)

Drive Index (MBps) / Random Access Time (ms)

Memory Bandwidth Score (Integer / Floating)

3D Mark 2005:

3D Marks / CPU Score

Real World Tests

Video Encoding (DivX 6.2) 100 MB File

File Transfer - 4 GB File

Doom 3 (640x480 / 1600x1200, 4xAA, 4xAF)

Splinter Cell Chaos Theory (640x480 / 1600x1200)

Abit

IP-35 E Off Limits

Intel P35

LGA 775

P35

ICH9R

8,500

Decent value overclocker

No solid capacitors

65.31

23.63

36.43

5.25

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

4 / 1

N / 0

N

3 / 2 / 0

N / x16

Realtek ALC888/8/Y

N/Y

1 / G

N

4 / N

N

6.13

Y / Y / Y

Y / Y / Y / Y / Y

1.3250 ~ 1.8950v

1.800 ~ 3.000v

3 / 1

NA

NA

7261

5829 / 12582

7318

8389

27930  / 19128

162102 / 88192

78 / 8 ms

5682 / 5638

17292 / 10812

69.2 sec

58.2 sec

233.2 / 119.2 fps

229.2 / 116.8 fps

Intel P35 Chipset Based
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ASUS

BLITZ Formula

Intel P35

LGA 775

P35

ICH9R

17,250

Overclockers delight

Very expensive

74.24

34.65

37.00

2.59

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

6 / 1

N / NA

N

2 / 3 / 1

CF / x16 / x4

ADI AD1988B / 8 / Y

Y / Y

2 / G+G

N

6 / 1

Y

6.50

Y / Y / Y

Y / Y / Y / Y / Y

1.00~1.9v

1.8~3.4v

6 / 1

3D Mark 2006 +

S.T.A.L.K.E.R game

Liquid cooling kit

pipes and connects,

LCD Poster

7536

6008 / 11918

7158

8417

27071 / 18772

162632 / 88103

79 / 8 ms

5682 / 5693

16959 / 11085

70.5 sec

50.46 sec

243.1 / 122.3 fps

234.4 / 117.3 fps

ECS

P 35T-A

Intel P35

LGA 775

P35

ICH9R

5,475

Well priced

Low on features

69.51

24.75

36.60

8.16

1333 MHz

DDR2 / 800 MHz

8 GB / 4

6 / 1

Y / 1

N

3 / 1 / 1

N / x16

Realtek ALC888 /8/Y

N / N

1 / G

N

6 / 1

N

6.46

Y / Y / Y

Y / Y / Y / Y / Y

1.1~1.6v

1.85~2.4v

1 / 1

NA

NA

7508

5843 / 12515

7171

8518

27156 / 18566

161350 / 87312

78 / 8 ms

5419 / 5372

17017 / 10242

69.3 sec

54.25 sec

245.7 / 123.8 fps

229.9 / 118.1 fps

Gigabyte

GA-P35 - DS3R

Intel P35

LGA 775

P35

ICH9R

12,000

Good high-end option

Expensive

74.56

33.70

37.14

3.72

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

8 / 1

Y (bracket) / 1

N

3 / 3 / 0

N / x16

Realtek ALC889 /8/Y

Y / Y

1 / G

N

4 / 1

Y

6.75

Y / Y / Y

Y / Y / Y / Y / Y

0.5~ 3.25v

1.8~3.3v

6 / 1

NA

E-SATA Power Cables

7522

5905 / 12520

7170

8412

27159 / 18843

162646 / 87868

78 / 8 ms

5753 / 5736

17078 / 11281

69.3 sec

53.64 sec

249 / 123.7 fps

240 / 118 fps

Gigabyte

GA-P35 - DQ6

Intel P35

LGA 775

P35

ICH9R

15,500

Status symbol

Bulky heatpipe solution

73.04

33.63

36.53

2.88

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

8 / 1

Y (bracket) / 1

N

2 / 2 / 1

CF / x16 / x4

Realtek ALC889A/8/Y

Y / Y

1 / G

N

4 / 1

Y

6.63

Y / Y / Y 

Y / Y / Y / Y / Y

1.8~3.3v

1.8~3.3v

6 / 1

NA

E-SATA Power Cables

7528

5933 / 11900

7153

8358

27035 / 18542

161287 / 87638

78 / 8 ms

5682 / 5673

16932 / 11187

70.84 sec

56.32 sec

240.7 / 122.8 fps

233.2 / 117.3 fps

MSI

P35-Neo

Intel P35

LGA 775

P35

ICH9R

6,600

Affordable P35 platform

Doesn’t overclock well

67.03

23.76

36.50

6.77

1333 MHz

DDR2 / 1066 MHz

8 GB / 4

4 / 1

N / NA

N

2 / 3 / 0

N / x16

Realtek ALC888 / 8 / Y

N / N

1 / G

N

4 / 1

N

7.00

Y / Y / Y

Y / Y / Y / Y / Y

1.525~2.3125

1.8~3.3

1 / 1

NA

NA

7512

5762 / 12473

7160

8458

27149 / 18796

161937 / 87253

78 / 8 ms

5285 / 5292

16965 / 11044

70.2 sec

55.25 sec

237.5 / 122.3 fps

228.6 / 117.3 fps

MSI

P35-Diamond

Intel P35

LGA 775

P35

ICH9R

14,500

Loads of features

Expensive

70.80

30.86

36.86

3.08

1333 MHz

DDR3 / 1066 MHz

8 GB / 4

5 / 1

Y / 2

N

2 / 2 / 1

CF / x16 / x4

Realtek ALC888T/8/Y

N / Y

1 / G

N

6 / 1

Y

6.75

Y / Y / Y

Y / Y / Y / Y / Y

1.525~2.3125

1.8~3.3

3 / 1

NA

56.6 Fax Modem, USB

& FireWire Brackets

7093

5868 / 12974

7200

8238

25804 / 18712

150760 / 87737

78 / 8 ms

5537 / 5539

17313 / 10785

67.48 sec

52.82 sec

239.9 / 128.9 fps

232.1 / 123.2 fps

MSI

P35-Platinum

Intel P35

LGA 775

P35

ICH9R

10,200

Good performer

None in particular

71.30

30.26

36.66

4.38

1333 MHz

DDR2 / 800 MHz

8 GB / 4

5 / 1

Y / 2

N

2 / 2 / 1

CF / x16 / x4

Realtek ALC888/8/Y

N / Y

1 / G

N

6 / 1

Y

6.75

Y / Y / Y

Y / Y / Y / Y / Y

1.525~2.3125

1.8~3.3

3 / 1

NA

USB & FireWire

Brackets

7012

5728 / 12823

7152

8199

25263 / 18383

151283 / 87923

78 / 8 ms

5427 / 5425

17342 / 10562

67.22 sec

52.25 sec

237.2 / 126.2 fps

234.2 / 123.4 fps

Biostar

TP35D2-A7

Intel P35

LGA 775

P35

ICH9R

4,700

Extreme value

Low on features

69.48

23.48

36.50

9.50

1333 MHz

DDR2 / 800 MHz

8 GB / 4

4 / 1

N / NA

N

3 / 1 / 1

N / x16

Realtek ALC888/8/Y

N / N

1 / G

N

6 / 1

N

7.04

Y / Y / Y

Y / Y / Y / Y / Y

upto + 0.787

2 ~ 2.6v

2 / 1

NA

NA

7521

5820 / 11890

7194

8302

26873 / 18607

161199 / 87845

78 / 8 ms

5447 / 5465

16579 / 11128

70.5 sec

52.98 sec

237.1 / 122.2

230.7 / 117.3 fps
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Verdict
When we think Gold, we think outstanding prod-
uct. Going by this principle, it’d be easy to see why
ASUS’ P5B Premium Vista Edition gets top hon-
ours. At Rs 14,750, it’s not for everyone,
though. That’s where our Silver
winner comes in. At Rs
7400—the MSI
P965 Platinum
offers good
features and
build quality,
and enough over-
clocking features to
justify the price tag.

We don’t really recom-
mend spending on a P965
board unless you must have the show-off fea-
tures that the P5B Premium Vista Edition
sports. Although this is an excellent chipset, it
has been replaced in Intel’s product line-up by
the P35—a product that, while not markedly
better, is definitely more future-proof.

INTEGRATED GRAPHICS
PLATFORMS
This category will be important for most—who
needs a graphics card when you don’t intend on
gaming or doing a lot of HD movie-watching,
right? We see boards for both Intel and AMD
processors here. The players in this arena are
more interested in the volume game, and such
boards tend to be focused towards value for
money rather than features, performance and
overclocking—with a few exceptions, of course.

We’ve got boards based on Intel’s latest G33
and G31 platforms, the older G965 platform
and ATI’s proven 690G. Newcomers were
NVIDIA’s GeForce 7050 and 7025—two very
interesting platforms—and, of course, the older
GeForce 6100 platform.

INTEL-BASED
Features
Gigabyte’s GA-G33-DS3R is a very well-built and
attractive looking board. Even better, we liked
the compact (Micro ATX) design on the GA-
G33M-S2H. This board also has an HDMI port.
Gigabyte has also included Realtek’s latest
ALC889A codec-based sound solution—the suc-
cessor the de facto ALC888 codec. It’s easy to see
the former being pitched as a high-end product
with integrated graphics, while the latter—with
its reduced BIOS options—gives lesser expand-
ability and smaller size being a home-entertain-
ment product (hence the HDMI).

ECS’ P33T-A board was an anomaly. While all
the G33 and G31 boards are mated to the ICH9
Southbridge, this motherboard had an older
ICH7 Southbridge—the same one on the much
older 975X platform—a very negative move.

Abit’s Fatal1ty F-190HD is another HDMI port-
sporting board based around (surprise, surprise)
ATI’s 690G platform—which is basically a combi-
nation of Radeon x1250 graphics and an SB600
Southbridge. We figure this board is part of an
endangered species—what with ATI having been
taken over by AMD—which is a pity, simply
because choice breeds competition, and Intel
and NVIDIA have run out of the latter as far as
platforms for Intel processors go. This board,
despite bearing the “Fatal1ty” moniker, fails to
impress as a hardcore enthusiast product. 

Performance
To be honest, there’s very little variety in the
performance of the Intel-based mother-
boards—with the exception of the ECS P33T-A,
though to be honest, with a Southbridge that
is two generations old we expected this board
to lag behind—particularly in the storage
based tests. Surprisingly, it lagged in the
graphics and gaming tests!

Both the Gigabyte boards do prove their
mettle here, and both the MSI boards keep
them close company.

Verdict
If you want an Intel-based solution, consider the
duo from Gigabyte—the GA-G33-DS3R, (Rs 9,500)
if you want something fast and feature rich and
the GA-G33M-S2H, (Rs 5,950) if you’re looking for
unbeatable value and HDMI thrown into the
kitty. Both these boards are very different beasts
despite being from the same stable—the former
is an enthusiast solution with greater overclock-
ability, solid state capacitors and an ATX form
factor and the latter is more for the cinema buff.
These two steal our Gold and Silver awards—the
GA-G33-DS3R placing first and its cheaper sibling
placing second.

AMD-BASED
Features
ASUS had two offerings—M2A-VM and M2A-VM
HDMI. These are basically the same board with
one difference—the presence of an HDMI port.
Abit’s AN-M2HD was a nice offering—micro ATX,
a full 4 memory banks, HDMI, and a display solu-
tion that supports NVIDIA PureVideo.

Zebronics’ ZEB-N61M2 was the old timer in
this category—the GeForce 6100 is an older
Northbridge, and the nForce 410 Southbridge has
been around for some time as well.

Performance
The MSI K9AGM2 (690G) performs quite
superbly, taking our X2 6400+ within striking
distance of the newer X6800 (although a slight
clock advantage is retained by the AMD part).
In fact, one look at our CPU scores—especially
under PC Mark 2005—will testify to the
Gigabyte and MSI boards simply blowing away
the other 690G based boards.

Gigabyte GA-G33-DS3R
The best Intel onboard-
graphics platform

NOVEMBER 2007
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E-mailCompany Web SiteBrand

Contact Sheet Motherboards

Abit
ASUS
Biostar
ECS
Galaxy
Gigabyte
Jetway

MSI
XFX
Zebronics

Tirupati Enterprises 
ASUS Technology Pvt. Ltd. 
Abacus Peripherals Pvt. Ltd. 
SES Technologies Limited
Technology And Gadgets
Gigabyte Technology India Ltd 
Jetway Information Co. Ltd /
Rashi Peripherals Pvt Ltd
Micro-Star International
Rashi Peripherals Pvt Ltd
(Zebronics) TopNotch Infotronix

abhishek@tirupati.net 
media_india@asus.com
ajain@abacusperipherals.com 
poonam.sharma@sesindia.com
sales@technologyandgadgets.com
sales@gigabyte.in 
amitp@rptechindia.com 

sanyam@msi-india.com 
amitp@rptechindia.com 
enquiry@zebronics.info 

www.tirupati.net 
http://in.asus.com
www.abacusperipherals.com 
www.sesindia.com 
www.technologyandgadgets.com
www.gigabyte.com.tw 
www.jetway.com.tw/jetway/
www.rptechindia.com / 
www.msi-india.com
www.rptechindia.com 
www.zebronics.net 



Although NVIDIA’s 7050 / 7025-based boards trail
behind, we won’t be too critical—simply because these
chipsets are really new, and we newer drivers should opti-
mise things for better performance. The Abit AN-M2HD
and the Galaxy AN68M boards were the only ones to cross
the 190 fps mark.

Verdict
With everyone jumping on the Core 2 Duo bandwagon, it
seems AMD is left out in the cold for now. However, we’ve
seen a few solid platforms for AMD processors, and these do
make viable solutions for those looking for a powerful mul-
timedia or Home Entertainment PC. If you’re looking for
value, it’s hard to ignore the Galaxy AN68M. A spanking
new chipset that promises a lot, decent layout and expand-
ability, HDMI connectivity (for home-cinema buffs)—all this
at an unbelievable price of Rs 3,300! If you want something
with a little more punch, we recommend the MSI K9AGM2
(690G)—priced a little higher at Rs 4,000. It’s got support for
8 GB of memory on 4 DIMM’s, and HDMI.

Gigabyte’s GA GA-MA69G-S3H is our
Gold winner for AMD’s processors—a great
combination of features and performance.
The Zebronics ZEB-N61M2 steals silver main-
ly because of its unbeatable pric-
ing—Rs 2,150.

In Retrospect
Going by the steady increase in the number of players (and
the number of products), our markets are teeming with
options for various kinds of solutions. The enthusiast
options—motherboards that come with everything—at
a price.

Then there are those products aimed at prosumers—
who are less discerning than enthusiasts. Home Cinema
buffs will also find something from among our plethora
of options.

Just when you think, “Hey—couldn’t get much better,
right?” something new comes out! Intel’s new Penryn
processors are about to enter the consumer space—and a
whole new platform (Intel’s X38) with support for an FSB
speed of 1600 MHz among a host of other goodies!

NVIDIA has promised a successor to their 680i chipset,
we don’t even know whether it’ll be called the 780i or
something else, but we’re as excited as the next guy!
We’ve already seen the still shiny P35 become a reliable,
powerful platform.

Then there’s the AgenaFX / Agena from AMD—the desk-
top spin off from their workstation processor Barcelona.
New processor equals new platform. So much for 2008! 

2009 should see the advent of native six- and eight-core
processors in the form of AMD’s Sandtiger and Intel’s
Nehalem—both of which should make today’s quad-cores
look prehistoric. 

sanket_naik@thinkdigit.com

michael_browne@thinkdigit.com

NOVEMBER 2007

Gigabyte GA-MA69G-S3H
The best 690G chipset-
based board
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We got tired of looking at different sites each day, so we brought all of them together

Mash ’em up
Bhaskar Sarma

Mash-ups seem to be the latest fad
in the crazy world of Web 2.0—
people don’t want to go all over

the Internet for their daily stuff; they
want it in one place. Mash-ups are also
increasingly used by businesses to
manage data and information on their
sites. If you thought a mash-up needed a
large team to develop and maintain, you
couldn’t be farther from the truth. With
a little patience and a clear head, you can
build a mash-up in a jiffy. 

You’ll need a Web site of your own.
You could also create a mash-up on your
iGoogle page or use a site like Netvibes
(www.netvibes.com). IBM has a QEDWiki
for primarily business users, while
Microsoft’s Popfly lets you build a stun-
ning mash-up on its SilverLight plat-
form. We’ll go with a Blogger page
(www.blogger.com)—most people have a
blog of their own now, and Blogger’s
new Customize feature has layout ele-
ments for a wide variety of sources like
HTML / JavaScript, RSS feeds, pictures,
videos and more. No more editing
HTML—just drag and drop!

Getting Started
We start with a blank Blogger page (you
should be logged in to Blogger). Choose
a template with a wide sidebar—you
don’t want your apps to spill over the
boundary of the page. The Customize
link at the top right will take you to the
Edit Layout page—click on Add a Page
Element and you’ll get a pop-up with
options to add polls, pictures,
HTML/JavaScript, feeds, logos, a video
bar, and more. You can edit the HTML
of the page —or do it the easier way.

Choose from Google Gadgets
(www.google.com/ig/directory?synd=open)—
they have an astonishing variety of
gadgets tailored for almost everything.
Inserting them into your page is simple
enough—copy a line of HTML and paste
it in Blogger’s element holder for HTML
/ JavaScript. Many of these Gadgets—
especially those with eye candy—need
Flash to work; install the free Flash
player from www.adobe.com/products/
flashplayer/ if you don’t have it.

The First Gadget
Adding social networking sites—espe-
cially Facebook and Orkut—to your blog
is now a breeze. If you’re a Facebook
junkie, this is for you—a search on the
directory will bring up Facebook apps

that let you check your account from
within your Blogger page. Select the
gadget and click on Add to your web-
page. You’ll get a snapshot of your
gadget, with some minor settings like
size adjustments and colour schemes.
Play around with them till you’re satis-
fied. Other settings are specific to the
gadget—in this case, you have options for
what to keep in your Facebook gadget.

Once you’ve made your choice, click on
Get the Code at the bottom. A line of
HTML code appears, which you copy and
paste into the HTML / JavaScript element
holder. Simple.

More Gadgets
After putting in the first
gadget, you should be
raring to go. For the rest,
here are our recommen-
dations:
Orkut: Access to Orkut
is quite easy from
your page, espe-
cially a Google

site like Blogger. There are no sign-in
hassles, and your Orkut profile with full-
blown functionality is enabled with this
nifty gadget.  
IM: Access to IMs (Gtalk, Yahoo! Mes-
senger, MSN Messenger, and more) is

quite easy with gadgets available. The
Yahoo! Messenger gadget is

nothing special, but Google Talk
was like the real thing. Tabbed
conversations, smileys, the

Get Orkut on your pageThe settings for a typical Google Gadget

Chaitanya Surpur 
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ability to hold group chats, calling up
contacts—you get all the goodies.
Visitor Map: Find out where your visi-
tors come from, on a Google map. The
map uses an API from Clicky (www.
getclicky.com), a Web analytics service. To

use this gadget, register your site at
Clicky, then go to the Google Gadgets
page and get the HTML code. There is a
slight bug here—till Clicky gets enough
visitor statistics, the map shows the
default image.

For lighting up the mood, we put
in the English to Yoda speak converter
(we love Star Wars, and we love the
little Jedi master most). Type in any
English sentence—“Work is a pain in
the neck”—and a few seconds later, up
pops up, in Yoda speak: “Pain in the
neck work is. Yes, hmmm”. (A swear
word elicits a scolding.)
Google Maps: Inserting maps, even if
you have no experience with code, is very
easy with Google maps. To create a
custom map, you need to go to Google
Maps, select My Maps, click on Create
New Map and start dragging placeholders
and drawing lines and shapes on your
map. When you’re done, click on Link
To This Page at the top right of the
map, and get the HTML code.
Flickr Zeitgeist: This is a small widget
to display your photos from Flickr, if you
have any uploaded there. Visit

www.flickr.com/fun/ zeitgeist/ to get your
HTML code.

Of course, you don’t have to settle
for what’s already there...

Your Own Gadget
Making your own Google gadget is sur-
prisingly easy—you just need to have an
idea of what are you going to “gadgetise,”
and a few clicks later, you’ve got yourself
a brand new gadget. As we’ve mentioned
later, you won’t immediately be allowed
to put your gadget on your Blogger page,
but it’s a start.

Start with a site whose contents you
want to see in the gadget—we chose
www.thinkdigit.com. Open www.dapper.net,
a site that allows you to take content off
any page and transform it into a variety
of formats like XML, RSS feeds, Google
Gadgets, Netvibes Modules, etc. Choose
Google gadgets.

When you put in www.thinkdigit.com
in the address bar, Dapper opens a frame
with the site in it. Navigate to the Game
On section under Digital Leisure. Click on
Add to Basket to add this section to
your gadget.

Choose the fields using the Select
arrow at the top. The fields that will go
in your Dapp are highlighted in yellow.
This is a bit tricky, as the yellow patches
have a way of getting on unwanted con-
tent like ads or links. If you don’t select

well, your Dapp(applications made
with Dapper) will be worthless. Give a
common name to your group of con-
tent—we selected “Game Reviews.”

Click Next to view the content that
has been selected. Here, we’ve got a list
of the games that have been reviewed in
the magazine. This list will now be
updated when the site is.

The final step is saving your
Dapp—name, describe and tag it,
then click Save. If you’re unsure
of whether your Dapp works
right, check the This is a test
Dapp box—the Dapp will be
deleted within 24 hours. Alterna-
tively, if you don’t want your Dapp
published in Dapper’s directory,
check the Make Private option.
After hitting Save, you’ll get to
make some final settings, and also
preview your gadget. You can add
it to your iGoogle page, or publish
it in the iGoogle directory.

Only if (and this is a big if) your
gadget gets listed in the Google

directory will you be able to add it to your
Blogger page. Google takes its own time,
so it’s best to remain content with adding
the gadget to your iGoogle page. 

Conclusion
There you go: a basic guide to making
your own Web 2.0 mash-up, with a mini
primer on Google Gadgets. Go ahead and
surf the Google Gadgets directory—there
are so many gadgets available, you can
have one for every conceivable need. 

Making a mash-up (most people
define Web 2.0 their own way, so the def-
inition of “Web 2.0 mash-up” varies) is
fun, and also makes for a slick site, if
tastefully done.

bhaskar_sarma@thinkdigit.com

Select the content which you want

Your selected content, in a list

Chat from inside your Web site  

Check your visitor’s locations

Your gadget, on your iGoogle page

Name your gadget, and get a preview
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Designed from a pure
usability point-of-view,

this little baby is built like a
tank. The construction is
rugged in general, and we
liked the sturdiness of the
hinges in particular. It’s not
as flashy-looking as its
competitors, but it’s sleek,
and weighs just 1.29 kg.
With an Intel dual-core

processor and a decent
amount of RAM, while
running Windows Vista
Business, this laptop packs
in enough power to cater to
business needs. The proc-
essor’s and hard drive’s focus
is on increased battery life.

The 2510p sports a
widescreen (WXGA). An
ambient light sensor
automatically adjusts the
screen’s brightness.

The keyboard is very
comfortable to type on, but
the touchpad is a little too
smooth. There’s also a highly
responsive pointer-stick. The
keyboard layout is good,
and just above the function
keys is a line of touch-

sensitive cool-blue
backlit buttons for

functions such
as Turning
On/Off

wireless,
Volume control, etc.

The 2510p features

connectivity in the form of
Bluetooth and Wi-Fi as well
as Gigabit LAN—and even a
legacy modem. It has a PC
Card interface, SD memory
slot, two USB ports and a
FireWire port. You can buy
the HP 2400/2500 Ultra-Light
Docking Station to add more
ports. There’s also a D-Sub
connector so you can hook it
up to a projector.

Security is taken care of
by the biometric fingerprint
reader and a host of utilities
that can encrypt your hard
drive and restrict data access
to only authorised users.
Even theft or removing the
hard drive will not expose
your data to prying eyes.

There’s not much to
complain about with the
2510p; a webcam would have
been a great value-add. A

faster hard drive would have
improved performance
drastically, while reducing
battery life marginally. And
remember, this laptop is not
made for gaming. With a
one-year warranty and HP’s
great support system, the HP
Compaq 2510p is a
reasonably good buy.

Specifications
Intel Core 2 Duo ULV processor
U7600 @ 1.2 GHz; Mobile Intel
GM965 chipset; 1 GB 667 MHz
DDR2@533 MHz; 80 GB 1.8-inch
4200 rpm PATA hard drive;
Intel GMA X3100 graphics with
384 MB shared; DVD-RAM
drive; 12.1 inch WXGA anti-glare
LCD; Ports: 2 USB, 1 IEEE 1394,
Gigabit, RJ-11, D-Sub; Wireless:
Intel 802.11a/b/g, Bluetooth
2.0; Dimensions: 282.3(W) x
212.8(D) x 24.7(H) mm; Weight:
1.29 Kg; Battery: 3-cell (28 WHr)
high capacity Lithium-Ion

The Shaker is a rather
novel concept from

Sansa, (and after their
audiophile-grade Sansa
E2xx series), both a
disappointment and a
delight. One look at it will
delight, but after hearing it
perform we were a little
disappointed despite the
fact that it’s supposed to be
a fun music player and not
a real music player!

The Shaker is dressed in
funky wear—bright blue
and white and looks like a
salt dispenser, complete
with the holes on top
(loudspeaker). It features
two 3.5 mm jacks. There are
two white bands running
around the top and bottom
of the player. Both twist left
and right—the top one
controls the volume, the

lower skips tracks. There’s a
large, receded play/pause
button built into the body.
Build quality is top class,
and a classy aluminium
clasp allows it to be 
belted on.

Sound quality via the
3.5 mm jacks isn’t its forte.
Music sounds muted across
the spectrum. Highs and
lows weren’t defined at all,
while the vocals and mid-
range were barely tolerable
for someone really into
music. If you aren’t the
discerning type, you could

give it a try. The
loudspeaker sounds much
better though, and actually
made tunes bearable.

When we think Shaker
all we envision is the
average urban kid whose
mom and dad don’t want to
buy something with a
breakable LCD screen. At
Rs 1,899, the Shaker is good
enough to introduce your
fresh-in-their-teens kids to
the world of PMPs; others
might want to give it a pass.

Specifications
Capacity: 512 MB Flash
memory, SD expandable slot;
Music formats: AAC, MP3,
WAV; Dual 3.5 mm audio
jacks; Lanyard with
aluminium ring

Contact: Rashi Peripherals Pvt Ltd 
Phone: +91-22-67090909
E-mail: amitp@rptechindia.com
Web site: www.sandisk.com
Price: Rs 1,899

Contact: Hewlett-Packard India
Phone: +91-9819881983
E-mail: abhinaya.deshpande@hp.com
Web site: www.hp.com/in
Price: Rs 89,990 plus taxes

We test the latest hardware
and software products 
available in the market

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS
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Value for Money
Build Quality
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RATINGS

Sandisk Sansa Shaker 
Salt ’N’ Pepper Cellar This Isn’t!

HP Compaq 2510p 
The Tough Ultraportable

BazaarBazaar
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Not all manufacturers are
innovators of style. Ever

since it launched the
Chocolate a year ago, LG has
been on to something, and
that something is its new
classy mobile line-up, of
which the Black Label Series
KE970 (a.k.a. Shine) is what
we got to lay our hands on.

Encased in a full-metallic
body with a rich brush
finish, the KE970 is as
rugged as a tank. It is wider
than most mobiles. The
highlight here is its 2.2-inch
LCD, which not only looks
good while it is on, but
doubles up as a mirror when
not lit up!

The keys offer good
tactile feedback. LG has
introduced the rolling scroll
button for the first time, but
we found it rather
inconvenient: it is very
frustrating to keep scrolling
through long lists and Web
pages. Probably because of
the scroller, the UI is vertical

menu-based rather than
icon-based—rather
unintuitive.

The Shine has an
excellent 2.0 MP camera with
autofocus. It is certified by
Schneider Kreuznach, the
German company that

certifies photo-optics. The
camera does live up to its
hype, and is one of the best
we have seen thus far. You
can choose from a host of
different resolutions and
there are five white balance
settings, along with a few
artistic effects. The camera is
a bit sluggish, though.

The media player is
decent. Bluetooth 1.2 with
A2DP support—wirefree
stereo music on a supported
headset. There is support to
view most common office
formats, but the internal
memory is just 50 MB, and
you’ll need to use the
microSD slot to add more—
irritatingly, it’s not hot-
swappable. Lost Mobile Track
(LMT) function is inbuilt to
allow you to trace the phone
in case you lose it.

We found the call

quality decent, the KE970 is
weaker at signal reception
than most phones we have
seen. You can’t make a call
or even send a message
when the phone is
connected to the PC.

To sum it up, the LG
Black Label KE970 is über-
high on style, but there are
certain issues that need to
be addressed. The price tag
of Rs 19,000 is a little too
much—there are better deals
out there.

Specifications
GSM 900/GSM 1800/GSM 1900;
Display: 2.2-inch with mirror
finish; 240 x 320; 256K colours;
Camera: 2.0 MP, autofocus,
flash; Memory: 50 MB internal,
microSD; Connectivity: GPRS,
EDGE, Bluetooth 1.2 with A2DP,
USB; Weight: 118 g; Dimensions:
99.8 (H) x 50.6 (W) x 13.8 (D)
mm; Accessories: Charger, USB
cable, stereo handsfree, lanyard 

LG Black Label Series KE970 “Shine” 
If only looks could matter

The WinFast DTV1800 H is
a hybrid PCI TV Tuner

capable of receiving analogue
as well as terrestrial digital
(DVB-T) transmissions, which
are currently available only
in a few metros. The
Conexant CX23880-39 +
Zarlink 10353 chipset enables
it to decode stereo audio. The
audio cable connects
internally to the PC-audio
solutions, so no more looping
cables collecting cobwebs at
the back of your PC.

The front-end is provided
by the excellent WinFast
PVR2 that features
Scheduling and
TimeShifting, as well as
recording in WMV, Transport
Stream, as well as MPEG-1/2
(and no additional activation
or purchase is required for its

use). It remains perched
quietly in the system tray and
springs into action when
launched using the icon or
the full-function remote. The
PVR2 even lets you use two
TV-Tuners simultaneously, so
you can either watch two TV
channels, watch one and
record the other, or watch TV
and use the second TV-Tuner
for surveillance.

It detects even the
weakest of cable TV and FM
radio channels. Video as well
as audio quality is top-notch.

You can force the aspect ratio
to either 4:3 or 16:9—a
delight for wide-screen users.

To sum it up, the WinFast
DTV1800 H gives you the best
of both worlds, and we give it
a double thumbs-up—no
complaints. 

Specifications
Chipset: Conexant 23880-39 +
Zarlink 10353; Tuner: Xceive
3018 TV/FM Stereo; TV

reception: Analogue, DVB-T;
Video standards: PAL, NTSC,
SECAM; Software: WinFast
PVR2; Video capture formats:
WMV, MPEG-1/2, Transport
Stream; Remote control; Input
ports: Coaxial, S-Video

Leadtek WinFast DTV1800 H  
Two Thumbs Up

Contact: TopNotch Infotronix 
Phone: +91-44-26616201
E-mail: enquiry@zebronics.info

Web site: www.leadtek.com

Price: Rs 3,900

Feature  
Performance
Build Quality
Value for Money
Overall 

RATINGS

Contact: LG Electronics India P. Ltd 
Phone: +91-9899302514
E-mail: viveksingh@lgindia.com
Web site: www.lgezbuy.com
Price: Rs 12,990

Performance  
Features
Ease of use
Value for Money
Overall 

RATINGS
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The PXC 450 is the latest
from Sennheiser’s travel

line of headphones.
“Portable” and “circumaural”
generally don’t see eye to eye
due to bulk and issues with
anchoring them to your
head. To remedy this, the
PXC 450 has a very firm
headband; thankfully,
it’s padded and well-
designed enough to not
squash your ears.

The patented active noise
cancellation technology
called NoiseGard 2.0 makes
its presence felt. This uses a
combination of improved
circuitry (over the previous
version of NoiseGard), and
better microphones (that
detect unwanted outside
noise). Their noise
elimination algorithms have
also seen an overhaul. Using
NoiseGard will require a
single AAA battery. Remove
the battery and the PXC 450
can function as a regular,
wired headphone set.

There’s a talk-through
function inbuilt. According
to Sennheiser, two
microphones (one on each

cup)
pick
up
external
sounds
in the
immediate
vicinity such
as someone
trying to talk to
you. We tested this
feature, but it didn’t work
too well, and the reviewer
had to take off the
headphones to hear what the
other person was saying.
Nevertheless the PXC 450
isolates noise beautifully
even with NoiseGard off.

Bass is quite a mixed bag:
sometimes it’s there and
goes quite low, on other
tracks it’s not as pronounced
as the mids and highs. We’d
have liked for these phones
to be a little kinder to vocals
and mids—which, although
forward (not overly so), lack
finer detail. (At this point
we’re comparing them to
audiophile-grade cans.)

Their quick response
means the PXC 450 is equally
suited for fast heavy metal

music as
to country or
soft rock genres. They’re
rather easy to drive—so using
them with your iPod while
aboard a noisy local or bus is
a possibility.

These cans need to be
used for around a hundred
hours before they actually
sound good (burned in, if
you will). We found a full 35
to 40 per cent difference in

quality and bass
reproduction, and highs
became a little more
noticeable. They’re still
improving after the 120 odd
hours that we’ve spent with
them, so don’t go by the way
a brand new pair sounds.

At Rs 29,900, the PXC 450
is far from affordable. Even if
you can foot the bill, you will
still need to accept that these
aren’t the audiophile-grade
cans that the price suggests.
That said, they’re head and
shoulder above most other
headphones available in
India, and definitely one of
the best noise-cancelling sets
we’ve come across (including
the Bose Companion 5). Of
course they’re in a price
league of their own!

Specifications
8 to 28000 Hz; 150 ohms;
Sound Pressure Level (SPL): 108
dB; Cable: 1.4 m; Weight: 240g;
Accessories: transport case, 6.3
mm stereo adapter

The TurboUSB feature
incorporated on the

Buffalo HD-HS250U2
external hard drive
promises a 37 per cent
improvement in transfer
speeds over regular PATA-
based external USB drives.

The drive is well built
with matte-black plastic
edges. The bottom half of
the silver coloured side
panel and the top panel
have pores to aid air
circulation. Additionally,
you can improve the drive’s
cooling by clipping the
optional HD-HSU2 fan to the
top of the drive.

The drive automatically
powers itself down when it
detects a disconnection
from the host PC, or when
the PC shuts down. It enters
a state of hibernation when

inactive for a preset amount
of time. The bundled Secure
Lock Ware allows AES
256/128 encryption of
important data, preventing
unauthorised access. Then,
Memeo AutoBackup is a
feature-rich and simple-to-
use software—it allows
you to back up to a shared
network device, network
folder, iPod, Memeo Internet
drive, or Flash drive.

The tests were
performed in both normal
and TurboUSB mode. In the
latter, the drive outper-

formed the Digit Best Buy
June 2007 Western Digital
MyBook Essential (500 GB).
Switching between Turbo
and normal mode is easy
using the TurboUSB utility.

The drive is definitely
not the cheapest amongst
the 250 GB drives available,
though the performance in
TurboUSB mode justifies
the cost to an extent.
Power management, along
with the option for
additional cooling, makes
it a good purchase if you’re
looking for a dedicated
external drive.

Specifications
7200 rpm SATA; USB 2.0;
TurboUSB; Dimensions: 4.6 (W)
x 16.3 (D) x 20(H) cm;
Weight: 6.2 kg

Sennheiser PXC 450
Noise out, sound in!

Contact: Buffalo Inc.
Phone: +91-11-41436751
E-mail: csbuffalo
@adventelectronics.com
Web site: www.buffalotech.com
Price: Rs 7,800

Features  
Performance
Value for Monery
Comfort
Overall 

RATINGS
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RATINGS

Buffalo DriveStation TurboUSB 250GB (HD-HS250U2)
Turbocharged Transfers

Contact: Sennheiser Electronics
India Pvt Ltd
Phone: +91-124-4187815
E-mail: kapil.gulati@
sennheiserindia.com
Web site: www.sennheiserindia.com
Price: Rs 29,900
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Print, scan, fax, copy and
get photo prints all at a

great price—seem
impossible? Well, the
Brother MFC-5460CN seems
to be what you are looking
for—at least at first look. Like
all Brother MFDs, this one
sports a no-nonsense, office
look, with rugged build. It is
quite small. At the front is a
two-line, backlit LCD
indicator that reports a lot of
data and also lets you access
the control panel menu. The
input paper tray can
accommodate 100 pages—
just enough for a small to
medium office—and the 35-
page ADF tray is foldable.

The printer sports a
resolution of 6000 x 1200
dpi—fairly high. There are
four colour cartridges, and
access to these is made easy
by means of a door at the
front of the unit. The flatbed
scanner can scan legal-size
documents. The
printer supports most
popular memory formats
and it even

has PictBridge.
Connectivity is via USB

and a network interface, but
you will need to weave the
wires through the provided
channel into the heart of
the device. The advantage:
no accidental
disconnections;
disadvantage: it’s irritating,
and wires may not last long
due to all the twisting.

The inbuilt 33.6 kbps fax
can store up to 400 pages
and is capable of
broadcasting to up to 150
locations. The phonebook
memory is 100 numbers.

Printing is slow; the
printer took half a minute
to print a simple text
document in normal mode,
and it took over a minute to
print the same in best
mode. Print quality is
decent and sharp. There is
some amount of graininess
in photo prints, but it’s
good enough for the
average home user. The
copier does an excellent job.

The software bundle

consists of the MFL-Pro Suite
(a control centre of sorts),
PaperPort SE with OCR (a
definite plus), and even
Presto! PageManager OCR for
Mac users.

At its price, we can say
this is a good buy, if you
don’t mind waiting a bit for
the print.

Specifications
Printer resolution: 6000 x 1200

dpi; Printing technology:
thermal inkjet; Number of
cartridges: 4; Scanner
resolution (optical): 2400 x
1200 dpi; Input paper tray
capacity: 100 sheets; ADF
capacity: 35 sheets; Memory
slots: CF, MS, MS Pro, SD, MMC,
xD Picture Card; I/O ports: USB,
RJ-45; Fax memory: 400 pages;
Auto-dial: 100; Broadcast
locations: 150; Weight: 9 kg;
Dimensions: 44 (W) x 39.5 (D)
x 22.6 (H) cm

Contact: Brother International
(India) Pvt Ltd
Phone: +91-22-40988900
E-mail: customercare@brother.in
Web site: www.brother.in
Price: Rs 13,500

ViewSonic is just one of
the many brands trying

to push projectors into the
home theatre market as
good replacements for
large TVs. The design of the
PJ258D is great—it’s com-
pact and has a jet black
glossy piano finish which
makes it stand out—and
which also makes it a fin-
gerprint magnet.

Screen quality is pretty
decent—quite sharp, and
zooming only affects it a
little. The display turns out
very bright, and is very
prominent even in a well
lit room. Text is readable,
but the best results are
achieved during image and
movie viewing—Thus
making it good for multi-
media purposes. 

The remote control is
small and moulded to fit
the average hand well. The

buttons are soft and easy to
use. IR ports have been
positioned on the front as
well as at the back, so you
don’t have to plan where
you’ll stand.

You can connect an iPod
to the projector to watch
your favourite movies on
the big screen. The stan-
dard inputs are VGA,
S-Video, Composite, and a
standard analogue audio
in. The USB port can be
used to upgrade the
firmware.

Heating, as with all pro-
jectors, still remains an
issue. The fan spews out

hot air continuously from
its side, but the ViewSonic
PJ258D still gets awfully
hot even after just 15 min-
utes of use. The stand for
raising the projectors front
is a little flimsy. 

The manual is very
basic and has information
on the parts of the project
and how it’s supposed to be
set up. A large pouch is
supplied as well. 

At a price of Rs 70,000,
the ViewSonic PJ258D is
reasonably priced and
offers good performance.
Also, it’s cheaper than
buying an LCD or Plasma
TV with a comparable
viewing area. 

The iPod docking
facility might attract a few
users, but the heat it gener-
ates is definitely a concern
if you plan on using it for
many hours at a stretch. 

Specifications
Size: 40-inch to 300-inch
(diagonal), Pixel format: 1024
x 768, Dimensions:
11.3x7.5x3.5 inches, Lamp:
2000 hours (normal),
Contrast ratio: 2000:1.

ViewSonic PJ258D
Ouch—smoking hot!

Contact: Redington (India) Limited
Phone: +91-9380303950
E-mail: hemachandran.m@
redington.co.in
Web site: http://ap.viewsonic.com/in
Price: Rs 70,000

Features  
Performance 
Build Quality
Value for Money
Overall 

RATINGS
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Brother MFC-5460CN
The Affordable Network MFD
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Nero has always been the
favourite choice in

CD/DVD burning software,
and is used by almost
everyone today. VSO
Software’s CopyToDVD 4 just
might be able to change
that. CopyToDVD 4 is elegant
and straightforward in its
approach. The Welcome
window doesn’t look all that
great, but it does its job of
guiding you through.

The most popular
application is the
CopyToDVD Manager, which
is the Nero Burning ROM
equivalent. The interface is
simple, with two panes
providing some help, and
there’s the main project
window and the file browser
window. The Wizard panes
can be disabled. To make
things more fun, a large
collection of themes is
provided, each of them

tasteful and unique.
Burning audio CDs is no

problem—the software
handles almost all audio
formats. Burning video DVDs
or CDs is a different story,
however. Conversion to DVD
means you might need to
get VSO’s other software—
ConvertXtoDVD. This isn’t
free. Non-advanced users
will have to go through the
trouble of converting videos
to suitable formats using
third-party applications
before burning them to CDs
or DVDs.

You can choose to
schedule burning tasks,

which can be useful in
backing up data, say every
day or every week. 

The software is light and
bloat-free—20 MB memory
consumption most of the
time. There is no help file,
only a link to the manual
when you look for Help.

The price tag of Rs 1,200
is definitely attractive. This
10 MB software actually
makes good sense when the
latest Nero 8 is now nearing

a gigabyte in size.
CopyToDVD 4 does what
most of us need, and not
much more. It is great for
people who keep backing up
data very often—along with
an occasional audio and
video CD.

Web site: VSO Software
Phone: +33-5-62160223
E-mail: annelise@vso-software.fr
Web site: www.vso-software.fr
Price: $29.99 (Rs 1,200)

Kaspersky is another one
of the many anti-virus

makers that’s gone the
complete Internet security
system way—not a bad
thing. It’s known to be a
resource hog, so we
checked if anything had
improved with this edition. 

The suite takes care of
all your security worries—
files, mail, system network
security, etc. All the basic
controls for the
components can be
accessed from the main
two-pane layout window.
Modifying settings means
you go to another window
which houses all the
settings for the
components, and there are
plenty of them. 

The core anti-virus
feature is standard and
allows you to scan files and
folders along with boot
sectors, Registry, memory,
startup programs, etc. The
Anti-spam has a nifty

training feature that learns
by looking at mails in your
mailbox through a Wizard
to provide more accurate
spam protection. The
firewall monitors for
incoming and outgoing
threats and notifies you
immediately. Any attacks

targeted at your computer
can be set to have the
attacker’s machine blocked
for a set period of time.
The firewall also takes care
of the blocking of ad
banners and pop-ups from
Web sites as well. The
parental control is useful
in not only stopping access
to inappropriate sites, but
also in setting limitations
on time spent at the
computer and on the
Internet. User accounts on
Windows can be set to
Parent, Teenager, or Child
and by default, all users
are set to Child.

Strictness of all the
features can be adjusted
using a slider. At the same

time, manual changes can
be made. This is especially
useful for spam filtering,
parental control and the
firewall. Heuristic scanning
is available in most of the
modules, but not enabled
in all of them by default.

The help file doesn’t
carry any screenshots, but
the explanation is
adequate and easy to
understand.

Kaspersky’s Internet
Security Suite is a pretty
good choice for anyone
looking for a complete
security solution—it’s right
up there with the best
security suites money can
buy. There are no missing
features, and everything is
implemented well. New
users might be a little
confused by all the terms
and huge list of options,
though.

Web site: www.kaspersky.com
Price : $59.95 (Rs 2,400) (One year)

Kaspersky Internet Security 7.0
The Big Daddy Of Internet Security Suites

Features  
Performance 
Ease of use
Value for Money
Overall 

RATINGS

Features  
Performance 
Ease of use
Value for Money
Overall 

RATINGS

on Digit CopyToDVD 4
A non-deviated CD/DVD burning app
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The need for a PDF Editor
usually means you end

up buying a copy of Adobe
Acrobat. There are a few
paid applications to do the
same task. CAD-KAS’s PDF
Editor 2.4 is one such
application among a few
other emerging ones.

The interface is
modular; it allows you to
add and remove or even
move panels around. It is a

little cluttered, with the top
end of the window taken up
by the two toolbars and the
tab bar, which are used to
do the majority of the
tasks—opening, editing,
exporting, etc. Although
looks aren’t a priority in
software such as this, six
menu colour schemes have
been included as a way to
improve the cluttered UI.

One can change pretty

much everything in an
existing PDF file. Text,
images, and even complete
pages can be edited and
moved about. New additions
can be made easily in the
same manner. Images in
PDFs can be edited using
the inbuilt image editor—
which looks like MS Paint,
but is a lot more advanced
in features. A scanner can
be used to add new pages.
Bookmarks can be set, and
existing ones deleted if
required. 

CAD-KAS PDF Editor
allows you to save PDF files
in different PDF versions,
and also encrypt and
protect them from being
edited or even viewed if
required. One of the
missing features is the
ability to export a Web page
into the PDF format.

Exporting to Word files
and text files is supported,
though.

The way you use the
software is a little different
from what you’re used to.
You need to first select the
tool and then select the text
or image that you’re trying
to alter. Double-clicking
doesn’t enable any kind of
editing mode. There is no
live preview of all the tasks
done—on images for
example. Users will take a
while to get used to all this.
The help file has sketchy
documentation with the
most basic explanations,
and contains just a few
screenshots.

CAD-KAS PDF Editor
skimps on some of the
features Acrobat gives you,
but it is way cheaper—just
$79. Ignore the tiny missing
features, and it’s a great
tool for anyone who needs
to create documentation or
distribute important
documents.

CAD-KAS PDF Editor 2.6
Tricky!

Web site: www.cadkas.com 
Price: $79 (Rs 3,200)

ACDSee is an image
viewer that’s been well

known since the days of
IrfanView. ACDSee had quite
a few followers for its
superior features back then,
but IrfanView was generally
known more for being
freeware. ACDSee 2 Pro has
moved from being just an
image viewer. This new
version boasts of great photo
handling features for the
professional photographer.

The first thing ACDSee 2
Pro does is catalogue all
your images when you first
run it. The interface is
surrounded by sidebars,
leaving only a small area to
actually view images and
the thumbnails. 

Photos are sorted by
time and can be viewed
through the Calendar view.
The other useful filtering
feature is the Organise
sidebar, which allows you to

display photos from only a
particular camera. A quick
preview appears when you
hover the pointer over an
image.  You can enter image
editing mode by double-
clicking on any of the
photos. ACDSee 2 Pro even
loads videos; you can not
only view them, but also
convert them using the
codecs on your machine.

Images and videos can
even be burnt onto CD and
DVD. Wizards are available
to create video CDs as well.
Other than that, you can
even export your photos as
HTML albums, PDF, or
PowerPoint presentations. 

Memory consumption
was well under 30 MB while
browsing images, and only
spiked by a few (5 to 10) MB
while opening images.

Other than its clumsy
interface, ACDSee 2 Pro
seems a nice software, until
you get to know about the
price tag—$129.99. It’s still
much cheaper than Adobe
Lightroom, which is more
than twice its price. It has
quite a few features that can

be compared to those of
Lightroom, but it doesn’t
match its simplicity.

People looking for image
viewers can stick to free
ones like IrfanView, as
ACDSee 2 Pro has gone far
beyond that. Users who
can’t afford Lightroom
might want to consider
ACDSee 2 Pro.

ACDSee 2 Pro
Lightroom’s new competitor

Web site: www.acdsee.com
Price: $129.99 (Rs 5,200)

Features  
Performance 
Ease of use
Value for Money
Overall 

RATINGS

Features  
Performance 
Ease of use
Value for Money
Overall 

RATINGS
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SECRETS THAT KEEP YOU AHEAD IN THE RACE

WINDOWS VISTA
Adding Desktop Icons And
Customising Them 

The only icons on the desktop you will
find after a clean install of Vista is that of
the Recycle Bin. We love our desktops, and
it’s one of the quickest ways to access
programs. To get icons of the other
necessary programs in Vista like the
Computer and Network, right-click on the
desktop and select Personalize. Click
on Change desktop icons in the left
pane. Check the boxes for the icons that
you require on the desktop. Click OK.

The same window also allows you to set
custom icons for each item. Click on the
icon that needs to be changed and click
the Change Icon button. Select the icon of
your choice and click OK.

Disabling Folders And Links In
The Start Menu

The Vista Start Menu has links to
almost everything: Music, Games,
Pictures, Documents, etc. You may not
need all of these, or you may need to
add some more shortcuts.  To remove
these links, right-click on the taskbar
and click on Properties. Click on the
Start Menu tab. Here you can choose
to set the Start Menu to look like older
Windows versions, you can choose to
select the Classic Start menu by
clicking the radio box. To remove the
unnecessary items, click on
Customize next to Start menu. To
disable the links, check the radio 
box—Don’t display this item for the
items you want removed. Click OK
when done.

Changing Power Button
Characteristics

Vista has this useful option of allowing
the user to choose the function that the
Power button on your computer performs.
Go to Start > Control Panel and (if
you’re using the Classic View) double-
click on Power Options > Choose
what the power button does. To
do this from the standard Control Panel
view, go to System and Maintenance
> Power Options > Choose what
the power button does. Once you’ve
got here, you will find that the options
are disabled by default, so click on
Change settings that are
currently unavailable. Click on the
dropdown for the Power button settings.
Choose from Sleep, Hibernate and Shut
down. Click Save Changes when you’re
done.

Accessing The File Menu
One of the characteristics of Vista

is that there might not be any File
menu in some of the applications such
as Windows Explorer for example. At
any time to access this menu, press
[Alt]. To permanently enable the
menus, open Windows Explorer. Go to
Organize > Folder and Search
Options. Click on the View tab and
check the box for Always show
menus. Click OK.

Search The Internet Quickly
Microsoft has implemented the

search bar within the Start Menu in
Windows Vista. Its main purpose is to
access files and programs quickly but it
can be used to search the Internet as well.
Click on the Start button or press the
Windows key on your keyboard. Enter the
keywords in the search field. Click on
Search the Internet to use the default
search engine (Live Search). In Windows
Explorer, the search field normally
searches the local drive. Pressing
[Shift] + [Enter] after entering the
keyword will open up a new browser
window with results of the search in the
default search engine.

Adding New Search Engines To
The List

You just learnt how to use the Start
Menu to search the Net. You can also
change the default search engine Vista
uses. To do this, start Internet Explorer.
Click on the dropdown in the Search
field and click Find More Providers. A
page should load with a list of some
search engines. Click on the search
engine you want to use. A confirmation
window will pop up. Click Add Provider.
If you want to make it your default
search engine, check the “Make this my
default search provider” box. Click OK.
Now all Internet searches done by you

Necessary desktop icons can be set to be dis-
played on the desktop

Pressing Alt shows the File menu which isn’t
displayed on Vista by default
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will be handled by the new default
search engine.

Automating Drive Defragging
Sessions

Defragging is a must. Vista has an
inbuilt scheduling feature that allows
you to set when you want your drives to

be defragged. Start Disk Defragmenter.
Click on Modify Schedule and select
when you want the defragging to take
place. You can set the frequency, the day
and time for the defragment process.

Turn Off Unnecessary Features
Vista comes bundled with a whole

lot of features you don’t always need.
These can be turned off to save
resources and speed up the computer a

bit. Go to Start > Control Panel >
Programs > Turn Windows
Features on or off. A list of
installed components will be displayed
and the ones not required like Tablet PC
Optional Components and Fax and Scan
can be removed. Uncheck the boxes for
these components and click OK.

An Advanced Right-click Menu 
The right-click is the quickest way

to access and work with files. The Vista
right-click menu has a few more

options that are hidden away. To be
able to use these, hold down [Shift]
when right-clicking. If you do this to a
folder, you can launch a command
prompt at that location. You will now
be able to copy the path of a file or a
folder using that menu much quicker
than usual.

Removing Vista And
Its Boot Loader 

If you have Vista and XP in
dual-boot and want to get rid
of Vista, its boot loader is an
obstacle. To get rid of Vista,
insert your Windows XP CD
and boot from it. Remember
to set your first boot device
as your CD/DVD drive. Press a
key when it tells you to
during boot up. When
prompted, press [R] to load
the
Recovery

console. Confirm your
Windows installation
by entering the
number. Enter your
Administrator
password at the
prompt. On the
prompt, type fixmbr
and then type
fixboot.

Reboot and you
should be
able to boot into Windows XP.
Make sure you have backed up
all critical files. Then format the
partition on which Vista was
installed to clear out Vista.

Another way to do this is to
insert your Windows Vista CD
and boot into Windows XP as
usual. Go to Start > Run, type
X:\boot\bootsec.exe
/nt52 ALL /force. (Replace X
with your CD/DVD drive letter).
Reboot and format the Vista
partition.

Using Parental Control 
Not only can parental

control in Vista safeguard your
children from inappropriate
content, it can also regulate the

way they use the computer. Go to Start
> Control Panel > User
Accounts and Family Safety and
click on Set up parental
controls. 

You can create a new account for
your children by clicking on Create a
new user account or just choose an
existing account. Here, click On,
enforce current settings. Other
setting that you will find here are time
limits, and program, Internet and game
access restrictions.

Recently Opened Items 
As in Windows XP, Vista has a small

list that shows all files that were opened
recently. By default, the value is set to 15.
This number can be changed through a
registry tweak. Start registry editor
(Start > Run > regedit). Browse to
HKEY_CURRENT_USER\
Software\Microsoft\Windows\Curr
entVersion\Policies\Explorer.
Here, right-click in the right pane and
create a new 32-bit DWORD called
MaxRecentDocs. Double-click on the
entry and give it a Decimal type value of
how many ever entries you want in the
recently opened file list. Reboot when
you’re done and the changes will be
applied.

If you do not want to have a list of
recently opened files at all, the easier way
is to right-click on the taskbar and click
on Properties. Click on the Start Menu tab

and uncheck the “Store and display a list
of recently opened files” box.

Tweaking Indexing 
If you set Vista to index all files

on your drive, this can take quite a
while. Chances are, you will not be
searching for INI files in the
C:\Windows\system32 anytime soon.
You can speed up the process by
selecting only the most important
locations to be indexed. Get to the
Indexing Options by going to Start >
Control Panel > System and
Maintenance > Indexing Options.
Now, go to Modify > Show all
locations. Here you can select which
folders you want indexed. Clicking on
Advanced in the Indexing Options
window will let you set filters for file
types as well.

ADOBE FLASH CS3

T he latest version of Adobe Flash is
part of the CS3 badge. It’s got a
new look and we’re bringing you a

whole bunch of tweaks for Flash novices.

Customize Your Toolbars
Toolbars are the quickest way to

access tools, but Flash has so many tools
that it’s not possible to have all of them

Users can now set when they want their system to be defragged

Disabling unnecessary Vista features can save space and
resources

Useful Shortcuts

Bring gadgets sidebar into focus 
Cycle between gadgets
Launch nth Quicklaunch application

Cycle between 3D objects
Cycle through programs in taskbar
Quickly viewing file details in Explorer
Show all subfolders under a folder

[Windows] + [Spacebar]
[Windows] + [G]
[Windows] + [Application 
number in Quicklaunch]
[Windows] + [Tab]
[Windows] + [T]
[Ctrl] + [Mouse scroll]
[Num Lock] + [*]
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Tweak Compression Settings 
While working on Flash, you can

import objects that weren’t designed in
Flash, such as images or videos. This
can add to file sizes in Flash
animations though. You can access
compression settings by going to File
> Publish Settings > Flash. You
can modify the JPEG quality and the
audio quality here. Other ways of
getting smaller Flash file sizes is to set
fairly low frame rates if your
animation has no fast motions.

Better Performance 
The preview feature will tell you

how the project is coming along.
Depending on the number of objects
and layers, the performance of the
preview can suffer and you might get
really low frame rates. Flash gives you

the option to choose the quality of the
preview too. Go to View > Preview
Mode and choose from one of the
modes listed there.

Quick Hide Toolbars 
Like every other advanced

graphics designing tool, Flash CS3 too
has toolbars which eat up a lot of
valuable workspace. Depending on the
resolution of your monitor, you might
end up with very little working space.

To get more space you can disable the
toolbars by pressing [F4]. Pressing
[F4] again will bring back the
toolbars. The CS3 family of products
also have toolbars that can be made
more compact by clicking on the
arrows at the title of each toolbar.

The Pen Tool  
You might think that any

freehand drawings done using the
Pencil or Brush tool can’t be edited
easily. Flash is much more flexible

than that. Clicking the pen
tool displays the path for
the freehand drawing and
you can in fact add, remove
and move control points in
it. When you use the
Eraser, new control points
are automatically created
to form a new modified
shape.

Animations And
Keyframes 

Animations in 3D or 2D are
made up of a sequence of
keyframes, each with
objects in them. Flash, like
other animation packages,
works in the same manner,

and creating animations means you
need to create keyframes wherever
there’s some kind of significant change
made. To create a keyframe, right-click
in the time line and click on Insert
keyframe.

Making Better Use Of The
Timeline Window 
The timeline plays an important
part in helping you keep track of
everything going on in an
animation. It allows you to jump
to different positions and make
changes to the animation. It looks
rather simple but there are
different faces to it. Click on the
right top icon of the timeline
window. Here, you can change the
position of the window and the
size of its contents. The most
useful feature is evident when you
choose the Preview mode. The
timeline window now shows a
frame-by-frame preview instead of

just keyframes.

visible together. Adobe’s products are
notorious for having tools with sub-tools
hidden in them. These can be accessed
by holding down the left-click on a
particular tool in the toolbar. These
tools usually have a small tag on the

right-bottom of the icon as an indicator.
Adobe Flash CS3 allows you to add

custom sub-tools to any existing tool.
Just click on Edit > Edit Tools
Panel and select the tool that you want
to add the sub-tool to. Choose one from
the list of available tools and click Add
and then click OK when done. You can
also remove sub-tools that may have
come by default with Flash CS3 if you
want to.

Onion Mode 
The Onion mode in Flash is kind

of like using the transparent sheet
paper used by animators before
computers came along. It allows you to
get a reference of previous frames so as
to be able to plot changes in the frames
accurately. The Onion mode can be
enabled by clicking on the Onion Skin
button at the bottom of the timeline
window. If you just want the outlines
of the objects to be shown, then click
on the Onion Skin Outlines button
which is to the right of the Onion Skin
button. 

Flash CS3 toolbars can be modified to suite
your style of working

Quality can be sacrificed for better performance
during previews

The timeline window is more versatile than
one thinks

Compression settings for audio and images can be modified
as per the needs

Illustrations Harsho Mohan Chattoraj
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Rendering 3D images is a won-
derful and addictive passion as
well as an attractive career option.

But some people—for example, graphic
artists—are actually afraid of 3D ren-
dering software, and their fears are
well-founded many a time; seldom will
you find a software that’s easy to learn
and master. Here, we’ll introduce you to
one software that is!

Bryce 5.5 is a 3D illustration and
rendering software available for free
download (122 MB) from
www.daz3d.com. (You’ll also find it on
our August 2007 DVD.) You’ll need to
create an account at the site to pro-
cure your free serial code.

The beauty of Bryce is the ease with
which you can create breathtakingly
realistic 3D landscapes and animations
using a drag-and-drop interface on a
“real-time canvas” (meaning you can
alter the position and shape, and even
replace objects in the scene any time
you want). All this in an intuitive
manner, in a matter of minutes. You
design a scene in 3D within Bryce, then
Bryce takes the 3D information and fig-
ures how it would look in 2D (with
shading and all) so when you render it,
it looks like a painting with a 3D effect. 

Let’s look at how handy this tool
really is.

Easy-to-use GUI Toolbars
You’ll see three types of toolbars: one
for creating objects, one for editing
them, and one for editing the environ-
ment (“Sky & Fog”). There is also a
camera control section that allows you
to change the camera angle or your
view of the scene (refer image below).
The mountain in the image—with the
objects around it—changes your camera
view to top, then front, left, right, back,
and underneath. Clicking on the small
ring at the upper right corner gives you
a “flyaround” preview of your creation,

meaning you can look at the whole
scene at once. You can either move the
camera angle on any of the three axes
by clicking and dragging on the flat
arrows, or you can move all three at
once with the trackball—though this is
a bit harder in terms of ease of control.
Just below the trackball are the render
options, with the render button at the
centre. The rest of the options allow you
to do such things as turning textures on
and off while rendering, doing a quick
preview render,
resuming rendering,
and clearing a render.

At the very top of
the screenshot along-
side (Camera controls
and Nano Preview) is
the Nano Preview
window, which gives
you a preview, in
quick thumbnail size
render form, of your
creation. This saves
time because full-
screen rendering
takes much longer.
You can save camera
angles by clicking on
the little buttons to
the left of the
window.  The top
button gives you the
default camera angle.

The Create Toolbar
The Create Toolbar is the one which you
will be using the most while using this
software. The first three of these icons
represent infinite planes; the blue one
is water, the white one is clouds, and
the last is a ground plane.

Next is the mountain, which allows
you to create random mountains, and
there’s a tool that allows you to edit
almost everything about the moun-
tain. Similarly, there is the random
rock, symmetrical lattice, and a multi-
tude of objects (in blue) that can be
placed in the manipulation field (the
3D canvas). The last group of objects (in
yellow) are the light sources; these let
you place spotlights, radial light
sources, parallel lights, etc. and decide
their directions to illuminate the

scene. Clicking on the icons places
them in the manipulation field.

As you probably know, proper
lighting can make all the difference
between just another illustration and
a masterpiece. 

The Edit Toolbar
This toolbar allows you to edit the
objects you just created. The tool on the
far left is the material editor, which
opens up a window where you can
choose from or create custom textures
for your objects. Next is the stretch tool,
which allows, as the name suggests, to
stretch objects on the three axes. This
can also be used to mirror objects. The
rotation tool and the move tool are
obvious. The align tool that comes next
lets you line up all your objects in refer-

ence to one thing or another. Next is the
randomise tool, which sends your
objects scurrying in random direc-
tions… Last comes the terrain editor
tool, which brings up different edit win-
dows for rocks, mountains, light
sources, and more. You can also edit
objects in the manipulation window
using the mouse.

The Sky & Fog Toolbar

This toolbar allows you to create custom
skies and atmospheres for your scene.
Each of the controls has a slider using
which image attributes can be con-
trolled. The control on the far left
selects the sky mode and sky colour.
The second control selects shadows and
ambient colour. The third modifies
haze amount and colour, and the fourth
modifies fog and fog colour.
Experiment with the others…

The next tool is the cloud fre-
quency, which is used to randomly
place clouds in the scene. By clicking
and dragging your mouse over this
field, you can alter the position of the
sun. Clicking on the small sphere at
the top left of this sphere will toggle

Creating 3D imagery wasn’t easy, we thought—until we discovered a software
called Bryce

Yes, you can actually create this in Bryce—
with considerable ease!

The section where
you control the
camera angle—
and more

The “Create” section using which you can place
different objects in the scene

The “Edit” section where you can edit the
objects placed in the scene

The great outdoors… create the environment
of your choice



89DIGIT NOVEMBER 2007

Digital Tools l Tips & Tricks

the sun to night mode; clicking on the
small rectangle at the bottom left of
the sphere will let you choose the
colour of the sun.

Quick Menus For Presets

Each of the toolbars we’ve talked about
has quick menus that can be accessed by
clicking on the small triangle at the
right (of Create, Edit, as well as Sky &
Fog). You can access preset objects in
here, or you can save your custom cre-
ations for later use. This makes sets of
theme scenes easier to create. For
example, say you’ve created a decent
model of a car. Instead of saving the
scene and repositioning it for every sub-
sequent picture with the car, you could
just save the object group under the user
section of the quick create window, and
place it in your scene in a jiffy.

Next is the much-used quick menu
for the Edit toolbar, which again lets
you choose from a selection of preset
textures and materials. Again, you can
also save user-created presets here.

Finally, the quick menu for the Sky &
Fog toolbar lets you create and save
custom skies. You may not feel the need
to make your own skies, but we recom-
mend that you do, because all the preset
skies leave the scene shrouded in black—
since the clouds block out the sun! If you
create it from scratch, you can let the
sun shine through.

The Animation Tool
Bryce comes with a complete animation
tool. The animation is controlled by
means of a small toolbar at the bottom
right of the window. Select File >
Animation Setup, and specify the
duration of the animation as well as the
frames per second. To animate a scene,
first create the first one (using the com-
posite image you’ve created) with the
slider at the 00.00 position. Now make
the animation toolbar completely vis-
ible by clicking on the Time /
Selection Palette Toggle (the
small sphere at the extreme bottom
right of the window). Then click the
little Plus beside the icon that looks like
a key. Next move the slider forward to a
desired time in the animation (the
measurement is in seconds). Then
change the location, shape, and texture
of objects in the first scene.

When you press Play, the objects
will get animated. The results are sim-
ilar to a 3D morph. (You can also curve
the objects’ paths.) That’s how you
make animations in shape and posi-
tion, but if you want to animate the
material of the object, there is the
material editor.

Select Objects > Edit
Material to open the Materials Lab.
Here, you can change aspects of the
object’s texture such as ambience, spec-
ularity, bumpiness, transparency,
reflection, refraction, and more, and
wrap textures around them. You will
notice the familiar animation control
at the bottom of the window, and it can
be used in the same way as before. You

can change the texture according to the
time slider and click the Plus icon
beside the key icon to add a key event.
When you render this animation, the
texture will change scene by scene
according to what you’ve done in the
animation.

Work better with Bryce
Texture Presets
Since textures are the basic building
blocks of materials, it would have been
great to have a preset menu for tex-
tures, like you have for materials. Well,
it is there, but hidden. To access it,
instead of simply clicking to get the tex-
ture list pop-up, hold down the [Shift]
key while clicking on the texture name
or the button beneath it. Now you can
view the graphical texture presets
dialog, which not only allows you easily
select textures, but also lets you import
and export textures.

Precise Placement Of The 
Sun and/or Moon
If you would like to place the sun
and/or the moon at a precise location
in the picture, you can do it this way:
first select the Sky&Fog Palette, hold
down [Ctrl] + [Alt], and double-click
on the sky sphere. This is to switch to
the sun/moon placement mode. Hold
down [Ctrl] + [Alt] and click into the
scene to place the sun at the cursor
position. To place the moon at the
cursor position, hold down [Ctrl] +
[Alt] + [Shift].

Negative Lights (Virtual 
Black Holes)
In Bryce, light can have a negative
value in the Light Editor. So while the
upper limit for this is 999 (very bright
light), the lower limit is -999. In the
latter case, the source will suck the sur-
roundings, creating an eerie, unreal
effect. As you might have guessed,
the shadows casted in this case will
be bright. Give it a try—amazement
guaranteed!

It’s Good Fun
Bryce 5.5 is a great 3D illustration and
rendering program, we think, and is
equally useful for the beginner as well
as the expert graphics artist. While it
does not offer advanced CAD-style 3D
creation or figurative animation capa-
bilities, it is an effective tool for
achieving attractive 3D scenery and
well-lit environments.

Go ahead, create a stunning
landscape, put it up as your wallpaper,
but don’t submit it to wallpaper sites.
It’s yours! 

jayesh_limaye@thinkdigit.com

You can choose different preset objects

You can choose presets of environments here

Choose a preset material for the scene

The Materials Lab: Lots of options to play with!
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Undo Levels 
The Undo tool is useful to fix any

errors that may have occurred while
working in Flash. Undo does take some
amount of system resources by keeping
track of all of the steps on the way.
Fortunately, you can set the limit on
how many undos one can execute. Go
to Edit > Preferences. Change the
values for the number of levels allowed
and click OK. 

Using Custom Workspaces 
Every individual has his or her

own way of working and arranging
tools. Every kind of workspace layout is
suitable for a particular kind of work.
Use the workspace tool to save any
workspace layout that you’ve made.
Click on Window > Workspace >
Save current to save a workspace. To
access the workspace at any time, click
on Window > Workspace and then
select your custom workspace. 

Importing Files In Library 
Importing images and other

media into the library in Flash is a
good practice. It’s easier to manage and
access files rather than directly
importing single files into the stage.
Click on File > Import > Import
to library. Now you can simply drag
and drop elements to your project and
at the same time you get a small
preview of the same.

Flash CS3 can also directly open up
Flash projects on sites instead of
downloading the files on your local
machine first and then opening them.
Click on File > Open from Site.

objects and the image will be applied
in place of color. You can also use 
this feature to have images as fill 
colors while creating new objects 
as well.

Video Encoding In Flash CS3 
Adobe Flash CS3 comes along with

a video encoding utility which is useful
in converting videos from almost every
format into Flash. Click on Adobe
Flash CS3 Video Encoder from the
Start Menu to start it. Click on Add to
add the videos for conversion. Click on

the Settings button to set parameters
for the conversion. You can quickly
choose from one of the readymade
presets available by selecting one from
the dropdown menu. Use the sliders to
set the region you want to encode and
set video and audio compression settings
using the Video and Audio tabs. Click
OK when done. Click Start Queue to
start the conversion process.

If you are planning to use a video in
the Flash project, you can also import a
video into Flash CS3 itself by clicking on
File > Import > Import Video. Here you
are asked to enter the location of the file
and where it would eventually be
deployed—web server, Flash Media Server,
etc. Clicking Next shows up a window
similar to that of the Flash CS3 Video
Encoder after which you’re asked to
select the template for the player.

Using The
History

Window
The History
feature, like in
Photoshop, keeps
track of all the
actions you’ve
executed in
Flash. At anytime
you wish, you
can jump back to
any step by
clicking on that

Choose the site on which you have the
project hosted. Enter the password.
Sites can be added by clicking on File
> Edit Sites.

Flash is the latest in the Adobe
family of products. Integration between
all the products has been built into it as
well. When you try and import a
Photoshop file (PSD), for example, you
will be displayed all the layers in the
file and you get to choose which ones
you want to import. You can import
each of the layers as separate keyframes
or layers.

Exporting Animations To
Movies 

Flash isn’t used for just Web content.
Flash is actually used by a lot of other
media like in TV advertising. Keeping that
in mind, the developers of Flash have
allowed the user to export animations as
standard video formats. When your
animation is ready, click on File >
Export > Export Movie. Choose the
format and enter a filename and location.
Click Save. Depending on the format, you
will be asked to set compression settings
and the codecs to be used.

Disabling The Launch Screen 
The Welcome or Launch screen is

the one that pops up as soon as you
start Flash CS3. It’s useful in loading up
different kinds of projects and
templates for platforms such as mobile
devices. Instead of having to select your
recently saved project every single time,
you can have your last open file load up
by itself. Go to Edit > Preferences.
Click on the On launch dropdown

menu and choose Last Documents
Open. If you want no files open, choose
No Document. Click OK to save.

Using Images Instead Of Colour
As Fill

Instead of having plain colours for
objects, you can make use of images
instead. Click on the Color window 
to the right, choose the Color tab.
Click the Type dropdown and choose
Bitmap. Click the Import button and
select the image you want to use. Now
use any of the painting tools—Brush
or the Paint Bucket Tool to color

The library is one click access to all the
required resources 

Flash CS3 comes with a standalone video
encoder 

The annoying Launch screen can be disabled if
required

The history window
gives a list of steps 
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step. The history window might not
always be visible but you can enable it by
clicking on the Window menu and then
on Other Panels > History.

Layers To Organise Elements
Using layers while designing is

useful in grouping elements and
making changes to them without any
confusion. To add new layers in Flash
CS3, right click on the timeline window
and click Insert Layer. 

Optimising Shapes
Every object in Flash has a number

of control points which give it a distinct
shape. Sometimes there can be too many
redundant points especially in cases
where you have used an eraser to erase
certain portions of an object. An
optimising feature is built into Flash CS3
which can be accessed by first clicking
on an object using the Selection tool.
Click on Modify > Shape >
Optimize. Set a level of smoothing and
click OK. If you find the object is losing
any serious characteristic shape, then
undo the move. It’s also a good habit to
use the Smooth and Straighten tools
from the Main toolbar. They can be used
to bring down the number of nodes or
make the objects smoother.

Spell Checking
The spell checking feature can

help those embarrassing slipups from
making their way on to the Internet.
Run the spell checking feature by
clicking on Text > Check
Spelling. You can setup the spell
checking feature much better and also

specify more dictionaries of other
languages and custom dictionaries of
your own by clicking on the Text menu
and then on Spelling Setup. 

Precision Designing
The Snapping, Ruler and Guides

feature are there to help create designs
accurately with ease. Snapping can be
set on by clicking on View >

Snapping. Click on Edit Snapping in
that sub-menu how you would like the
mouse pointer to snap to. The Ruler
feature is required to be able to set
guides which are similar to grids but
which can be modified and created as
per your needs. 

To create a new guide, click on View
> Rulers. Once the ruler has been

enabled, left click on one of the rulers
and drag it out where you want a guide
line to be set. Do the same steps with the
two rulers with as many guide lines as
you wish to create. If you wish to remove
a guide line, then click on the guide line
and drag it out of the window. Make
sure you have the snapping feature set to
Guides. Now when you move your mouse
pointer near a guide it should latch on
to them automatically.

Motion And Shape Tweening
The problem with animating one

frame after another is that it’s very slow
to create and it’s not perfect so the
resulting animation isn’t as smooth as
expected. There are two features called
motion tween and shape tween to
counter this problem.

The shape and motion tween feature
allow the user to set a starting and
ending position or shape for an object.
All the frames in between are generated
by Flash CS3. To do this, first create the
keyframes and place or modify the shape
of the objects. Then, click on Insert >
Timeline > Create Motion Tween
or Create Shape Tween if you
modified the shape.

MEDIA PLAYER
CLASSIC

Media Player Classic might look
like the old Microsoft Windows
Media Player 6, but is in fact

one of the most used media players
around. At around a megabyte in size,
the player is much more compact than
VLC or any of the others. Let’s look at
some of the most important and useful
features that also make MPC the player
of choice for many. We’ll be using the
last stable release—6.4.9.0. You can find
it in on one of our CDs or download it
for free from http://sourceforge.net/
projects/guliverkli/.

Make It Default
We’ve already told you why Media

Player Classic is so good. If you want to
have Media Player Classic as your

Flash’s Spell check is very customisable

MPC can be made to play back a few selected formats

Guides can make aligning and accurate placing
of objects very easy

Quick Shortcuts

Play [Enter]
Rewind [Ctrl] + [Alt] + [R]
Move ahead by 1 frame [.]
Move back by 1 frame [,]
Insert frame [F5]
Create blank keyframe [F6]
Convert to Keyframes [F7]
Clear keyframes [Shift] + [F6]
Tools               
Brush [B]
Pencil [Y]
Pen [P]
Paint Bucket Tool [K]
Eraser [E]
Insert Symbol [Ctrl] + [F8]

Move object forward [Ctrl] + [Up arrow]

Move object backward [Ctrl] + [Down 
arrow]

Send object to front [Ctrl] + [Shift + 
[Up arrow]

Send object to bottom [Ctrl] + [Shift] + 
[Down arrow]

View
Zoom in [Ctrl] + [+]
Zoom out [Ctrl] + [-]
Set 100% zoom [Ctrl] + [1] 
Show all [Ctrl] + [3]
Show grid [Ctrl] + [‘]
Show guide [Ctrl] + [;]

Enable/Disable Ruler [Ctrl] + [Alt] + 
[Shift] + [R]
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default video player, then click on View
> Options. Click Formats and from
the list, choose the formats you want
Media Player Classic to play for you. If
you want all videos to be played in MPC,
click the Video button to the bottom
right. Click OK.

Fixing Audio Delay
Sometimes we come across videos

with some delay in audio playback.
With High Definition focussed codec’s
like H.264, the lower end machines are
unable to cope, and a lot of audio delay
might be noticed. To compensate this
delay, click on View > Options. Click
on Internal Filters > Audio
Switcher. Enter a value for Audio

Shift in ms (milliseconds). Enter a
positive value to have the audio delayed
or a negative value to have the video
delayed. Click OK.

Boosting Audio
If the audio in a video isn’t loud

enough even after increasing all the
Windows volume control sliders to the
max, you can have Media Player Classic
boost it even further. Click on View >
Options. Click on Internal Filters
> Audio Switcher. Drag the boost
slider to increase the volume. Be aware
that these changes can create very
drastic changes in the volume so be
cautious while setting the amount of
amplification. Playing back any media
with normal amount of amplication
might result in very loud audio.

Control From A Web Interface
Media Player Classic has inbuilt

components that allow you to use a
remote control or even remote access it
through a Web browser. For Web-based
remote access go to View > Options
> Player > Web Interface. Click
on Listen on port to enable it. You
can change the port as well if you want
something easier to remember. Now
from a remote PC or even if you have a
mobile phone with access to your PC,

access http://YOUR.MACHINE
.IP:13579 (or whatever port you set)
through a web browser. A couple of
alternate Web interface links can also be

used that are present on that
page.

If you access MPC using a
remote, under Options click
on Keys and check the box
for WinLIRC and uICE—you
may require a
compliant remote
control though.

Saving
Screenshots

Ever had a moment on
video that you would
love to capture but
never knew how—
[Print Screen]
almost always results in

a black screen. MPC allows you to
capture single screenshots by
clicking on File > Save Image.
Select from BMP or JPG, enter a file
name and click Save. If you want
thumbnails from the entire video clip,
click File > Save Thumbnails. Enter
a filename and the number of rows and
columns you want. Click Save. An image
sheet with the thumbnails and
information on the video file will be saved.

Modes
When you aren’t watching a video in

full screen mode, you can have it running
as a window on one corner of your screen.
Pressing [2] disables the playback
progress bar. The best thing to do if you
want a video playing back while you’re
doing something else—say browsing or
chatting is to press [1]. This disables all
the title and menus bars and only shows
the video. Move the window to the position
of your choice and press [Ctrl] + [T].
This puts the MPC window on top of all
other applications. If the window is too big
in size, press [Alt] + [1] / [2] /
[3] / [4] for different preset sizes. You
can also set a custom size by clicking and
dragging the edges of the window. Pressing
[3] brings back the default MPC layout
and [Ctrl] + [T] again will disable
the On Top mode.

Playlist
When you’re viewing

more than one video, you
would want to be to queue up
videos. Press [Ctrl] + [7]
to enable the playlist or click
on View > Playlist. Drag
and drop videos from your
folders into this window. While
watching a video, pressing
[Page Up] loads the next
video in the playlist. [Page
Down] does the opposite. 

Subtitles
Media Player Classic has supported

subtitles for quite a while now. However,
there are a few changes to the renderer
that need to be done before you can
actually view them. Click on View >
Options. Choose DirectShow VMR7 or
VMR9 (renderless). Click OK and restart
Media Player Classic. Now open the movie
you want to watch. Click on File > Load

Subtitle and point it to the subtitle file
you have downloaded. Start the movie
and the subtitles will be displayed.

You can customise the way the
subtitles are rendered. Go to View >
Options > Subtitles > Default
Style. Here you can set the subtitles
settings such as the position, font, colour,
transparency, etc.

Fixing audio playback delay doesn’t need you to have media
authoring tools

MPC can be remotely accessed even through a mobile phone

Subtitles can be downloaded and viewed through Media
Player Classic

Quick Shortcuts

Play/Pause Spacebar
Stop .
Volume Up Up arrow
Volume Down Down arrow
Full Screen Alt + Enter
Mute Ctrl + M
Boss key B
Zoom In Numpad 9 (Page Up)
Zoom Out Numpad 1 (End)
Increase Width Numpad 6
Decrease Width Numpad 4
Increase Height Numpad 8
Decrease Height Numpad 2
Center view Ctrl + Numpad 5
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Yes, I Know, I Know!
I often get the low disk notification message on
one of my drives. Since I am all too aware that

the drive is full, it’s a major irritant!
Durgesh Sharma

Open the Registry Editor. Go to the key
HKEY_CURRENT_USER\Software\

Microsoft\Windows\CurrentVersion\Poli

cies\Explorer and look at the DWORD value
NoLowDiskSpaceChecks. (Create it if it doesn’t
exist.) Set its value to 1. Exit the Registry Editor
and reboot for the change to take effect.

Coding The Load
When I try to install Windows XP on my PC with
Windows 98, I get the following error:
NTLDR is missing
Press any key to restart

Shamit Rahi

This problem can occur if a current Windows
ME or 9x installation was cloned from a hard

drive with a geometry different from that of your
current drive. This results in a mismatch of writ-
ten values, which is ignored in Windows 9x and
ME; Windows XP/200x/Vista have an issue with
this, though. Still, this can be corrected:

Restart the computer using a Windows 98
startup disk.
Make a backup copy of the Msdos.sys file in
the root directory of your system drive. To do
this, type in the following commands at a
command prompt:

attrib -h -r -s c:\msdos.sys
rename msdos.sys *.bak

At a command prompt, type sys c: to
rewrite the Windows 98 startup code with
accurate information.
Restart into Windows 98, and then try to
install or upgrade to XP.

Brand Recall!
The PC I bought has Internet Explorer and
Windows Media Player with the title bar

displaying the name of my system integrator. I want
to get rid of this.

Shalini Desai

Launch the Registry Editor and go to the key
HKEY_CURRENT_USER\Software\

Microsoft\Internet Explorer\Main (for
Internet Explorer). Modify or create the String
Value called Window Title, and give it a value
equal to what you want it to be—say, your name.
If you just remove it, it’ll default to “Microsoft
Internet Explorer”, getting rid of the name of
your system integrator.

For WMP, go to HKEY_CURRENT_USER\
Software\Policies\Microsoft. Click on the
key WindowsMediaPlayer. Modify the String
Value TitleBar (or remove it to get back to
the default setting).

The Famous Disappearing Act
My XP Taskbar has disappeared. Help!

Vishwas Rele

This can happen if the Windows settings
for a user account get corrupted, so you’ll

need to start your computer in Safe Mode.
Select the Administrator and enter the admin-
istrator password. Click Yes to close the
message that states that Windows is running
in Safe mode. Right-click My Computer and
select Manage. In the list called Computer
Management (Local), expand Local Users and
Groups. Right-click the Users folder, then
select New User. Type in the username and
password where needed, then confirm the
password. Untick the User must change pass-
word at next logon checkbox. Click Create,
then Close, and then quit the Computer
Management window. Restart Windows
normally and log on as the new user. The
taskbar should reappear.

Switch Glitch
My computer shows my partitions as follows: C:
Seagate primary; D: Samsung primary; E: and F:

Seagate extended; G:, H: and I: Samsung extended; J:
CD-ROM. I have set up the Seagate as the primary
master and the Samsung as the primary slave. I have
installed Windows 98 on C: and XP on E:. When I
removed my second hard disk, I couldn’t boot into XP,
as the E drive swapped with D. What should I do?

Chinmay Godbole

Your Questions, Our Answers

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

Questionable
licenses and truant
uninstallers—all
dealt with right
here!

Illustrations Harsho Mohan Chattoraj
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This happens because the settings in the
boot.ini file are no longer correct, now that

you have removed the Samsung drive. What you
can do is edit boot.ini. To do this in Windows 98,
at a command prompt, type in CD\ and press
[Enter]. Now type Edit boot.ini and press
[Enter]. This will open the boot.ini file, which
will display partition information. Here, you
need to locate the Windows XP partition string.
It looks like this:

multi(0)disk(0)rdisk(0)parti-
tion(1)\windows=”Microsoft Windows XP
Professional” /fastdetect.

Take the digit next to the partition tag;
subtract 1 from it, and save the file. You should
now be able to boot into XP.

My Computer Boasts Of No Floppy
I run Windows 2000 Professional. Recently, my
floppy drive stopped showing up in My

Computer. All the other drives display correctly.
Under Floppy disk controllers, in the Computer
Management console, it says that the drive is work-
ing properly. What is the problem?

Vaibhav Shinde

The BIOS doesn’t seem to detect your floppy
drive. Check the CMOS settings and see if

the floppy drive is visible. Ensure that the CMOS
is set to “Halt on all errors” and also check that
the BIOS’ “Report the floppy drive to the OS”
setting is enabled. Another reason could be
drive letter conflicts caused by software such as
RAMdisk. The TweakUI PowerToy, available from
www.microsoft.com /windowsxp/down-
loads/powertoys/xppowertoys.mspx, can
also cause drive letters to be hidden in Windows

Explorer and My Computer. If you have it
installed, go to the Control Panel and double-
click on TweakUI. In the My Computer tab,
select the checkboxes of the drives shown as
hidden. Click Close and restart.

Beating The Heat
I have a Celeron 1.2 GHz, a Mercury 815e
motherboard, an 80 GB hard drive, and 256

MB of SD RAM. The problem is that my heat sink
gets really hot (I can feel really hot air blowing
towards my hand when I place it next to the heat
sink), and as a result, the PC hangs or restarts.
The CPU fan is working fine, but the BIOS setting
doesn’t show its rpm. I have another case fan,
and the BIOS reports its speed. Is there a prob-
lem with my motherboard?

Piyush Lore

You first need to make sure the CPU fan is
working properly. Open your cabinet and

make sure the fan rotates easily. Make sure the
heat sink and fan blades are free from dust.
Use a paint brush to clean these. If necessary,
remove the fan and heat sink, clean them thor-
oughly, re-apply thermal paste and fix them
back on to the CPU. To make sure it's a heating
problem, you can try running the CPU with
the same heat sink and fan on another moth-
erboard. Another factor due to which the BIOS
may not be reporting the rpm of the CPU fan
correctly could be the CPU fan cable not being
connected to the proper connector on the
motherboard. Check for this. If all is in order
and you still have an issue, you will have to opt
for an external CPU fan kit, which will cost
between Rs 200 and 300.

Anti-Bogus-Anti
My computer is infected with WinAntivirus Pro 2007
and PestCapture, which I had installed thinking they

were anti-virus and anti-spyware programs. I later learnt
about them being bogus… how do I remove them?

N Venugopal

Download these programs to your desktop and install
them: SmitRem from http://noahdfear.geekstogo.com,

SmitFraudFix from http://siri.geekstogo.com/SmitfraudFix .php,
RogueRemover from www.majorgeeks.com/ RogueRemover
_d5360.html, HijackThis from www.merijn.org/files/hijackthis.
zip, and CCleaner from www.ccleaner.com. 

That done, reboot into Safe Mode. Open the SmitRem
folder and double-click RunThis.bat to start the
SmitRem removal procedure. Next, open SmitFraudFix
and choose to search (option 1) and clean (option 2) and
run a full system scan to remove anything it finds. Then,
run RogueRemover.
While still in Safe
Mode, run
CCleaner. Analyse
and clean the files
it finds, then click
on the Issues
button and Scan
and Fix any Registry
issues CCleaner
discovers. Run both

the Registry Scanner and the File Analyzer
until nothing more is found.

Run Hijackthis and Remove any leftover
issues. Do not delete anything with
Hijackthis unless you are absolutely sure what the file is
and what it does. For items in the Hijackthis log like the
following, which will not get deleted manually, use
KillBox (killbox.clickhereformoreinfo. com) to browse to the
location of the file and delete it or delete it on reboot.
Items that are impossible to remove unless using Killbox
usually show up in the “20” section of Hijackthis, for
example:

O20—Winlogon Notify: msupdate—
C:\WINDOWS\SYSTEM32\msupdate32.dll

O20—Winlogon Notify: winrir32—
C:\WINDOWS\SYSTEM32\winrir32.dll

O20—Winlogon Notify: dvd4free—
C:\WINDOWS\SYSTEM32\dvd4free.dll

Reboot into normal mode. Scan your computer using
online virus checkers such as those at www.kaspersky.com/
virusscanner and  http://security.norton.com/sscv6/default.asp?
productid=sarc&langid=ie&venid=sym. Also download, install
and thoroughly scan your system using a spyware
removal tool such as Spybot Search & Destroy from
http://spybot.clickhereformoreinfo.com.

As a matter of general practice, always install and use
an anti-virus program, update it regularly, and never
disable it (even when certain programs ask you to do so),
especially when you are online.

Question 

of the

Month
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Use GoogleTalk To Chat With Yahoo! And MSN Buddies

Jayesh Limaye

With loads of online buddies from all
over the planet, all of us have been
forced to use either multiple instant
messengers or unified clients like
Pidgin (formerly GAIM) to keep in touch
with everyone. With MSN and Yahoo!
joining hands, some of our woes were
reduced. However, with the introduc-
tion of GoogleTalk, and its subsequent
jump in popularity, we find ourselves
back to square one. What’s more, you
can chat using GoogleTalk right from
your browser, when you access your
GMail account. 

Recently, GoogleTalk opened up
their chat protocol to Jabber networks,
which now makes it possible for

GoogleTalk users to chat
with their buddies on
AIM, MSN, Yahoo and
ICQ. Here is how it can be
achieved.

The resources
required for this are Psi—
a free Jabber client, which
can be downloaded from
http://psi-im.org, and
GoogleTalk, which can be
downloaded from
http://talk.google.com.
Install these two chat
clients and proceed to the
next step.

Launch Psi and in
the “Add Account”
window (which will

launch if you
are using Psi for
the first time),
enter Google
Talk as the
Name and do
not check the

box next to
Register new
account. Click

Add. Alternatively if you have already
been using Psi, you can right-click on
the Psi icon in the System Tray, go to
Psi and select Account Setup. The
Account Properties window will show
up and here you should enter your
full Gmail address including
“@gmail.com” into the Jabber ID
field. Tick the “Automatically connect
on Startup” and “Automatically recon-
nect if disconnected” boxes.

Click on the Connection tab. Check
Use SSL encryption (to server). The Port
field will automatically change to 5223,
which is normal.  Check the “Ignore
SSL warnings”, “Allow Plaintext
Login”, “Send Keep-alive pack-
ets (for NAT timeouts)” and
“Manually Specify Server
Host/Port:” boxes. Enter
“talk.google.com” in the Host field
and leave the port as 5223. If you have
trouble connecting, use port 443 instead.

To get
online, just
right-click on
your account
name in the
main window,
go to Status
> Online.
Now right-
click on the
account name
again and
click Service
Discovery.
You now need to find a Jabber transport
server that will help communicate
between GoogleTalk and non-GoogleTalk
chat applications. A good place to start
this search is The XMPP Federation at
https://www.xmpp.net/ servers and Open
Jabber Servers at
http://www.jabber.org/user/publicservers.
shtml. We used the server jwchat.org (or
you can use talkonaut.com), since it had
transport servers for AIM, ICQ, Yahoo as
well as MSN. Enter this name into the
Address field (initially containing the
name gmail.com) and click on Browse.
You will see a list of transport servers

being populated in the box below.
To set up your IM account, right-click

on one of these servers and select
Register. Enter your user name and pass-
word for the service selected and click
Register. Psi will ask you to confirm all of
your newly transported contacts in your
Google Talk account. After this is done,
they’ll all be automatically available
through your Google Talk account. You
will even be able to add buddies from
that service, right from your GoogleTalk
client. To confirm this, open GoogleTalk
and you will find all the contacts from
the other service inside GoogleTalk
buddies list. To add a friend from
another service, just make sure that you
follow the format screenname@trans-
port_ server_name.dns_name—if
the Yahoo ID of your buddy is testacc@
yahoo.com, and jwchat.org is the
transport server, you should add the
contact from within GoogleTalk as
testacc@yahoo.jwchat.org.

There have been reported cases of
unreliability of quite a few transport
servers, but we found that two
mentioned above are quite stable. You
should also know that when you use a
transport client, you trust your informa-
tion to a third party server, which you
may not like if you are very particular
about your privacy.

jayesh_limaye@thinkdigit.com

Tired of having to use two messengers to chat with all your friends? Here’s how you can
convert GoogleTalk into one unified chat client

Subscribe to RemoteCalendars

Register other IM services as well

Google Talk Account setup properties

Select Account Setup in Psi

Add your Google Talk account

Connection properties
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A Sound Solution
I have a Pinnacle PCTV Rave TV-Tuner, and my
computer has Windows XP Pro SP2. I want to

record TV programs in WMV, DivX, as well as the
MPEG-2 formats, but the software provided with the
card does not support it. I have tried to use third-
party PVR programs such as InterVideo WinDVR, but
it does not capture sound.

Ajay Tiwari

The Pinnacle PCTV Rave TV Tuner encodes
TV audio right on the board, and there is

no loop-through cable that goes to the line-in
of the sound board, as is usually the case with
most TV-Tuners. That’s why the audio does not
work with InterVideo WinDVR, since it does
not feature an option to use internal TV audio.
There are some programs such as ChrisTV
from www.chris-tv.com and BeyondTV from
www.snapstream.com that support such TV-
Tuners (with on-board audio chips) and also
allow you to capture in the WMV, DivX, and
MPEG-2 formats.

Anti vs. Anti!
I had installed McAfee AntiVirus from your CD
for a trial run, then uninstalled it and returned

to my older Norton AntiVirus. The problem is that
Windows Security Center says I have the above two
antivirus programs running.

Paramjeet Singh
Right-click on My Computer and click
Manage. Expand Services and Applications

and click on Services. Find the Windows
Management Instrumentation service, right-click
it, and choose Stop. Open My Computer, then go
to (assuming Windows is installed on C)
C:\Windows\System32\WBEM\Repository.
Delete it. Return to the Windows services screen;
find Windows Management Instrumentation,
right-click on it, and choose Start. Restarting this
service will rebuild the repository folder infor-
mation. Restart your computer. Windows
Security Center should be fine.

Video’s Not On The Cards
I have an NVIDIA GeForce FX 5200 graphics
card. The problem is that the display goes

blank after entering Windows, even when I have
installed the official WHQL drivers. When I booted
using my onboard graphics, I got a message that
read something like "the display device driver was
unable to complete a drawing operation. Please
check for a driver update." I downloaded the latest
drivers from NVIDIA, but the problem persists. My
PC configuration is an AMD Athlon XP 2100+ CPU
and 512 MB DDR RAM on an ASUS A7N266VM moth-
erboard and I have Windows XP Professional SP2.

Vinay Chaudhary

A device driver conflict seems to be at play.
Here's what you can do: Boot your system

while using the onboard video card, then unin-
stall all the video card drivers. If possible, use
System Restore to get back to a time when the
computer was working fine, and then uninstall
the display drivers. Now, reboot and get to the
BIOS. Go to the Advanced Options, and look for
the PCI display menu. Under VGA BIOS, change

the adapter to AGP VGA. Save the settings, shut
down the computer, and install the new video
card. Reboot and install the display drivers. Your
issue should be resolved. Alternatively, start the
machine in Safe Mode; right-click on My
Computer and select Properties > Hardware >
Device Manager and expand the Display adapters
option. Right-click on each entry under display
adapters, and select Uninstall. It is imperative
that you install only the latest drivers for the
motherboard, and also to ensure that your BIOS
is up to date. Check at the motherboard manu-
facturer's Web site for this.

The Un-dead!
I uninstalled a program, but the Add/Remove
Programs applet still shows the entry for it. So

how do I get rid of it?
Akhilesh Srivastav

Open the Registry Editor and navigate to
HKEY_LOCAL_MACHINE\SOFTWARE\

Microsoft\Windows\CurrentVersion\Unin
stall. You can find the entries related to the
uninstalled program in the right pane. Just
delete them.

Installing An Installer!
I have Windows XP. I get the Windows
Update Error 0x80070420 while trying to

update Windows.
Irfan Sheikh

First, Check to see if you have Windows
Installer 3.1 installed: go to Control Panel

> Add/Remove Programs, search the list of
programs for Windows Installer 3.1. If you find it
there, uninstall it, then reboot and install the
program; if it’s not there, you’re fine; just install
it. The program (Windows Installer 3.1) is at
http://www.microsoft.com/downloads/details.aspx?fa
m i l y i d = 8 8 9 4 8 2 f c - 5 f 5 6 - 4 a 3 8 - b 8 3 8 -
de776fd4138c&displaylang=en. Reboot and then try
and do the Windows Update. 
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Sweet Memories

DDR 400, 3-3-3-8 should suffice. (Lower timings
are better.)

I nowadays recommend 2 GB of memory.
Two reasons: your PC will speed up in general,
and Vista—which is a memory hog. And you
don’t want to bottleneck a good processor and
decent graphics card, do you? RAM is the
expressway in your PC and handles data traffic—
more is always good, although as of now you
won’t see any significant gains with more than
3 GB, and 2 GB is the sweet spot for Windows XP.

I was searching for a 2 GB kit for a friend
who’s upgrading from a 1 GB kit. The most
common brands for DDR2 memory available are
Transcend and Kingston. 1 GB of Kingston DDR2
667 MHz memory costs Rs 1,450, and Transcend
is some 100 bucks more. Both manufacturers
offer “lifetime” warranties, which equates to five
years in the case of both vendors. This is a three-
year replacement warranty plus a two year
repair warranty. A 2 GB kit will cost you around
2,750 bucks (Transcend has a 2 x 1 GB kit). The
slightly lower price for a 2 GB kit means you’re
getting more value for money for buying more
memory! Corsair value RAM is also available at
Rs 1,700 per GB—dual channel kits are just shy of
the 3,500-rupee mark. Dynet is one of the locally-
available brands, and is available for as little as
Rs 1,300 per GB. Digital, another local brand
retails at Rs 1,250 per GB—terrific value for
money, but I’d rather pay 300 bucks more for
blissful peace of mind.

DDR2 800 MHz is a little more expensive, but
worth it if you’re going for faster components. 1
GB of DDR2 800 RAM will cost you around 2,000
bucks—both Transcend and Kingston are avail-
able for nearly the same price. What’s worth a
mention is, the price fluctuates as well—
for example, 1 GB of Transcend DDR667 was
Rs 1,650 last week, this week it was 1,450. It

could go up next week!
DDR3 is available, too, but prices are so

restrictive at the moment that you’re
better off with faster DDR2. I don’t
expect DDR3 to make big inroads into
DDR2, at least for another year. Only
one big vendor had stocks of DDR3
from Corsair, and the 2 GB dual-
channel kit (two sticks of 1600 MHz
memory) was priced at Rs 23,000. A
serious premium which I think is
totally uncalled for.

I ended up buying a 2 GB Transcend
kit (DDR2 667) for 2,750 bucks—a superb

deal for my friend who had paid 3,500
bucks last year for his 1 GB kit! 

Motherboards and Processors this month!
There’s another component that works
as hard as your processor most of the

time—and is even more important as a limiting
factor a.k.a. bottleneck to performance. Yes, I’m
talking about good old Random Access Memory.

There’s only one real memory standard today
and that’s DDR2. DDR is officially dead, and
nobody is using it for new PCs, not even value
PCs. DDR2 had initial teething issues with per-
formance—mainly due to higher latencies, but
all those have been ironed out, and the sheer
bandwidth DDR2 offers over DDR is significant.
DDR is still available in the market—but it’s
mostly older stock, since manufacturers have
stopped making it. As a result, DDR memory is
very expensive now—and those who need it for
older systems will face the simple market reality
of demand and supply. I found DDR memory at
prices roughly twice that of DDR2 in Lamington
Road, and the prices fluctuated from dealer to
dealer—although many dealers flatly stated they
didn’t stock DDR any more.

DDR2 is available in mainly two speed
options—DDR2 667 and DDR2 800 MHz frequen-
cies. The higher frequencies (1000 and 1066 MHz)
are very expensive, and do not justify the pre-
mium. What I came across in shops was mostly
value RAM. This is basically RAM based on
cheaper memory chips, the characteristic being
slower speeds and higher latencies. Enthusiast
memory will have higher speeds at lower laten-
cies but typically requires higher voltages to
operate (1.8V is the default for DDR2),
which means your board should sup-
port moderate overvolting.

Generally, higher-performance
(read enthusiast) memory—which per-
forms better with demanding appli-
cations—typically has heat spreaders
on the memory strip. I must caution
all our readers: some manufactures
are resorting to the cheap tactic of
putting attractive alu-
minium heatsinks on el
cheapo value memory, and
vendors call this “high per-
formance” memory, and
you’ll subsequently be
charged 500 to a thousand
bucks more for nothing
more than eye-candy! Look at
the latency figures to base a
purchase decision on, and not attractive
heatsinks. If you’re buying DDR2 667 MHz,
look for latency figures of 4-4-4-12. For DDR2
800, timings should be 5-5-5-15 at the most;
anything more and your memory is going
to be slow irrespective of the frequency. For

Agent 001

Illustration Chaitanya Surpur

Agent001 recounts his recent memory shopping spree
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Widening Horizons

I want to watch HD movies, and I have a maximum
budget of Rs 15,000 for a monitor. What do you

suggest? What resolution? What does “diagonal dot
pitch” mean?

Viral

I’d suggest you opt for a 22-inch LCD mon-
itor, which will be very suitable for

widescreen applications such as HD movies. A typ-
ical 22-incher has a native resolution of 1680 x
1050 pixels (an aspect ratio of 16:10).

Dot pitch represents the distance in millime-
tres between two adjacent phosphor dots in the
case of a CRT or pixel cells in the case of an LCD.
The smaller this value the better, because there
will be more dots in a given area—leading to a
crisper image. For a 19-inch monitor a dot pitch
of .26 mm is usually the norm, although this
figure goes up for larger monitors. 

A Burning Question
Please suggest a DVD-Writer for me. I currently
have a Sony DRU-710A. I bought it back in Jan-

uary 2005; now, after extensive use, it seems to have
gone kaput—it fails to read and write properly.

Abhirup Chaudhuri

All DVD-Writers are pretty much similarly-
priced—I don’t think a couple of hundred

bucks will be a big deal for anyone. I’d suggest Lite-
On’s latest 20x DVD burner—the LH-20A1P—which
should be priced at about Rs 1,750. If you want a
Sony burner, the Sony DRU-830a is available,
priced at Rs 1,650.

A Laptop—Specs Laid Down
I’d like to purchase a laptop for personal use. I
want a good graphics solution and a 14.1-inch

screen. I am also looking at 2 GB of memory. What are
my options?

S Mitra

I’d suggest the Dell Inspiron 1420 series. It
has a 14.1-inch screen and offers a Core 2

Duo processor and 2 GB of memory. Also optional
is the GeForce 8400GS graphics solution, which is
decent. The best part is, you can configure the
laptop to your specific needs—of course, this scales
with price. The starting price is around Rs 40,000.

Nokia For Signal Quality?
I want to buy a cell phone for between Rs 13 and
14K. What’s most important is signal quality and

connectivity with a laptop (Internet via GPRS). Media
playback and camera is not of primary importance, but
of course, it wouldn’t hurt! I’d prefer a Nokia. I could go
with another brand, but it should have more features
than Nokia.

Anurag

In case you’re absolutely set on Nokia, I’d
recommend the N70ME—about Rs 11,000.

The N73ME is a lot more future-proof as far as
GPRS connectivity goes, and will cost approxi-
mately Rs 15,000. Note that these are street prices,

and that the N73 (the non-music edition) will be
around 1,500 bucks cheaper.

One Upgrade Forces Another…
I bought a new GeForce PCI-E 8600 GTS graphics
card, but later realised that my motherboard does

not support PCI-E. I now want to buy a new mother-
board that supports PCI-E, DDR2, and Core 2 Duo. I
have a budget of Rs 18,000 for processor, mother-
board, and a GB of RAM. So what would be a good buy?

Harshit Syal

Take a look at Abit’s IP35, I’d say. This
board should be priced at Rs 8,500. It’s

based on Intel’s latest P35 chipset, and will sup-
port the upcoming Penryn family of processors.
For the processor, I’d say a Core 2 Duo E6550 (2.33
GHz)—around Rs 7,500. For the RAM, I’d suggest 2
GB in lieu of 1 GB—the performance boost is
worth the price. 2 GB of DDR2 800 MHz memory
would cost you Rs 4,500, while DDR2 667 MHz
would be a thousand rupees cheaper.

It’s Touch Vs. Tap
What would be a good PDA for Rs 20,000? I’ve
homed in on two candidates. One is the Dopod

HTC Touch, and the other is the O2 XDA Atom Exec.
Which one would I should buy, with my preference
being finger touch rather than a stylus?

Rohan Mathew Chungathil

The Dopod HTC Touch allows you to
finger-swipe, similar to the iPhone. How-

ever, it’s definitely not finger-operable for typing,
jotting down notes, etc. In fact, no PDA is. Besides
the touch feature, I found the O2 XDA Atom very
feature-rich—more so than the Touch, which is
definitely more gimmicky. In terms of operation,
they’re both pretty much the same. If you’re keen
on the finger swipe feature, then go with the
Touch, else stick with the XDA Atom.

Get With The Times!
I am buying a PC with the following configuration:
Intel Core 2 Duo X6800, Intel original mother-

board D975 XBX 2, 2 GB DDR 2 667, ASUS EN8600GT.
My budget is Rs 65,000—70,000. What cooling

system and PSU should I opt for? Please also say if I’m
getting the best of my budget, or if some changes
should be made to the configuration. This will be used
for gaming on Windows XP SP2.

Jyotirmoy

You’re buying old hardware. I wouldn’t rec-
ommend the 975X chipset to anyone, so

we’ve excluded that chipset from our mother-
board test. For a budget of 65,000—70,000, I’d rec-
ommend getting a motherboard on the lines of
an ASUS P5K Deluxe, which will cost about Rs
14,000. Instead of the X6800, opt for the E6850,
which is slightly faster and runs cooler and, not to
mention, is much cheaper. The money you save on
the processor can be used for a better graphics
card, say an 8800GTS 640 MB—look for brands such
as Leadtek and XFX. I should also say that 2 GB of
RAM is good enough for gaming.

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related
questions in this space.

Ask Away!

Ask Agent 001
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Wi-Fi Access Points
Linksys WAP54G

Great performance
None in particular

Contact Ingram Micro India Pvt Ltd
Phone 9323112279
E-mail sunil.z@ingrammicro.co.in
Price Rs 3,816

5.1 Speaker Sets
Artis S6600R/FM

Good performance, radio
None in particular 

Contact Kunhar Peripherals Pvt Ltd
Phone 022-66345758
E-mail mail@kunhar.com
Price Rs 8,500

Processors
Intel QX6850 Core 2 Extreme

Extreme performance
Expensive
Contact Intel Tech India Pvt Ltd
Phone 9833823474
E-mail saranya.rustagi@intel.com
Price Rs 52,000

Projectors
Acer PD726W

Great overall performance
No remote sensor at rear

Contact Acer India Pvt Ltd
Phone 9880544226
E-mail alankar_s@acer.co.in
Price Rs 1,35,000

Digital Cameras
(High-End)
Canon PowerShot A570 IS

Good overall performance
Lacking in macro 
performance
Contact Canon India Pvt Ltd
Phone 1800-345-33-66
E-mail info@canon.co.in
Price Rs 13,995

Digital Cameras
(High-End)
TECH-COM DSC-524X PLUS

Good features and 
performance
Average macro performance

Contact Shree Sagarmatha
Distributors Pvt. Ltd.

Phone 011-26428541 
E-mail techcom@airtelbroad-

band.in   
Price Rs 5,250

LCD Monitors (19-inch)
AOC 197S

Good looks and performance
Gloss finish catches smudges

Contact AOC India
Phone 1800-425-4318
E-mail info@in.aocmonitor.com
Price Rs 12,000

LCD Monitors (17-inch)
AOC 177V

Good performance
None in particular

Contact AOC India
Phone 1800 425 4318
E-mail info@in.aocmonitor.com
Price Rs 9,800

MP3 Players up to Rs 4,000
MobiBlu DAH-2100

Good performer
Tiny screen for video

Contact J.J.Mehta & Sons
Phone 022-24306356
E-mail   info@jjmehta.com
Price Rs 4,000

MP3 Players up to Rs 10,000
Sandisk Sansa e250

Good performance, 
feature-rich
Tacky scroll wheel

Contact Rashi Peripherals Pvt Ltd
Phone 022-67090909
E-mail navinderc@

rptechindia.com
Price Rs 8,150

Internal DVD-Writers
Lite-On LH-20A1P

Fast performance, 20x 
writing to DVD+R and DVD-R 
None in particular

ContactMediatech India
Distribution Pvt Ltd

Phone 022-26361111
E-mail digit@ 

mediatechindia.com
Price Rs 1,700

Internal SATA Hard Drives
WD Caviar SE16 WD5000AAKS

Fast transfer speeds
None in particular

Contact Champion Computers 
Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 7,500

Graphics Cards (High-End) 
Galaxy GF8800Ultra

Sheer performance
Heats up
Contact Technology and Gadgets
Phone 022-23823331
Web site
www.technologyandgadgets.com
Price Rs 35,000

Graphics Cards (Mid-range) 
ASUS EN8600GT 

Well priced, fast
None in particular
Contact Asus Technology Pvt Ltd
Phone 022-67668800
Web site http://in.asus.com 
Price Rs 8,800

External Portable Hard
Drives
WD Passport Portable (Black)

Excellent performance, good
value
None in particular
Contact Champion Computers 

Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 6,500

Internal SATA Hard Drives
WD Caviar SE16 WD3200AAKS

Value for money, 
performance
None in particular

Contact Champion Computers 
Pvt Ltd

Phone 011-26214751
Web site www.championindia.com
Price Rs 4,500

The best products tested so far in different 
hardware and software categoriesThe A-List
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Multimedia Phones
Rs 12,501 to Rs 20,000
Sony Ericsson CyberShot K790i

Great all round
Cam slider flimsy
Contact Sony Ericsson Mobile 

Comm. India Pvt Ltd
Web site www.sonyericsson.com
Price Rs 12,500/-

Up to 12,500
Nokia 6300

Great screen, build
Hard joystick

Contact Nokia India
Web site www.nokia.com
Price Rs 11,489

Intel P35-based
Motherboards
ASUS P5K Premium

Excellent enthusiast solution
Expensive

Contact ASUS Technology Pvt Ltd
Phone 022–67668800 
E-mail media_india@asus.com
Price Rs 15,870

Intel Integrated Graphics
Motherboards
Gigabyte GA-G33-DS3R

Very good layout
Expensive 

Contact Gigabyte Tech India Ltd 
Phone 022-30616666
E-mail sales@gigabyte.in
Price Rs 9,500

Desktop PCs
Sahara 20CK16

Great performer
Slightly bulky

Contact Sahara Computers & 
Electronics Ltd

Phone 0120 - 4397777 
E-mail info@saharacomputers.co.in
Price Rs 40,000

AMD AM2 Motherboards
Gigabyte GA-MA69G-S3H

Well built, feature rich
None in particular

Contact Gigabyte Tech India Ltd 
Phone 022-30616666
E-mail sales@gigabyte.in
Price Rs 6,900

Home Inkjet MFDs
Canon PIXMA MP160

Good performance
No memory card reader 

Contact Canon India Pvt Ltd
Phone 1800-345-33-66
E-mail info@canon.co.in
Price Rs 5,995

Mono Laser MFDs
Brother MFC-7420

Great cost per page, fax
No Ethernet Port 

Contact Brother International India
Pvt Ltd 

Phone 1800 222 422
E-mail customercare@brother.in
Price Rs 18,000

PCI TV-Tuners
Leadtek Winfast PVR2000

Excellent video quality and 
software
Expensive

Contact Topnotch Infotronix (India)
Pvt Ltd

Phone 044-42042565
E-mail naqui@zebronics.net
Price Rs 5,500

Mono Laser Printers
HP LaserJet 1020

Good combination of speed,   
print quality, and warranty
A bit slow in comparison to
others

Contact Hewlett-Packard India 
Sales Pvt Ltd 

Phone 0124-2566111
E-mail kakuni.mahto@hp.com  
Price Rs 6,999

Mice
Logitech MX Revolution

Has a flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone 022-26571160
E-mail response@logitech.com
Price Rs 8,000

Performance Laptops
HP DV6226tx

Funky Looker, features 
Needs better graphics

Contact Hewlett-Packard India
Phone 0124-2838700
E-mail tapoti-t.tipnis@hp.com
Price Rs 56,990

73

Up to 12,500
Samsung SGH-E840

Great build, slider
Keypad tactility

Contact Samsung Telecomm.
India

Web site in.samsungmobile.com  
Price Rs 11,499

PDA Phones Above Rs.25K
Nokia Communicator E90

Extremely powerful
Heavy, bulky

Contact Nokia India 
Web site: www.nokia.com
Price Rs 40,499

Office Inkjet MFDs
HP Photosmart C4188 All-in-
One

Good print quality
No fax

Contact HP India Sales Pvt.
Ltd.

Phone 0124-2566111
E-mail kakuni.mahto@hp.com
Price Rs 7,999

PC Webcams 
Logitech QuickCam IM

Strong performer
Manual focus

Contact Compuage Infocom Ltd
Phone 022 - 65297356
E-mail india_getcreative 

@ctl.creative.com
Price Rs 1,995
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Robert Sovereign-Smith

Whatever the nature of your business,
whether you have a three person
team or 30,000, if you’ve got comput-

ers in your office, you’re going to need a proxy
server. Now larger businesses need something
that can handle much more traffic, and we’ve
earlier recommended Squid on a Linux server
for them. However, smaller businesses
(between 2 and 30 computers) might not have
the free hardware or expertise to install and
maintain Squid.

Most often, SoHo businesses need some-
thing Windows-based—a tool that’s easily
installed and just as easy to maintain. This is
because most SoHo businesses cannot spare a
computer, so the proxy server machine is quite
simply just another computer on the network
that the person with the Internet connection
uses. Now Windows can also share a connec-
tion over the Network, but it does nothing else.
The Windows Internet Connection Sharing
Wizard will do nothing more than give all net-
work computers access to your Net pipe, which
will result in slow surfing speeds for everyone. 

Proxy server software do not just share Net
connections; they also cache files to save band-
width, act as a firewall, put restrictions on con-
tent, and much more. So how does one go
about choosing a good proxy server? The first
step is to look for the following features:

The ability to run as a service: You don’t
want everyone in your office getting dis-
connected from the Net just because some-
one accidentally closed the proxy server
window.
Caching: A proxy server that doesn’t cache
is just useless; caching helps save bandwidth
and speed up the browsing experience. 

User lists: In order to make sure that no
unauthorised people are using your Internet
connection, you need to be able to give access
to only specified users, with authentication.
Logging: You need to keep an eye on what
people in your company are using the Net for;
to make sure they aren’t misusing privileges.
Bandwidth controls and monitors: These
will help ensure that people don’t overuse

Business
Digital

How Technology Can Help Your Organisation

108 Get Noticed, 
Get Clicked 112 Bookworm Or

Veteran?

Learning
To ShareYour Internet connection,

that is...

Smart SoHo

Adding users to Proxy+

The Access List lets you control your proxy server



104 DIGIT NOVEMBER 2007

Digital Business l Smart SoHo

bandwidth, and that will keep your bills in
check. Some software will also let you set
maximum speeds per client, or cut-off
points to stop Net access when a user reach-
es A prescribed bandwidth limit.

Of course, software that offer all of the
above or more will cost a bundle, or will they?

PROXYPLUS (PROXY+)
Proxy+ is proxy software that has both free and
paid versions. The free version allows for three
users (two concurrent) to use the proxy. The two-
concurrent-user restriction means only two peo-
ple can be using the proxy at the same time. The
licensing price for five users is $99 (about
Rs 3,950), for 10 users is $199 (Rs 7,900), and for
unlimited users is $299 (Rs 11,950). You can get
the latest version from www.proxyplus.net.

Installing  
This is as simple as can be. Just download the
software and double-click it. The last step in
the setup process is important, and you should
tick the “Install as a Windows service” to run
the proxy in the background as a service. 

Configuring
Proxy+ can be configured by using a browser
and navigating to http://localhost:4400 from the
same computer or http://<Your_IP>:4400 from
another computer on the LAN.

Once you get to the Proxy+ Admin page, you
can start setting up your proxy server. Everything
is explained, and help is available in detail from
Start > Programs > Proxy+ > Guide, or
online at www.proxyplus.net/doc/en/proxyguide.htm.

In order to allow your networked comput-
ers to use Proxy+, you need to inform them to
change the settings in their Web browsers. In
Internet Explorer, you’ll need to go to Tools >
Internet Options > Connections. Here, if
you have an account name in “Dial-Up set-
tings”, select Never dial a connection.

Then press LAN Settings... . Uncheck
Automatically detect settings and Use
automatic configuration script. Select
Use a proxy server and fill the IP address
of the PC running Proxy+ in the Address field,
and set the Port to 4480. Instructions for
other browsers are at the page mentioned.

IMPORTANT CONFIG SETTINGS
Almost everything you see when configuring is
self explanatory, but we will list significant set-
tings here to ensure you set up your proxy right:

Add users
At the Proxy+ Admin page, click on Accounts
at the left and then on Users. Type in the
name of at least one user, say Admin, add a
password, and click Add. This will make sure
that you have at least one user for the next
step. You can come back later and add all the
users you wish.

Change Admin Access
By default, Proxy+ configurations can be
changed by anyone who navigates to
http://<Your_IP>:4400 from any computer on
your LAN. This is open to exploit, so you
should change this ASAP. After making a user
and setting a password, click on
Administrator and then General at the left.
Check the WWW Admin requires authenti-
cation box, select the user from the drop-
down, and click Save. This will force anyone
who browses to http://<Your_IP>:4400 to enter a
username and password to go any further.

Restarting
Proxy+ requires a restart after all major settings
changes. This is because the software reads set-
tings when it starts up—so don’t be alarmed
when you make changes and don’t see the results
immediately. In order to restart Proxy+, just go to
Administrator > Restart, and click
Restart. In a few seconds the page will be
refreshed and your new settings will take effect.

Changing Ports
By default, Admin access is at port 4400;
browsers need to set port 4480 to use the proxy,
and if you set more proxies such as FTP gate-
ways, the port is 4421, etc. All this can be
changed, and you can choose custom ports, say
1337 (geek for “elite”) for admin and normal
proxy ports, such as 8080, or others like 12345,
etc., for the services. Just go to Proxies >
General, and you will see all the settings listed
on the right. Change these values to what you
desire, and remember to click Save and also
restart Proxy+ for the changes to take effect.

Dialup
If you are on dialup, or even broadband dialup
(PPPoE), you don’t want to leave it connected all
the time. Using Proxy+, you can choose to only
dial a connection when someone on the network
tries to access a site or use a protocol. You can
even choose which protocols activate dialling.
Just go to Dialing > General and select your
connection—Proxy+ will identify and list all avail-
able connections you have here automatically—
and click Save. To choose the protocols that acti-
vate auto-dialling, go to Dialing > Auto Dial,
check the boxes for the protocols that can initiate
an Internet connection, and click Save. We rec-
ommend you set this to only HTTP and FTP.

Setting Mail Accounts
This is a very useful feature in Proxy+, and it
enables you to set the proxy server to download
mails from POP3-enabled accounts. This results
in a much faster experience for users, because
when they download their e-mail into their

Anti-virus plugins for Proxy+

Using Proxy+,
you can choose
to only dial a
connection when
someone on the
network tries to
access a site or
use a protocol
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mail clients, they’re actually downloading it
from the proxy server instead of from the
Internet. The same applies to sending e-mails.

In order to set Proxy+ to handle mail, go to
Mail > General and set the outgoing SMTP
server first. Choose Internet Mail Server if
your server is an online one. Usually, just choos-
ing your ISP’s SMTP server is recommended. Next
go to Mail > POP3 General and check the
POP3 Downloader enabled box. Now you can
go to Mail > POP3 Download, add the Internet
mail account for any of the local users you have.
Add in the e-mail account, username, password,
and select whether you want messages to be left
on the server or downloaded. Click Save.

After you’re done adding all the accounts,
you can restart Proxy+ to make the changes
active. To configure your mail client, just set the
POP and SMTP servers to the IP address of the
computer that Proxy+ is running on. You also
need to use the authentication (username and
password) that is stored in Proxy+ for your user-
name. So, if Proxy+ is installed on a machine with
the IP 192.168.0.1, your name is Prakash Sharma,
your e-mail address is p.sharma@yourdomain.
com, your Proxy+ username is psharma and pass-
word is pwd, your mail client settings would be:

Account Name: Prakash Sharma (or any-
thing you want)

E-mail Address: p.sharma@your domain.com
Incoming Server: 192.168.0.1
Outgoing Server: 192.168.0.1 (providing you
have set your SMTP server in Proxy+, otherwise
just use your regular SMTP server)
Username: psharma (the Proxy+ username)
Password: pwd (Proxy+ password, not your e-
mail account password)

Access Lists
If you decide that not everyone requires access to
the proxy server, you can deny access based on IP
addresses—for example, you might not want any-
one in the accounts department to get Net

access, to prevent exposure to viruses. Using the
Access List, you can also set Allow and Deny
based on the time of day—so, for example, you
can allow Net access only during working hours
(say, 9 AM and 7 PM), or even deny access to every-
one during lunch hours (known as goofing off
time). You can also set rules on a per-IP basis.

First, you need to go to Access List >
General and tick the “Enable Access List”
checkbox. Click save and then move on to Access
List > Objects. You need to read carefully if
you want to be able to allow or deny access to
computers or set time restrictions. Although
what follows may look like scripting, it’s not. It’s
just a logical way of telling the proxy what to do.

First we’ll look at Objects. Here you will see
a dropdown box called New object type. If
you want the proxy to deny the IP 192.168.0.99
access, you need to first define that IP. This is
exactly what you will do at Objects.

The three types of objects that are most com-
monly used are ClientHostName, ClientIP
and Time. If the IP 192.168.0.99 belongs to a com-
puter called Prakash, this is the
ClientHostName. Now to define this, you will
add an identifier under New object name. For
the computer Prakash, you might want to set
the object name to say, PC99, or anything descrip-
tive that will help you identify the object. Under
Parameter, you need to add Prakash and select
ClientHostName from the New object type
drop-down. When you click Add, you will see that
it is saved in the format PC99 =
ClientHostName; Prakash.

Let’s say you now want to add an IP—say,
192.168.0.125—as an Object. You need to select
ClientIP from the New object type drop
down, enter 192.168.0.125 as the parame-
ter, and anything descriptive that you will
remember as the New object name—IP125, for
example. This will add the line IP125 =
ClientIP; 192.168.0.125.

You can define time similarly—for exam-
ple, choosing the time between 11:00 AM and
1:00 PM, and calling it Lunch would give you
the following line in the Defined Objects list:
Lunch = Time; 11:00-13:00.

Once you have defined Objects, you can
choose what the Access List does to them. There
are four commands the List understands: Allow,
Deny, Pass and Rewrite. The first two are self-
explanatory. Pass is a rule that allows a con-

Alternatives

FreeProxy
Available from www.handcraftedsoftware.org, FreeProxy is, well, free!
Made for the Windows platform, it offers all the important features that
you want: content filtering (keyword/URL, etc.), time based access,
user-based access control, auto-dialling, access report generation,
caching (v3.80 onwards), a Web server, ability to run as a service, etc. It
offers almost all the same functionality as Proxy+, and at an unbeat-
able price—Rs 0. It’s ideal for smaller companies though—10 users or
less—according to prominent software reviewers, and seems to perform
less efficiently as the number of users increase. Still, the software is
still being actively and passionately developed, and FreeProxy is by far
the most popular Windows-based proxy server. If you have 15 or less
PCs in your company, look no further than FreeProxy.

Squid
If you have a PC to spare, and are familiar with Linux, you should
definitely look at Squid. This open source proxy server is the de
facto choice of larger businesses. With all the features you can
imagine, stability that’s unbeatable and the capability of 
handling thousands of concurrent connections without overload-
ing the CPU, nothing beats Squid in terms of scalability. 
The only drawback for the average Indian SoHo office is the 
need for a machine running Linux—however, with Linux gaining
popularity amongst PC enthusiasts and Digit readers, we expect
Squid to gain a few popularity points over the years. You can
download it, or read more about it at the Squid Web site:
www.squid-cache.org.

Remember to restart Proxy+ for major changes to take effect

Using the Access
List, you can set
Allow and Deny
based on the
time of day
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necting IP or user “pass” a username and password prompt without seeing
the login screen. For example, if people connect to
www.yourdomain.com/secret, which has a username and password
requirement to keep people who don’t work in the company out, you can
safely do away with the login requirement from PCs within your company.

Rewrite allows you to change the HTTP request that the user’s IP
requested. Say your company domain name is www.something.net, but peo-
ple are just too lazy—typing in something and pressing [Ctrl] + [Enter],
and ending up at www.something.com. This is an unnecessary waste of band-
width and time, and you can set the proxy server to automatically rewrite
the HTTP request to forward to www.something.net when it is asked for
www.something.com. This will also work when the URL asked for is
http://www.something.com/a/b/something_else/something.php?module=blah,
changing something.com to something.net in any URL.

The first two Rules are all we’ll ever use most of the time though, so
let’s look at how you can use these rules to Allow or Deny access. If you
want to deny access to the IP 192.168.0.99, you will first have created the
object IP99 = ClientIP; 192.168.0.99. Then, under Access List >
Rules, you can add the rule deny IP99. The “!” character can be used as
a NOT argument, so you can also set the previous rule (deny IP99) by typ-
ing allow !IP99, which tells the proxy server to allow all IPs except for
IP99. We’d recommend you not use this too often, unless necessary,
because you might get conflicting rules. As an example of a more compli-
cated rule, let’s say you want to deny three employees (IPs 192.168.0.80,
192.168.0.81 and 192.168.0.101) access during Lunch hours (11:59 AM
and 1:00 PM): First create the objects...

IP80 = ClientIP; 192.168.0.80
IP81 = ClientIP; 192.168.0.81
IP101 = ClientIP; 192.168.0.101
Lunch = Time; 11:59-13:00
...then add the following line to the Access List Rules box:
deny IP80 IP81 IP101 Lunch.
These examples should help you set up any rules that you need to. If

you get confused, remember to look at the help file.

Plugins
The most important plugins available for Proxy+ are those that allow it to
work with various anti-virus software to scan e-mails. You can access
these by clicking on the Back to Status link, and then clicking on Plugins.
Check the Use Plugins box, then click on Plugin Settings. You can see
which plugins are available by clicking Registered Plugins. Here you’ll
find Avast4, AVG6, MP3 Saver, NOD32, and more. You can also add more.

Finally Setup 
Once you’re done with all this, your proxy should be ready to use. There
are many more settings we’ve omitted for lack of space, so you should def-
initely take the time to read the help files thoroughly to learn how to use
it better. Make sure you try the free version of Proxy+ before you decide
to buy it. Regardless of whether you choose to use this software or one of
the others mentioned in the box Alternatives, the basics of using a proxy
server remain unchanged, so all the above should apply to them as well—
only terms and nomenclature of features will differ. Now go save band-
width and time and install a proxy server for your company! 

robert_smith@thinkdigit.com

Setting the SMTP server in Proxy+
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Abey John

W
ith more than 135 million Web sites
out there, you’ve got your job cut
out to get your Web site in front of
surfers. Search engines have long

been recognised as a good source of visitor traffic,
and over the years, Search Engine Optimisation
(or SEO as its popularly called) has developed into
an active, dynamic industry in its own right.

A Little History
If you still think stuffing keywords into the meta
tags of your Web pages are what will push you up
the rankings in the SERPs (Search Engine Results
Pages), this is a wake-up call. You’ve been sleeping
and “keyword stuffing” is about as dead as it can
get. The Net has moved on, and how! The practice
of keyword stuffing originated in the ‘90s when
Webmasters found that search engines gave spe-
cial weightage to the META tag of HTML pages
(right-click on a Web page and view its source,
and inspect the <meta> HTML tag near the top).
This was in the days when bandwidth and hard-
ware were still at a premium. Canny Webmasters
began stuffing keywords into their meta tags,
which pushed them up in the SERP rankings.
Search engines quickly caught on, compensating
for the skew in the results, and ever since it has
been a game of tag between the search engines
and the SEO industry. SEO consultants discover a
way to gain an edge in the rankings; the search
engines move in and plug the hole.

What Search Engines Do
These days, most search engines look at multiple
factors in determining a Web site’s ranking in the
search results. Some are known, most are

unknown. The search algorithm is the secret
sauce that drives the accuracy of the search
results, and is therefore one of the most closely-
guarded secrets. Each search engine has a differ-
ent set of factors to determine rankings. Google, it
is rumoured, uses more than 200 data points! The
others (Yahoo! and Windows Live are the main
ones which matter these days) are not far behind.

One of the known factors that play a role in
determining the rankings in Google is PageRank.
This is a score that Google assigns to a Web site
on a scale of 1 to 10. A higher PageRank gives you
higher weightage. PageRank itself is determined
using “…more than 500 million variables and 2
billion terms.” (http://www.google.com/corpo-
rate/tech.html). And like PageRank, there are
other hundreds of other factors that go into
determining the ranking in the SERP.

Black Hat Vs. White Hat
Even with these many factors to juggle around
with, some Webmasters resort to using deceptive
practices in an attempt to fool the search engines
and push up their ranking. This using of decep-
tion—and techniques that attempt to fool the
search algorithm—is known as Black Hat SEO, and
search engines have special filters that monitor
for known Black Hat techniques. If you are look-
ing for long-term recognition and are building a
quality Web site, Black Hat SEO is just not the way
to go! Search engines penalise sites that knowing-
ly or unknowingly use Black Hat techniques, and
this can include suspension or even complete
removal from the search engine’s listings. 

Case in point: the German Web sites of
BMW and RICOH were removed temporarily
from the search listings for using deceptive
techniques. They were only restored after they
addressed the issue. 
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shortcuts to
currying favour
with search
engines, it seems
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Deceptive techniques can be broadly classi-
fied into two types: those that try to fool the
search engines, and those that try to fool human
searchers. For example, the title of a page may
read “Free Software Download.” This will be dis-
played in the search results if the Black Hat SEO
for this page is successful. However, when the
user clicks on the link, it takes them to a page
where they are served more ads to click on—and
with absolutely nothing to download. Search
engines are aware of such techniques and com-
pensate for them. They have become increasing-
ly efficient—though not perfect—at detecting
Black Hat SEO. As time progresses, the cost of
Black Hat SEO is going to far outweigh the cost of
following legitimate practices in making your
Web site search-engine-friendly.

White Hat SEO, on the other hand, employs—
or at least tries to use—only non-deceptive tech-
niques. The qualification “tries to” stems from
the fact that there is a certain amount of grey
area in what Webmasters and SEO consultants
consider legitimate optimisation and what the
search engines agree on. Early on this year, there
was a spate of sites that sprang up offering paid
reviews from bloggers. This seemed a good idea,
especially for little-known sites who wanted to
piggyback on the popularity of an established
blogger. That’s until Google declared paid
reviews (and their links) might get penalised or

removed from search listings.
Black Hat works on the assumption that they

will eventually be caught by the search engines
and are ready to move on. There is a law of
diminishing returns in operation, as search
engines get increasingly efficient in proactively
detecting Black Hat sites. Eventually, we expect
to see the practice minimised to only those die-
hard tech criminals with enough resources
(time, money, and determination) to use Black
Hat as a part of a larger scam operation.

White Hat works with the sole objective of cre-
ating a sustainable ranking in the search engine
results. Again, this is not bullet-proof: search
engines are constantly refining their algorithms
to keep up with the latest developments that
impact what users want to search for. These days,
search engines not only monitor the search
results page, but also monitor user behaviour for
a given search term. That is, if site A was ranked
number 1 on the SERP but users regularly clicked
on site B, the number 2 link, then site B would
move to the number 1 position. Add to this the
fact that search is getting more and more person-
alised. Google, according to what can be inferred
from patent filings, will customise the SERPs
based on geographic location, similarity of search
patterns with other users, membership on certain
Web sites or forums that are discoverable by the
Googlebot (the search engine spider software that
crawls and indexes Web pages), and other factors
that would, in aggregate, group you with a specif-
ic set of users who have similar interests.

For example, if you start using Google
Finance, Google will start serving financial infor-
mation in the SERPs. If you are, say, a regular par-
ticipant at Digit’s forum (http://www.thinkdigit.
com/forum/) and you run a search, Google will
look at similar searches from other users in the
Digit forum and try to guess what will interest
you. Of course, this is a simplified example. Your
actual profile will be much more complex, and
grouping you with users with similar tastes will
involve much more. This is, of course, very good
for the user: relevance improves.

But this kind of complexity is a nightmare for
SEO practitioners. You can be forgiven for think-
ing that even White Hat SEO is more voodoo than
an art or a science. Fortunately, there are some
published guidelines, and over the years, the SEO
industry has matured enough to be aware of
some basic best practices that can help you in
achieving the rankings that you feel you deserve.

SEO Basics
Determining a specific SEO strategy for your Web
site will depend on a number of factors that are
beyond our scope here. These include things like
at what stage your Web site is—whether it’s a start-
up or an established site, what your industry is,
your target audience, as well as what type of con-
tent you have on your site. If you are an e-com-
merce site, you might need to follow certain opti-
misation techniques like exposing your product
catalogue and making it easy for the search spi-
ders to index the product pages. Here, we look at
the basics that will give you a general idea of what
you need to do stay on the good side of the search
engines. Even if you are not interested in SEO, you

Digital Business l Smart Business

Google does not bring up IWantADate.co.uk for “I want a date” (which is what you
might enter if you do!)—though that is the most obvious first result. Yahoo! brings it
up right on top, so Google probably implements “aging delay” with more strictness

...search engines
not only monitor
the search
results page, but
also monitor user
behaviour for a
given search
term.



from a site on, say, Ayurvedic medicine will have
no value, and links from many such non-rele-
vant sites may end up getting treated as link
spam, attracting penalties and even blacklisting.

One other technique is to participate in other
forums, write articles for other Web sites, and/or
leave comments on blogs. You may use these to
provide links to your site, but ensure that the
links are in context and provide value to the con-
versation. If you simply pop into a comment
thread and say “Hey, check out my motorcycle
forum” and leave a link, you will quickly get
flagged for comment spam. Look for articles or
blogs on motorcycles (our example) and leave an
intelligent comment linking to a thread in your
forum where they discussed the same issue—or
something similar.

Links (and therefore the site it is linked to)
gain value in other ways too:

the older they are, 
if they are located higher up on a page than
towards the bottom, 
if its part of the content (higher value) as
against it being in a collection of other links
like in a business directory listing (lower
value), and 
if the link is from an authority site on the
subject.
While all these links are something you have

no direct control over, what you can ensure is
that you have relevant on-topic content that cre-
ates the environment that will influence others
to link to your content.

W3C Compliance And Site Structure
The one cardinal rule that all search engines
insist on is that your Web site be primarily
designed for humans and not search engines. The
easiest way to do this is to bring your site into
W3C (World Wide Web Consortium) compliance.
The W3C is the standards body that defines devel-
opment standards for Web technologies, and
making your site W3C-compliant will give you a
boost in the rankings with at least one of the
search engines (Yahoo!). There are many valida-
tion tools that you can use to find out how com-
pliant (or non-compliant) your Web site is. A basic
“validator” for individual Web pages is available
at http://validator.w3.org.

Bringing your site into W3C compliance is
hard. The upside, though, is that when used in
combination with CSS (Cascading Style Sheets),
you can get a much cleaner and better-perform-
ing site. In addition, from an SEO perspective,
the actual content will move up higher in the
page code and hence be treated as more valu-

able by the search engines.
From a pure SEO perspective, compli-

ance is not the holy grail to climbing up the
SERP. The objective behind attempting to
become compliant is that it ensures that
the copy is marked up so that it is “clear”
to search engines. Achieving compliance
also ensures better compatibility with
mobile devices, with less chances of the
the code not working in mobile browsers.

In any case, the point is to minimise errors
rather than seek to achieve full compliance

overnight.
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might still want to pay attention to these guide-
lines which, at the very minimum, will ensure
that you don’t accidentally get blacklisted.

While all these techniques are applicable
to some degree to the Big Three (Google,
Yahoo!, and Windows Live), the emphasis given
by each will vary. To a large extent we have
kept Google in mind, considering that they
hold the largest market share.

Content Relevance
Content is still king. Nothing increases your
search engine rankings like relevant, on-topic, in-
context content. All the other factors you need to
pay attention to will carry no weight if you do not
have relevant content. Even if you have a poorly-
designed site, but with content that is useful to
your visitors, search engines can be very forgiving
and push you up the rankings, especially if a lot
of other Web sites link to your site referring to it
as an authority in the specific subject area.

Linking
Link Popularity is one of the main criteria in judg-
ing the relevance of a site. This is based on the
assumption that if you have good, high-quality,
authoritative content, more people will link to
you. This might give some the idea that many
dummy sites linking to your site can artificially
inflate your rankings. Not any more. Search
engines have wised up to this technique—known
as link farming—and will actually penalise you if
they detect that you’re using link farms. What
counts are organic links, that is, links to your
sites by other sites that are in context. 

Search engines not only count the links to
your site but also look at the surrounding words
to identify the context in which the link is
placed. For example, if you are running a motor-
bike forum and you are linked to from a tech
blog, a plain link to your Web site in the links
section will carry less weight than if you were
mentioned in a blog post. Of course, the excep-
tion is if a number of bloggers link to your
forum, and a large percentage of them are pas-
sionate bikers with posts on biking. Secondly,
the “anchor text” for the link also plays a part in
determining the value of the link. “Check this
out” will have less weightage than “Check out
Rajesh’s Motorcycle Forum”. The link anchor text
“this” is less descriptive and of insignificant con-
text when compared to “Rajesh’s Motorcycle
Forum”, and hence will have lesser value.

Of course, you have no control over how a
blogger or another Web site will link to you, but
you can at least do some groundwork (run a
search for link:yourdomain_dot_domain
_extension in Google) and politely request the
Webmasters or bloggers you can reach if they
would be so kind as to edit the anchor text.

While link farming is dead, there is still
some life left in “reciprocal linking.” This is
where you agree with another Web site to
show their links on your Web site in
exchange for linking to your site. Note, how-
ever, that this should be done intelligently,
or you might run foul of the search engines
and get blacklisted. Stick to sites and blogs that
are in topic and context with your site. Linking

Nothing
increases your
search engine
rankings like
relevant, on-
topic, in-context
content.
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Often, search engines do not crawl very deep
into your site; you can remedy this by submitting
your site and the deeper pages in your site direct-
ly. Go to http://google.com/ Webmasters/tools for
Google, http://siteexplorer.search.yahoo.com for
Yahoo!, and to http://search.msn.com.sg/docs/sub-
mit.aspx for Windows Live. Also, create a site map
based on the XML Site Map standard—which is
supported by the Big Three and others. There are
many free tools that can quickly generate an XML
sitemap of your site (search for “XML Sitemap
Generator”). Create a folder called “public_
html” in the root folder of your Web site, put the
sitemap xml file there, and submit the URL of the
xml file to the search engines. This way, the spi-
der will crawl the entire site and index all the
pages. One added benefit is that when your site
does come up as the first result in SERPs, it will
automatically show the internal links under the
main result heading, making it easier for users to
quickly reach your internal pages faster.

Formatting And Keyword Density
While we did imply at the outset that META tags
are no longer relevant, it still carries a little
weight. The meta tag of a page indicates some
basic information about your page. For example...
<meta name=”Description” con-

tent=”Website for Indian Motorcycle
Fans.” />
<meta name=”Keywords”

content=”india,motorcycles,hero honda,
bajaj, bullet, royal enfield “ />

...is an example of a good meta tag. The key-
words can, of course, be expanded, but ideally
should be kept to the bare minimum and only
include those important words that appear in
the content. In addition, ensure that the Title
tag of your page corresponds to the title of the
content of the page. This informs the search
engine that your Web page is what it claims to
be.

You can also use different fonts and format-
ting for specific keywords. Search engines will
give different weightage for words that are bold-
ed or underlined, and will give different weigh-
tage for bolded or underlined links. Needless to
say, this has to be in context. You can’t bold all
the text! The search engine will take this as the
standard formatting for the page.

The formatting you apply should be prima-
rily designed to inform the human reader of
different levels of emphasis that you wish to
apply. Also, for images, include anchor text (alt
text) that gives a description for the image
rather than just the image name.

In addition to applying formatting that can
help increase the weightage of your pages, you
should also keep keyword density in mind. The
keyword density is the ratio of the total number
of keywords to the total number of words. There is
no magic number for this; it keeps changing con-
stantly and may be different for different indus-
tries. One way is to run a search with the key-
words and look at the density in the top 10 sites in
the SERP and determine a density somewhat mid-
way between the highest and lowest values. You
might want to do the same for the keywords
themselves—see what the competition is using!

Now for the bad news. While optimum key-
word density may not be given a great deal of
weight by the search engine, too high a figure
for keyword density can attract penalties—search
engines may rightly or wrongly suspect you of
keyword stuffing.

Keep your keywords focused. If you are a
packer and mover in India, keep your words lim-
ited to “packer mover india”; Google, in any case,
clumps words with similar meanings together.
You might consider using related keywords like
“point-to-point shipping”, “door delivery”, etc.

Site And Page Age
This is a simple but important metric. The
longer the site has been running and the longer
the page has been up, search engines give it a
better ranking on the assumption that you are
not a fly-by-night operator and have really some-
thing useful to say. The same can be said for
links. The longer someone links to your page,
the more it gains in value. 

The search engines apply, to varying degrees,
an aging delay on new Web sites. This is based on
the assumption that sites are trying to game the
search algorithm, and they are progressively
removed over a period of time. From an optimi-
sation perspective there is nothing you can do
about it but wait. So if your pages do not start
appearing in the search results straightaway and
you are a fairly new site, you know why!

Going To The Professionals
The SEO industry being what it is, there are as
many con artists as there are genuine practition-
ers of the craft. In most cases, by simply focusing
on delivering great content and by following the
basic rules to prevent you from get blacklisted—
along with some light PR linking activity in rele-
vant blogs and forums—will enable your site to
gradually rise up the rankings. However, if you
need results, and fast, you should turn to an SEO
Professional. A true SEO consultant can deliver
superior results to what you could achieve on
your own. However, given the prevalence of so
many con artists who make your contract contin-
gent on specific benchmarks, you need to define
the search keywords that you wish to rank in,
specify the ranking range that you want to
appear in (if they promise to deliver number 1
ranking, politely thank them and slam the door
in their face), and specify the time period that
this must happen in. Only after you define at
least these three metrics should you even consid-
er inking a deal. 

readersletters@jasubhai.com

Results for “packers movers india”. The result pages are chock full of permutations of
those keywords! While this may seem to work, you could be penalised
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“W e believe that basics and foundation are mandatory for
success. These cannot be achieved through crash courses.
Crash courses pander to people’s insecurities, and we

believe that better candidates would not be attracted to them. We give
relative weightage of 50:50 to qualifications held and the skills
possessed by an applicant—both are equally necessary. Formal
education provides the foundation for the concepts that can be built
upon in the corporate world.
“Standardised tests give us a uniform benchmark for us to assess all

candidates. Variations in the curricula of different universities will thus
be compensated for.

“From a candidate with experience, we expect solid basic concepts,
understanding of the workspace, working in a team and lateral thinking.
We also expect the person to understand the requirements of the client
and work with customer delight in mind. We look for people with good
adaptability and learning abilities, and believe that good performance at
work can erase the deficiencies of academic performance. 

“Today, the requirement to demonstrate skills is already gaining
importance, and will continue to do so.”

“Any educational degree which is
obtained from an accredited
institute has weight, and given

preference not only in the government
sector, but in the private sector as well. Many
private institutes have mushroomed recently,
some of which follow the basic principle of
earning money rather than adding desired
value to the candidates. 

“If a candidate has formal qualifications, it
tells us that he / she has grown up to that
level, which works a launching pad to take
him further. That is why at the time of
recruiting, the requirements clearly state that
formal education is required to go ahead.

“Standardised tests, according to me,
would work better if candidates have already
taken the first flight—formal education. 

“For a regular position, we go through a
formal assessment through interviews,
written test, HR interviews, reference checks,
etc. On-the-spot hiring is limited to campus
recruitment only.

“At Synapse, we value knowledge and
skills, but a formal education is an essential
requirement.  Once candidates are hired,
what really matters is their performance,
and academic scores take a back seat. 

“Formal education can give you a
launching pad, but it’s your grit and
performance that will enable you to take-off.”

Shamit Khemka, 
CEO,
Synapse Communications
Pvt. Ltd.

Sivaramakrishnan
Kalyanaraman
Vice President—HR
Intelligroup, Inc.
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Bookworm Or
Do skillsets possessed merit over qualifications? We asked IT industry bigwigs and found out the
current trend
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Sumeet Sabharwal
Managing Director
NaviSite Inc.

“It is important to insist on formal qualifications and certifications,
because employers are competing with global talent, so you need
to hire the best. This could be very specific more to a Product

Design company than IT services company.
“You need both formal education and suitable skills to progress.

Standard- or industry-specific tests checks for skills that are needed for
specific employment where as college / university tests are needed to test
academic skills.

“At Analog Devices, formal education and basic skills are equally
important. Basic skill sets are the foundation on which every assignment
is built. Formal education gives you the tools and techniques to perform
your job better, and is also important for you to excel in your domain. 

“In our case, good performance, skills and academic record all go
hand in hand. In very rare instances, candidates with poor academic
record have shown great performance. 

“I foresee that in the years to come, it will still be important that
demonstrations of skills will be equally important as academic
achievements.”

Joe Lazar
Director-HR
Analog Devices India

“Formal education is necessary for anyone who aspires to enter
the IT industry. At KPIT Cummins, formal qualifications are the
basic criteria to enter in the primary round for recruitment, and

also an important benchmarking tool for filtering the applicants.
We give 30 per cent weight to the formal degree held by the

candidate, and the remaining 70 per cent to skills possessed. This 70 per
cent is further classified for different aspects like communication skills,
knowledge of domain and industry, aptitude, and so on.

“After passing the technical interview, aptitude and personality tests,
candidates are graded on a scale of 1 to 5 on the basis of their overall
performance and we look for those who are above average. 

“For specific requirements, we give programs or assignments to check
whether candidates can show us satisfactory results. Here too, above
average performers are selected. 

“All the skills acquired by a person during the academic period are
tested on the job, and those who prove themselves go further. At the
end of the day, however, it’s the performance of the individual that
tells the real story.”

Shrikant Kulkarni
Sr. Vice President-HR
KPIT Cummins 
Infosystems Ltd

As told to Samir Makwana (samir_makwana@thinkdigit.com)

“Formal education still remains a strong criterion for getting
through the application-screening stage. At NaviSite, we focus
less on qualifications once the candidate has been through the

conventional pre-screening process. The minimum requirement to pass
the pre-screening process is graduation. The qualifications held by
candidate represent two things—maturity and commitment by doing a
degree course. 

“Conducting standardised tests would help—depending upon who
conducts them, how they are conducted, what degree or level of
knowledge is expected, and whether it’s done by a trusted body. We’d be
pleased if they’re conduct at a level that is something similar to the
Common Aptitude Tests (CAT).                       

“We give 30 per cent weight to qualifications held and 70 per cent to
basic skills like analytical capabilities and logical reasoning for
programming. Competency has to be proven by going through the
technical test exercises that precedes the aptitude and personality
exercises.” 

Veteran?
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the likelihood of a pest infestation in the 
weeks to come. 

A Portal To The Rescue
Understanding this need for the exchange of infor-
mation from and to rural communities, a multi-
lingual, multimedia-based agriculture portal
called aAQUA (www.aaqua.org) was launched late
2003 by the Developmental Informatics Lab of IIT
Bombay in collaboration with the Krishi Vigyan
Kendra (KVK) (Agricultural Sciences Outreach
Centre) at Baramati (Maharashtra) and Vigyan
Ashram at Pabal (Pune district). There are several
KVKs across the country.

aAQUA, short for Almost All your Questions
Answered, attempts to help the farmer who
does not have access to expert advice.
Addressed here are farmers’ queries based on
location, season, weather, and crop, and other
such information that farmers or their agents
and representatives provide.

How It Works
The farmer (many a time illiterate or semi-liter-
ate) puts forth his question regarding his crop or
livestock with the help of a local computer oper-
ator at an Internet café, commonly referred to as
an Internet kiosk, as or through a literate farmer
who has an Internet connection at home. There
are relevant forums on the portal he can access
for this purpose. The portal supports Hindi,

Prakash Ballakoor

India is—sit back and think about it—a booming
economy, an IT hub, a business outsourcing
hub, and has an extremely high mobile

subscriber growth rate… and is also a country
where farmers kill themselves out of monetary
debt and poor fishermen mark their graves at sea.

The economist will tell you that waiver of debt
or providing subsidies is not the way out for the
farmer. The weatherman will tell you that fore-
casting is not enough to warn the fisherman at
sea. So what can be done to help farmers and fish-
ermen, two classes with shared problems? Tech-
nology can help: it need not only be for the
middle class. It is about supplying the right infor-
mation at the right time, making the unpre-
dictable more predictable.

It’s About Information
If our farmers need to harvest the benefits of a
booming economy, they need information:
accessible and affordable, timely and
customised, usable, searchable, and up-to-date.
Large sections of society—mostly rural folk—do
not have access to the huge knowledge base
built by scientific development. The content is
not in the local language, and not deliverable in
a form of immediate use to them. For example, 
a monthly farming magazine cannot report 

Entrepreneurs
are taking
substantial steps
towards using
technology to
help those who
till the soil and
harvest the sea.
The information
is there; it needs
to be delivered

At Sea No More

Digital Leisure l Touched By Tech
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Marathi, and English as of now. Experts from
Krishi Vigyan Kendra—Farm Science Centre,
which provides training skills on scientific farm-
ing practices for farmers and the rural youth in
Baramati, then answer the questions.

The portal also maintains a repository of ques-
tion and answers. Upon registration, one gets
details such as the weather forecast for the loca-
tion. If a farmer cannot post a question online or
e-mail it (to aaqua@persistent.co.in), he can SMS it.
Industrial (agriculture-based), financial, and legal
advice is dispensed. aAqua experts say that once
they receive a question, they are time-bound to
reply within 48 hours.

The Extras
Other than providing expert answers, aAQUA
provides an online digital library called Crop
Doctor, which displays images related to crop
disease. Farmers can identify relevant photo-
graphs and look for control measures. A library
of seasonal crop recommendations by experts
from KVKs can be found under the Crop Recom-
mendations. Even updated prices of agricultural
commodities in different markets of Maharash-
tra, collected by the Agricultural Produce Market-
ing Committees (APMC), can be located under a
section called Bhav Puchhiye.

A multilingual meaning-based search engine
called Agro Explorer allows the user to search for
content in a local language (though the site
currently supports English, Hindi, and Marathi),
and view the document in that language irre-
spective of the language of the original document.
aAQUA’s architecture is designed in such a way
that it allows users to navigate and search
through all aAQUA forums even when connectiv-
ity is disrupted. The information repository on the
local computer gets updated whenever Internet
connectivity is established.

In the past year, the aAQUA portal has seen
5,760 posts and about 6 lakh views. From
incpetion, questions have been received from 290
of India’s 600 districts.

In Their Footsteps
Following aAQUA’s success, a new social
venture firm came up, based out of IIT
Bombay’s Business Incubator. The team behind
it comprises Anil Bahuman, Dr Krithi Ramam-

ritham, Dr Kadarbhai, Dr Yogesh Kulkarni and
Dr Bishnu Pradhan. This social venture, called
Agrocom, goes a step further: unlike in aAQUA,
a farmer need not visit an Internet kiosk for a
weather update.

Agrocom realised that though aAQUA has
been a success, there were more issues that
needed to be addressed. For information from
aAQUA, farmers needed to walk miles to get to

an Internet kiosk; and what with villages being
plagued by power outages or low voltages,
making it difficult to install and run PCs. Agro-
com addresses these issues by sending out
timely weather reports and disease and pest
warnings—to farmers and farming organisa-
tions that have subscribed to the service—using
SMS text. When more detailed information is
needed, Agrocom uses e-mail.

The Returns
Agrocom has realised about Rs 9 crore in savings
for farmers in the past 11 months of operation.
The cost per month for a weather forecast is Rs
100, and for a disease alert, it’s about Rs 250. For
e-mail-based weather forecasts for an organisa-
tion, the charges are Rs 800 per month per
village. More than 300 farmers have subscribed
to the SMS service.

An e-mail report from Agrocom contains charts indicating various weather parameters
ranging from dewpoint to relative humidity

Nilanjan Ghosh
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Information through e-mail is more elabo-
rate—it includes reports of humidity, solar radia-
tion, air temperature, precipitation, leaf wetness,
and dew point.

Farmers use disease forecasts to plan a preven-
tive spray schedule. This drastically reduces crop
damage due to insects and diseases. This is also
good for the environment, as it means fewer
pesticide residues in the crop. And now, given the
growing consumer awareness of pesticide
residues and the premium that consumers are
willing to pay for farm produce with low-level
residues, farmers can demand better prices in the
domestic as well as export markets.

Agrocom also offers bulk purchase of SMS
credits, which are then distributed to farming
organisations and KVKs. Agro universities and
KVKs buy these services so that they can interact
with the farmers and forward relevant informa-
tion, they depend on government grants for this.

Agrocom also supports infrastructure-build-
ing projects, providing consultancy and support
to farming organisations that want to install
automated weather stations for purposes of farm-
level disease forecasting, weather record valida-
tion for weather insurance, and weather forecasts
for decision support. Agrocom’s predictions have
been shown to have an accuracy level of 80 to 90
per cent, based on random surveys.

Mobile At Sea
The M. S. Swaminathan Research Foundation
(MSSRF), a Chennai-based research body that
works on agricultural and rural development as
a part of community service, has been providing
weather information to a fishing village called
Veerampattinam, and a neighbouring village,
Nallavadu, since 1992—and has been saving fish-
ermen’s lives. But since the announcement is
through a public address system at 3 AM (when
fishermen venture out) there is no way to
communicate sudden changes in weather when
the fishermen are out at sea. MSSRF therefore
developed a simple solution to address the issue:
use the cell phone.

QUALCOMM, a pioneer in CDMA communi-
cation technology, and actively involved in vari-

ous social projects the world over, partnered
with MSSRF and developed a user-friendly
mobile application, called Fisher Friend. It has a
user-friendly interface and provides vital, real-
time information to fishing communities—
anytime, anywhere—at the press of a button.

The application, developed by Indore-based
Astute Systems Technology, on the BREW (Binary
Runtime Environment for Wireless) platform—
QUALCOMM’s open solution for wireless applica-
tions development and device configuration—
allows users to access information through an
interactive menu. It allows fishermen to know if
it is the right time to venture out to sea; it provides
vital updates like the location of fishing shoals,
risks, and fish trade information in the local
language (Tamil at present). The information
channels the energy of fishermen in the right
direction, optimising time and fuel.

Satellite images are the basis for the informa-
tion regarding weather and fish concentration; it
is accumulated in a centrally-located server at
MSSRF. This information is then analysed by
MSSRF, and sophisticated technical information
like sea wave heights is processed to make it
usable. The processed data is sent to Astute to be
encoded for the BREW platform. The project is
now in the trial phase, and involves 10 fishermen
using Tata Teleservices in Veerampattinam.
Created in Tamil, the appication will be first rolled
out in places where Tamil is understood.

The service is available in the 10 to 15 kilo-
metre range within domestic waters, which
covers about 80 per cent of fishermen’s require-
ments. Extending this limit is not possible
because regulations do not currently permit
mobile communication in international waters.

Parag Kar, senior director, Government
Affairs, QUALCOMM India and SAARC, says, “Pric-
ing for the service at the moment has not been
decided. Feedback from the fishermen is being
collected to enhance the application in terms of
user-friendliness and how far it is reflective of the
needs of the fishing community. We have
finished with phase zero (of four) and we are in
phase one, which will be completed by the end of
2007.” Going by media reports, the application is
likely to be perfected by November of this year,
and will be deployed on about 100 phones across
the coast. It is also reported that QUALCOMM is
working on incorporating GPS capabilities into
the phones so the exact location of the phone can
be tracked, and so that rescue becomes easier in
the case of a disaster.

Why Not?
The technology is all there, but only a few rural
entrepreneurs take it to a stage where those as yet
unempowerd by that technology can use it. We
must not forget that technology is not for and by
the middle class alone. If we can have IT parks, we
can have services such as those we’ve discussed
rolled out all over the country… and that would
benefit not just the farmer and the fisherman; we
would all benefit in return—individually and as a
nation. Certain ideas—such as “the illiterate
cannot use technology”—must be wiped out. After
all, tech enhances life, wherever, whoever. 

prakash_ballakoor@thinkdigit.com
Fishermen included in the trial phase of QUALLCOM’s service using the Fisher Friend
application while out at sea

Once we
complete the
trial phase, we
will work with
our ecosystem
partners to
identify the
business
opportunities
and financials”

Parag Kar
Senior Director,
Government Affairs,
QUALCOMM India 

Once we
complete the
trial phase, we
will work with
our ecosystem
partners to
identify the
business
opportunities
and financials”

Parag Kar
Senior Director
Government Affairs
QUALCOMM India 
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We can hear you saying, “No! Not
another world war title, enough
already!” Actually, I missed the beta

and I’m glad I have my hands on the final ver-
sion. It’s been one of the games many have
been waiting for all year. The single-player
storyline goes along the lines of how the
Soviet Union tries to take over American cities
and US forces try their best to hold them back
and take back whatever little they can. 

The controls here are completely differ-
ent from those in most RTS games. You
move the camera like you would move a
player. Whereas WASD would be used for
attacks or making units, here you use those
keys to move in different directions, and
the mouse scroll to move up and down. The
training session has an obstacle course for
you in which you move your camera view
through hoops. It takes a while to get com-
fortable with the change, but they really
get you into the action.

Single-player gameplay is simple, and
has the typical primary and secondary
styled missions that are pretty easy even at
normal difficulty. The allied troops are
there helping you from getting your ass
handed over almost all the time. The game
has none of that collect 10 gold and 5 wood
to manufacture new shiny pony nonsense

here. What you get instead is non-stop
chaos in which you’re continuously either
attacking or being attacked.

The cool-down time for most of the spe-
cial weapons and reinforcements has been
kept lower than that in other RTSes, because
you won’t be creating any units as it is. Units
come in the form of reinforcements that you
order from time to time when you have the
credits. Select two of these and three of
those and point where you’d like them.
Moments later, they’re home-delivered. If
you aren’t careful with your spending,
though, you might find yourself fending off
half the Red army with two tanks.

The maps are huge but the vehicles are
quick. There isn’t a variety of units to
choose from; they have been kept rather
basic, and you spend your time focusing on
tactics. Most of the fun is to be had by doing
special attacks such as carpet bombing,
napalm strikes, and nukes.

These elements all add up nicely to
some really intense gameplay. There’s even

more fun to be had in multiplayer, where
you can have as many as 16 players at
once—with voice chat as well!

The graphics are some of the best I’ve
seen in RTSes. The unique camera controls
allow you to get really close to the action—
and you’ll see dust on jeeps’ windshields and
footstep trails of infantry in the sand.

The maps are filled with beautiful sway-
ing trees, brilliant shaders for the rivers and
seas, flashing clean metal structures, and
perfectly-tarred city highways which all make
for a well set environment to… destroy. 

Our GeForce 8800 GTX didn’t break a
sweat at maximum settings at 1440 x 900.
There aren’t any noticeable bugs, either.
Animations are very well done, and you can
see this especially in the in-game rendered
cutscenes. The sounds are great and so are
the voice actors.

World in Conflict is like Company of
Heroes (COH) minus the crazy-blood-
thirsty-soldier-blindly-running-across-a-
minefield-screaming-kind of passion and
madness. A big chunk of COH and
Command & Conquer players will like this
one. This is definitely one of the best RTS-
like games around today, alongside
Company of Heroes.

rossi_fernandes@thinkdigit.com

XFX GeForce 8800 GTX,
Intel Core 2 Duo E6600, 4 GB DDR2 RAM,
Windows Vista Ultimate x64, WD 250 GB
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The Final Conflict
Is old-school back?
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F
inally! After 16 months of waiting, Episode Two
of the Half-Life 2 saga has been released. It’s not
that good, unfortunately. We’re hoping that the
lapses we detail below are because the develop-
ers were working on Portal, for there’s no other
explanation we can think of.

Ever since Valve decided to release future instalments of HL2
in an episodic format, the innovations haven’t exactly awed us.
Episode One was interesting, but nothing compared to the buzz
that surrounded HL2. Now along comes Episode Two, and it just
feels like rehashed content. The solution to the various puzzles
seem too obvious, and I could always immediately see my way out
of the current situation. Episode Two will give you a maximum 10
hours of gameplay, which is another irritant with the episodic for-
mat—I’m officially changing my stance from a supporter of the
episodes to the point where I’d rather wait five years for HL3 and
get my days/weeks of enjoyment, instead of this 10-hour teaser.

What’s New?
In order of appearance, here goes:
The Hunter: A badass machine you’ll often meet. It’s
fast, powerful, eight feet tall, shoots weird cannons,
and basically spits venom. Throw something heavy at
one and watch it get bowled over. The pulse rifle’s
alternate fire is a one-shot kill, and the
hunters become the hunted if Freeman
is doing his Schumacher impression
behind the wheel of a beaten-up
jalopy (see hunter, point car at
hunter, hunter go squish!).
The Antlion Worker: The
damn thing throws
venom over long dis-
tances, while jumping
and climbing like,
well, an Antlion. It’s
immune to water too,
unlike regular Antlions
that drown in a puddle.
Again, using the gravity
gun to fling boulders or gas
cylinders (if available) at
Workers proved to be very
effective. 
The Magnusson Device: In
Episode Two, you’ll face a dozen
or more Striders. Sound really
hard? Not when Freeman

carries a Magnusson Device, it’s not! Use the gravity gun to shoot
this sticky bomb at a Strider, then just pull out any weapon and
shoot the bomb. Kaboom! Strider-stew. If it weren’t for the
Hunters that accompany each Strider, these monsters would be
as easy to kill as a stray zombie.  

Apart from the few new features, Freeman leaves City 17 for
the first time and heads to White Forest. Scenery-wise, every-
thing you do in Episode Two is outdoors or in caves. We won’t ruin
the ending, or too much of the plotline for those who still want to
play it, but be prepared for another pot-boiler at the end—typical!

Valve has also released Orange Box—which contains HL2,
HL2E1, HL2E2, Portal and Team Fortress 2—for a mere $49.95 (less
than Rs 2,000). If you haven’t played Half-Life 2 or Episode One
before, get the Orange Box now. Episode Two on its own is nothing
great though. Portal, however, is a different matter altogether...

Half-Life 2: Episode Two and Portal
Bottom line: HL2E2 could have been better. Portal rocks though

That Portal has to go!

Vortigons bring her back to life 

Scientists. You can’t live with ’em, can’t kill ’em Stupid Hunter trying to kill my girlfriend

Rating:
HL2E2—5/10; Portal: 9.5/10
Developer: Valve Software

Publisher: Available at
http://orange.half-life2.com/

Price: US$ 49.95
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Here’s an FPS that’s so refreshing, we’ll
tell you upfront that we gave it a
9.5/10—almost perfect, if only it were
longer. The game will give you about
three to four hours of immense fun.

Portal capitalises on the puzzle-
solving that made HL2 what it is, then
adds a whole lot more. What might this
“more” be, you ask? If you thought
physics was confusing, and life in 3D
complicated, Portal takes you to the
fourth dimension, allowing you to travel
between two “portals” that you can cre-
ate pretty much anywhere. One instant
you’re jumping down into a portal on
the floor, only to  emerge from the other
end you’d placed on a wall. To compli-
cate things, momentum is conserved
when you pass through the portal,
which means you come out the other
end at the same speed, but in a com-
pletely different direction. Thanks to my
nonexistent spatial skills, there were
times I became so disoriented, I began
swivelling my mouse around frantically,
trying to understand where I’d ended up
and which way was which.

You start off as a test subject (an
expendable one, obviously), being guid-
ed by an AI computer called GlaDOS,
who’s teaching you how to use the por-
tal gun. As you near the end of the test
after successfully completing all the lev-
els, GLaDOS tries to incinerate you. You
escape of course, with GLaDOS promis-
ing you cake if you come back.

The game has a hilarious script writ-
ten for GLaDOS, and a few times I found
myself losing a level because I couldn’t
see through the tears squeezed out due
to my hysterical laughter. The develop-
ers poke fun at everything, including
Black Mesa (the research centre respon-
sible for all hell breaking loose on Earth
in Half-Life), not to mention the much-
promised cake—if you keep your eyes
peeled, you’ll find tonnes of similarly
funny Easter eggs.

In the end, you meet and combat
GLaDOS, and have to kill her before she
returns the favour. Listen to her dia-
logues carefully and try not to laugh
yourself to death. We expect to see this
portal gun in HL2 Episode Three, or even
a more complete and much longer
Portal game. After you finish, some
Advanced Maps are unlocked, which
contain more challenging puzzles.

Enough. This game is a must-play,
the end-titles song a must-hear (we’ve
provided the lyrics on the right). Make
sure you get it ASAP.

robert_smith@thinkdigit.com
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GLaDOS tries to kill me

The cake is a lie...

That’s me looking at myself

GLaDOS says she loves me. Then I kill her

Getting through the puzzles

Staying Alive

This was a triumph. 
I’m making a note here: 
HUGE SUCCESS. 
It’s hard to overstate
my satisfaction. 
Aperture Science 
We do what we must
because we can. 
For the good of all of us. 
Except the ones who are dead. 

But there’s no sense crying
over every mistake. 
You just keep on trying
till you run out of cake. 
And the science gets done.
And you make a neat gun. 
For the people who are
still alive. 

I’m not even angry. 
I’m being so sincere right now. 
Even though you broke my heart.
And killed me. 
And tore me to pieces. 
And threw every piece into a fire. 
As they burned it hurt because 
I was so happy for you! 
Now these points of data
make a beautiful line. 
And we’re out of beta.
We’re releasing on time. 
So I’m GLaD. I got burned.
Think of all the things we learned 
For the people who are
still alive. 

Go ahead and leave me. 
I think I prefer to stay inside. 
Maybe you’ll find someone else
to help you. 
Maybe Black Mesa... 
THAT WAS A JOKE. (ha ha) FAT CHANCE. 
Anyway, this cake is great. 
It’s so delicious and moist. 
Look at me still talking
when there’s Science to do. 
When I look out there,
it makes me GLaD I’m not you. 
I’ve experiments to run.
There is research to be done. 
On the people who are
still alive. 

PS: And believe me I am
still alive. 
PPS: I’m doing Science and I’m
still alive. 
PPPS: I feel FANTASTIC and I’m
still alive. 

FINAL THOUGHT: 
While you’re dying I’ll be
still alive. 

FINAL THOUGHT PS: 
And when you’re dead I will be
still alive

STILL ALIVE 

Still Alive

XFX GeForce 8800 GTX, Intel Core 2 Duo E6600,
4 GB DDR2 RAM, Windows Vista Ultimate x64

GAMING PC
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Platforms: PC, Xbox 360, Distributor: (Xbox 360)—Redington India
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Digital Leisure l Game On

What do you get if you cross John
Carpenter’s The Thing with Starship
Troopers and, in typical Japanese

fashion, throw in a couple of hundred
giant battle mechs? Originally released
on the Xbox 360, Lost Planet finally
winds up in the hands of PC gamers,
becoming the first DX10-compliant
game to be released.

With an absolutely laughable
plot that serves no purpose
other than getting you from
beginning to end, Lost Planet
manages to pack in gameplay
that more than makes up for the
planet-sized hole in the story.
There’s arguably nothing more
fun than shattering the frozen
corpses of huge alien bugs into
teeny ice crystals. What works
against the game is, ironically, the
presence of the pilotable giant mechs,
dubbed Vital Suits.

Lumbering hulks armed with massive
weapons, the VSes pretty much turn combat
into a one-sided killfest. All that atmosphere
envelops you as you trudge through waist-deep snow,
or get chased through an expansive ice plateau by a giant
worm. And what was actually enjoyable on the Xbox 360 becomes
too easy and overly repetitive on the PC, simply because you can
aim better with the mouse (unless you use an Xbox 360 con-
troller), leading to a situation where you’re just mindlessly blast-
ing enemies to get to the juicy boss battle.

Even though Lost Planet is the first DX10 title currently out,
it is still a port of a DX9 console game, and it shows. The game
does look much better than the Xbox 360 version at high set-
tings in DX10—with improved lighting, shadowing and particle
systems—but unless you look really hard, you won’t spot major
differences between the DX9 and DX10 versions. Those who do

play it on an Intel Core 2 Duo and an
8800 GTS or higher, however, will be

treated to a lot more eye-candy,
including better kick-up from

grenades, the extremely
dense smoke / fire effects

and some of the richest
motion blur and HDR
effects seen in a PC
shooter.

However, it’s not all
fun and games, thanks
to the fact that Lost
Planet enforces a
strict Shader Model
3.0 requirement on the
GPU without actually

needing it. And then,
the PC multiplayer is

borked for the most part,
and provided you actually

connect to a proper server
on the PC or via Xbox LIVE,

you’d soon get bored thanks to
the dull variations on archetypal

gametypes or the VS-hogging killjoys
you’ll find online. And if you hate the Steam

platform, stay away from this game, since it relies
on Steam just as much as Valve’s games do—so you can’t really buy
the game and play it offline immediately.

In the end, if you already own an Xbox 360 or plan to get one,
it’s best to stick to this game on the console. On the PC, it just
becomes a really fun yet average shooter that has little to no
replay value. While no-one who gets the chance to play Lost Planet
will regret it, those who are planning to sell body parts over the
next three months considering the thousand and one new titles
being released, might want to take a rain check on this one. 

readersletters@jasubhai.com

Lost Planet:
EXTREME CONDITION
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Kids today... It has been
proven that children
will do anything they

can to upset the well-
intentioned plans of their
elders. And if that means
hacking into porn filters
and posting a DIY on
YouTube for other
oppressed teenagers—didn’t
the Bard say everything was
fair and all that?

The Australian
government, apparently
worried over the
proliferation of online smut
and resulting corrupting of
morals, dumped A$84
million (about Rs 250 crore)
into a state-of-the-art porn
filter. They then collectively
sat back, hoping to look
over benignly as the
hormone-affected
population browsed
National Geographic and
Popular Science. But young
Tom Wood—all of 16 years
old—stuck a mighty blow in
favour of free speech (or

insolent defiance,
depending on your political
leanings) by proving in 30
minutes that the filter was
nothing but a fancy piece of
eye-candy. He was
immediately hailed as a
genius and saviour, while
embarrassed officials
scrambled to plug in the
holes—without much
success.  The only comment
from the authorities was
that good parenting was
much better than any
technology. Needn’t have
wasted millions to find that
out, eh?

All the above happened
in August. Considering that
this was a pet project of
Aussie premier John
Howard, you would have
expected that they would
remove all the loopholes
after all that publicity.
Turns out, the thing is as
leaky as ever—when the
original hacker took it out
for a spin, it still let in stuff

that wasn’t supposed to be
in. And so other kids could
take advantage of this, he
posted a detailed video on
YouTube mentioning the
steps necessary for a free
inflow of porn on
computers with the filters
enabled. At the time of
writing, the technicians
were still scratching their
heads. We’re sticking our
neck out on this—they’ll
continue scratching for a
long time!

SIGNUP BLUES

U Joinin’,
Dude?

If you happen to read a
recent presentation of
the US Navy, don’t be

surprised if your first
thought is, “Are they
conducting a cultural
orientation course for an
invading force?” Well, we
thought the same way, until
we looked harder and found
out it was a presentation for

Geno P T, Nagercoil, Tamil Nadu
How he did it:
Edited the layout of the keyboard in the picture;
used picture-to-icon software to convert part of
the screen to icons; the icons were arranged in
their exact locations on the wallpaper. Changed
font sizes to merge the icons with the wallpaper.
Used Top Themes XP to edit my customised
taskbar. Used Magic Tray to remove the Start
Button and Taskbar items. And removed the arrow
in the IE and WMP shortcuts!

Nigerian Visa Scan
Bill Gates recently needed to go to Nigeria. The plans were ready,
but the visa wasn’t yet available... Nigerian immigration reported
that until they were sure Gates wasn’t planning to stay on in the
country permanently, putting a strain on the country’s social
services, he wouldn’t be allowed in. They did finally relent!

LEAKY FILTER

Porn, Down Under

My Desktop

Whatever 
Happened To…

Back when the DVD first
came out (feels like so
long, doesn’t it?), movie

studios didn’t really know
what to do with all that
space—a typical 2-hour movie
barely filled up two VCDs (1.4
GB); what were they
supposed to do with 4.7 GB
of space? One of the more
brilliant ideas was the multi-
angle movie—don’t like the
camera angle the director’s
chosen to show? Change it!
You could watch races and
matches from whatever
angle you chose! 

Nice plan, but Hollywood
had their priorities—they
kicked up the video
resolution, added subtitles in
multiple languages and
lavished us with higher-
quality 5.1 channel audio.
When it came to the final
touch—viz. the multi-angle
movies—they backed out.
Shooting scenes from
multiple angles meant higher
production costs, and it
interfered with the
“directors’ artistic vision”—
you are supposed to watch
movies the way they want
you to.

In fact, the only movie
producers to embrace the
idea of multi-angle movies
were in the porn industry—
for... ahem... obvious
reasons. In fact, you can
purchase multi-angle porn
DVDs even today, though not
in India, of course. In any
case, the format hasn’t really
died per se—nearly all DVD
players support it, but good
luck finding a family-friendly
movie with this option.

The Law Catches Up
A law student posted, on his Facebook page, a libellous
picture of his university president. Authorities spotted it and
gave the aspiring lawyer two options—apologise publicly or defend his
actions legally. The student submitted a legal brief to his dean, but the prof.
didn’t find any merit there—and he will now face suspension. Lawyers!!

Send us your desktop  with a description of how you
made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject
““MMyy  DDeesskkttoopp””,, and tell us your postal address, too.

Participate in this contest
and win next month

Hacking Wireless
Exposed
by Johnny Cache & 
Vincent Liu

Published by

Tata McGraw-Hill Publishing Co.Ltd.

Multi-angle Movies 

■ Homeland Security floods inboxes after snafu with mailing list ■ All Calif. govt. Web sites shut down by mistake in response to hacker attack



recruiters (the Gunnery Sgt
Hartman of Full Metal
Jacket type) on identifying
with the MySpace
generation—at which the
Navy points out, “This is not
about just a generation gap,
but dealing with a
somewhat alien life force.” 

The presentation talks
about pampered American
kids in the age group of 17-
24 (called millenials in
military jargon) and then
goes on to decipher their
ilk. They have a few good
things to say—kids are closer
to family and friends, more
socially responsible and
passionate about their lives.
However, it finds loads of
flaws in their make-up—
according to the Navy, the
target age group has been
mollycoddled so much so
that GenNext has come to
expect praise for just
turning up for work.

This generation had
grown up with technology
and have no concept of the
Cold War or the Berlin
Wall, which means Sarge
better nix his plans of
giving pep talks on the
need to sign up and defeat
the Red scourge. Neither
would jingoism and

xenophobia work, as
MySpace means these kids
have buddies in Godless
China who are as close—if
not closer—as the dude
next door.

The Navy glumly
concludes glumly that
living in an atmosphere
where a Web site taking a
little more time to load is
worthless, it has a hard job
ahead of it—made harder by
the idea that joining college
means four more
irresponsible years that
would be missed in
the forces.

There is also a little
quiz on, among other
things, who Shiloh is
(Brangelina’s baby, but you
already knew that), or what
an emoticon looks like!. The
new age jargon of IM and
SMS is also helpfully
demystified so that
recruiters could connect
with their audience.

Now if only they had
included information on
how to make friends on
MySpace, this project
would be a success.
Otherwise the US Navy
would be stuck with robo-
sailors—not to mention
mercenaries.

IROCK

Rocky 
Music

Regan Ritter, of Fort
Worth, Texas, was
approaching 14. Like

millions of people, she
wanted a Video iPod for her
birthday, so mom and
daughter went to a store to
get themselves a shiny new
‘Pod worth $350. But when
the teenager opened the
pack she found only rocks
inside—no, not translucent
rocks with orange and
green streaks which you put
on the coffee table, but
ordinary, roadside pebbles
which you might sometimes
pick up and smash the
neighbour’s windows with. 

Regan was
understandably stricken,
but her mom had
fortunately preserved the
receipt and there was hope
yet. They went back to the
store with the box of rocks,
hoping for a replacement.
Fortunately, the employees
at the store believed the
story and agreed to give
store credit (policy, you
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We all love our smileys :-)
—three simple symbols
that can turn an otherwise
staid
statement
into a joke.
’Twas back in
1982 that
Scott Elliot
Fahlman
discovered
that he could smile using
the keys on his keyboard
in this famous e-mail: 

I propose that the
following character sequence
for joke markers:        

:-)
Read it sideways.

Actually, it is probably more
economical to mark things
that are NOT jokes, given
current trends.  For this, use

:-(
If it weren’t for him, e-

mail and IM would be so...
bland. (Now it seems: how
come no-one thought of it
earlier?)

Though he sort of
revolutionised online
communication,
Fahlman’s first love was
Artificial Intelligence,
which he’s spent most of
his professional life
working with. He’s known
for his work on neural
networks—networks that
imitate the behaviour of
the human brain—and
semantic networks, and
has contributed
significantly to the
development of Common
Lisp at Carnegie Mellon
University. 

While studying at MIT,
he spent summers
working for the likes of
Bell Telephone
Laboratories, NASA
Electronics Research
Center, Honeywell
Computer Science Center,
Digital Equipment
Corporation, and Alcoa.
Elliot is now a Research
Professor of Computer
Science at Carnegie
Mellon University.

People Who
Changed

Computing

Smile!

The iPix exists!

WIN!
Send in your entry and you could win an exciting gift by sharing an amusing picture with a tech angle to it.
The picture should have been shot by you, and should not have been published anywhere earlier. 
E-mail your picture with “DigiPick” in the subject line, mentioning your postal address, oonn  oorr  bbeeffoorree  tthhee
2200tthh ooff  tthhiiss  mmoonntthh  to digipick@thinkdigit.com. One prize-winning picture will be published each month.

Participate and 
win next month:

CAPM/PMP
Project Management 
Certification
by Joseph Phillips

Published by
Tata McGraw-Hill 
Publishing Co.Ltd.

Last month’s winner:
Saurabh Singh
Delhi

Scott Elliot

■ Teen hacks into 911 system, orders SWAT raid on neighbours! ■ Kim Jong II asserts he’s a Net expert, but doesn’t favour Net for North Koreans



Blood Money

Acontract killer with a heart
of gold gets a hit order. He

alerts the victim and gives him
a chance to save his life. The
only catch—the would-be victim
would have to pay up. Sounds
like a movie script, right? Well,
this was the proposal a 72-
year-old pensioner in New
Jersey got when he opened his
inbox—the amount mentioned
was $8,000, with half to be
paid immediately. He was also
warned not to speak to
anybody about this; his friends
were likely to be involved in the
plot and he would get his goose
cooked.

Harry Whitworth promptly
smelt a scam and immediately

called the cops. After
ascertaining that he wasn’t
involved with the mob or other
unsavoury characters, the Feds
included his name as a part of
the US-wide operation. The
cops hope to catch the scum
behind the scam, though they
have not much leads. Knowing
how these scams spread
though, we will be watching
our inboxes.

Listing Sin

Information about peep
shows, brothels, and massage

parlours has always
proliferated through word of
mouth, but with the Internet,
this information is a few clicks
away—if you know where to

look. A very good place is
Craigslist—it’s well-known, free,
and anonymous. But Craigslist
draws the attention of cops,
especially if you list live sex
shows near a church and a
school. Now in the Windy City, a
bored officer of the Chicago
police was looking at listings
when he came upon explicit
ones that advertised live sex
shows. You could, for $240,
watch couples having sex. Pay
some more, and you could take
part. And so, the coppers
raided the house of ill fame
and took the performers and
the manager into custody.
We’re guessing the first thing
the manager does when he
gets out is sue Craigslist...

know—no refunds) for
another iPod, which
unfortunately, was out of
stock. A neighbouring store
said they had enough stock,
so the duo legged it to that
one. Once bitten, they
wanted to have a look at the
iPod before taking it home.
Due to another store policy,
they had to buy the iPod
and then open the pack.
The iPod bought, the teen
excitedly opened the pack
and…… found it filled with
rocks. Again.

Fed up to the skin of the
teeth, the Ritters demanded
their money back. But once
cash is in, it does not come
out of the system. The staff
suggested they pick up
something else for $350.
The daughter, her heart set
on a Video iPod, desolately
collected knick-knacks
totalling that amount,
while mom stood aside
swearing tort action.

Apple, as usual, declined
comments while the store
chain’s PR department
issued clarifications
couched in homilies such as
ensuring the customer’s
satisfaction and blah blah.

We are guessing a US-
wide, possibly global,
conspiracy headquartered
from a certain city in
Washington state to
infiltrate iPod supply lines...

HOSTILE TERRITORY

Hate Thy
Enemies

What’s the sine qua
non of social
networking sites?

Making friends, talking to
new people, and so much
more... But the operative
word here is friends. You
don’t generally behave like
a jerk; that people do at
usual sites is beside the
point. What if you’re tired
of keeping up an artificial
façade of sweetness during
those days of the month
when you go around
smashing furniture
and snapping at everyone
in sight?

Everybody feels like that
at some point or the other,
of course. So if you ache for
some good ol’ bile, do
yourself and others a favour
by heading over to Hatebook
(www.hatebook. org) and
vent that ire. It’s therapeutic,
as shrinks have repeatedly
told us, and there is that
thing about keeping friends
close and enemies closer.

Hatebook, if you haven’t
already guessed, is a parody
of Facebook. The look and
feel is the same, except the
colour scheme is a fiery red
for Facebook’s placid blue.
After registering, you are
welcomed with a “hello,
sucker” message, which sets
the tone of things to follow.
Your profile is made up of
fields like Music that sucks,
Brands I hate, Movies that
bother, Books I hate... you
get the idea. People who
visit you are Idiots, while
you write Junk Mail to
anybody and post on their
Blackboard. You can add
people you hate and bad-
mouth them; the only limit
is how wide your vocabulary
is. In fact, being nice to
people is frowned upon
here; you have only enemies
to add, though you could be
friends with your enemy’s
enemy and join forces in
pouring scorn on the poor
blighter... We hate to admit
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Cryptography
All about cracking codes and
secret messages,
“cryptography” has a
glamorous Bond-like ring to it,
though the actual science that
goes into it is highly
mathematical. That said, most
of us wonder what exactly
public key cryptography means.
SSL: Secure Socket Layer is a
cryptographic protocol used in
e-mails, IM and other data
transfers over the Internet. SSL
and its related protocol, TLS
(Transport Layer Security), are
grouped in the topmost
(Application) layer of TCP/IP.
Public Key Cryptography: The
most widely used type of
cryptography, PKC uses a
public key that is widely
distributed, and a secret
private key. The sender
encrypts a message with the
receiver’s public key, which
can only be decrypted using
the receiver’s private key. The
keys are generated using
algorithms like RSA.
RSA: A widely-used algorithm
used in PKC. It uses two large
prime numbers to generate
public and private keys. The
keys generated by RSA have
been very resistant to attack.
Hash functions: These take a
variable-length input and
generate a fixed-length output.
As used in cryptography, they
are designed so that it’s
impossible to get the input data
even by knowing the output and
the function. Hash functions
like MD5 and SHA-1 are used in
digital certificates for verifying
data identity and/or integrity.
Digital certificate: These are
used in online transactions to
verify identities. They are
typically issued by a trusted
third-party Certificate Authority
and have information that can
identify the owner.  
Usage: RSA is a bit slow,
though it’s the best public key
cryptography algorithm. But
for foolproof security, use a
hash function like MD5 in your
digital certificate, and when
you send the document to us
enable SSL in your browser’s
security settings.

Wild Wild Web

■ Japanese woman pays $1,700 to Webmaster of suicide Web site to kill her ■ The Pirate Bay acquires domain of int’l anti-piracy group
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this, but we felt pretty good
after we put completed our
hate profile. While we are
not recommending
dumping Facebook and
Orkut, Hatebook is always
an option for those crappy
days of the month when
you are apt to burst a vein.

SHARE AND DIE

RIAA
Trouble

The RIAA recently saw a
major victory in its
attempts to clamp

down on music pirates: a
court fined 30-year-old
Jammie Thomas $222,000
(Rs 8.8 crore) for illegally
uploading 24 songs. At
$9,250 a song, Ms Thomas
will have to pay a gorgeous
penny—if appeals to the
verdict fall through.

The ruling has
undoubtedly warmed the
hearts of copyright Nazis,
leaving file sharers fuming.
But we aren’t talking about
the implications or the
legalities here; we’re only
going to point out how a bad
lawyer can chuck you from
the frying pan into the fire.

After the RIAA’s
investigators had hauled Ms
Thomas in front of the jury,
her lawyer mounted
arguments which even a self-
proclaimed computer-
illiterate jury member found
laughable. The prosecution
showed that the IP address
used to upload the music
files to KaZaa matched
Thomas’ computer, and her
attorney speculated that a
hacker with a laptop outside
her apartment could be

responsible. A credible
argument, if only Thomas
had used a wireless router to
do the uploading. Expert
evidence debunked the hand
of Wi-Fi, and the attorney
was left looking like a sad
fool. The second mistake
Ms Thomas made was when
she handed over a different
hard disk to the investigators
when asked for the one
containing the offending
files. A third mistake was that
her username at KaZaa

tallied with her e-mail,
MySpace, and online
shopping logins. By this
point, the jury members
were insulted by the
shenanigans of the defence
counsel, who obviously
thought them a bunch of
hillbillies. And when that
happens, you’ll catch hell.

Only two pieces of
advice to the sad Ms
Thomas—get a smarter
lawyer next time. And a
new username.

Dietary Fibre
Jayesh, the quietest, most deserving

member of our team, this month got what
he deserved: a trip to Taiwan. Quite the desi
at heart, here’s all he had to say: “It looks
like a quiet Nariman Point—a few tall
buildings here and there.” (N. P. is where one
sees buildings tall by Indian standards.) Now
all the while he was there, Rossi was
complaining so loud about his deserving to
go, Ed shut him up by slapping a cricket bat
upon his head. Later, filled with remorse, he
wept: “I’m sorry, Rossi, for having caused you
potential death! Go to Taiwan, go, go, go!
Here’s $2.50 from my own pocket!” (Ajwani.)

And thus it came to pass: two trips across
the oceans (or land, at any rate) in a month.
Now here’s the ghastly part: J and R both
now have a contempt for Indian
food. Whereas J has taken a

liking to tubifex worms, R’s cuisine of choice
involves lizard garnished with bat wing.
(Actually, it was predictable: Jayesh is always
in office by 9, and the early bird catches the
worm—see?) Interestingly, as a result of the
unavailability of aforementioned
ingredients, they are both to be seen walking
in a pair on the street, eyeing fat street dogs.
We’re hoping it’s a passing phase.

Meanwhile, news is out that we’re
moving to a place called just “CBD,” where
Bhaskar, Michael, Ram, and Samir stay.
They’re all happy, naturally, but Ram is
actually elated because he can now have a
proper siesta every day, as opposed to curling
up under his desk pretending he isn’t there.

Digit does not guarantee the accuracy of any
of the information presented above. No libel

claims, please—worms are rich in fibre.

■ Brewery owner in New Zealand promises lifetime supply of free beer as reward for returning stolen laptop   

Steve Rubel: How the Portals Will Win the Social
Networking Wars
http://www.micropersuasion.com/2007/10/how-the-
portals.html (http://tinyurl.com/2ze3l7)
Social networking is certainly rising and there seems to
be no end in sight to the phenomenon. However, what I
do know is that people will jump around from one
Myfaceborkutspace to another and not all of them will
win. This is particularly going to be true as social
networking evolves from a destination into a feature of
every site. What does this have to do with the portals?

...No matter which social network(s) you participate
in, you’re going to turn to your trusted communication
system to manage it all. This will include any or all of
the following: a) web-based e-mail, b) instant
messaging, c) RSS and d) telephony tools like Grand
Central. And who dominates those?

Seth Godin: This changes everything
http://sethgodin.typepad.com/seths_blog/2007/10/thi
s-changes-ev.html (http://tinyurl.com/ysmefh)
Never mind the buy 1 give 1 (a great idea). Don’t wait
until November when you can directly buy laptops for
kids right here: One Laptop Per Child -- XO Giving. I just
bought five. (Hit the Donate button).

When you give a kid a net connection, access to
wikipedia and to the rest of the world, things change

fast. Things you wouldn’t necessarily predict. Like a ten
year old who can diagnose his dad’s illness. Or a farmer
that can ask his daughter to find out where to get a new
part for the tractor. Or...

The bravery: When Nicholas Negroponte and his
team started this project, they had nothing but
obstacles. The status quo of software and hardware and
skeptics stood firmly in his way. And he took a lot of grief
for the effort. Even when you’re doing nothing but good,
fear of change is going to cause a lot of people to object.

Duncan Riley: China Declares War On Western
Search Sites
www.techcrunch.com/2007/10/18/cyberwar-china-
declares-war-on-western-search-sites/
(http://tinyurl.com/yuavds)
If the Chinese Government were serious about
censorship alone, we would have reports of page not
found, not redirects to Baidu. It is clearly using its
censorship regime to the economic benefit of a Chinese
owned (but NASDAQ listed) company. Although the US
Government is a poor WTO member, given that China is
a recent member, the US Government should lodge a
complaint with the WTO. China expects free and open
access to Western nations but is now not only blocking,
but also redirecting domestic traffic away from Western
internet sites that compete with local firms.

Serious issues this
month. What’s the
connection between
social networking and
large portals? Then,
the OLPC project still
runs strong in
blogging circles... and
then, what’s gotten
into the head of the
Chinese government?
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In which part of the world is
the AZERTY keyboard most

used the most?
(a) France (b) Germany
(c) Spain (d) Russia

Starting from which version
of Windows did the

Automatic Update service begin?
(a) Windows 95 (b) Windows NT
(c) Windows 98 (d) Windows ME

Which actress co-invented
spread-spectrum

wireless technology?
(a) Hedy Lamarr
(b) Brooke Adams
(c) Nancy Allen
(d) Elvia Allman

What is the word used to
describe fake blogs created

only to show ad links?

(a) Strog (b) Plog 
(c) Splog (d) Grog

What do “Nimrod,”
“Perpetua,” and “Terminal”

have in common?
(a) They are the new versions of
MSN Messenger Microsoft is
working on
(b) They are the names of
Google’s main database servers
(c) They are fonts
(d) They are the names of
the first Web pages ever

Which of the following CEOs
appeared on the cover of

Time Magazine in 1995, titled
“Master of the Universe”?
(a) Jon Schwartzark of Sun
Microsystems
(b) Tim Wordsworth of IBM
(c) Bill Gates of Microsoft
(d) Daniel Borel of Logitech

What are the leaked memos
now called the “Halloween

documents”?
(a) Internal Microsoft documents
on Linux and open source in
general
(b) E-mails and cards sent to

relatives during Halloween
(c) Internal NASA documents that
revealed their Mars plan
(d) Internal Google documents
that revealed actual plans for
world domination

Which is the only Indian
portal to be available in

four regional languages?
(a) Indiatimes.com
(b) Sify.com
(c) Yahoo.co.in
(d) Rediff.com

9
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ACROSS
8. Convert ordinary language into code(7)
9. American multinational-leader in networking(5)
10. Electronic device that restricts current flow to
mainly one direction(5)
11. Device into which data can be placed, held
and later retrieved(7)
12. The best selling latest game on Xbox 360(4)
13. Software that periodically pops up 
advertisements on a user’s computer(6)
16. Bounded or limited in magnitude(6)
17. -----space-moves the screen cursor to the
left(4)
20. Software copied illegally(7)
22. Date and time relative to which a computer’s
clock and timestamp values are determined(5)
24. Google Mail (abbr)(1,4)
25. Web ‘crawler’ for Alta Vista search engine(7)

DOWN
1. ‘R” in ROM(4)
2. To move through a document either up and
down or sideways(6)
3. ----café - where online services are available(5)
4. New Technology File System(abbr)(4)
5. Adobe’s software program that converts documents in
PDF format(7)
6. ASCII character ESC key(6)
7. Small, compact portable computer(8)
12. The first page on a World Wide Web site(8)
14. A period or decimal point(3)
15. To load and configure a piece of software on a

computer(7)
16.A pre-established layout for data(6)
18. To exit a function or application without saving any
data(5)
19. Duplicator that copies graphic matter by the action of
light(5)
21. ‘D’ in DTP(4)
23.----drive-data storage medium(4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

Master Of The Universe!
The four ghosts in Pac Man are
Blinky, Pinky, Inky, and…

(a) Winky
(b) Stinky
(c) Roy
(d) Clyde

1

Most cell phone
companies don’t

use cellular technology
any more, yet nobody uses
the term “wireless phone.”
Calling today’s wireless
phones “cellular” is like
calling your MP3 player a
tape recorder!

Did You
Know?

Answers
1. (d) Clyde 
2. (a) France
3. (c) Windows 98
4. (a) Hedy Lamarr 
5. (c) Splog

6. (c) They are fonts
7. (c) Bill Gates
8. (a) Internal
Microsoft documents
9. (d) Rediff.com

Crossword by Nitta Jaggi

Last Month’s Solution

October’s Winner:
Yashodhara K, Karnataka 

Send in your entries to
TQ@thinkdigit.com on or
by 20th of this month. One
lucky participant will 
win Wireless and Mobile 
All-IP Networks 

By Yi-Bing Lin & Ai-Chun Pang
Published by

Win!
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It’s Infotaining
Your magazine is the best IT mag I have
seen yet. I first picked up a copy of Digit
at a friend’s bash. I enjoyed it so much
that I sneaked it out for myself. I enjoyed
reading it so much… imagine my shock
when I found out my dad too had
subscribed to Digit! my happiness knew
no bounds. From that day, I sneak the
mag out from my dad’s office. (I even got
a rubbing once, but I still keep sneaking
the mags out).

Your tips and tricks help me a lot—
those on Adobe Photoshop helped me
get the highest marks in class! Your
reviews even helped me choose the best
MP3 player for my age (14). But what I
feel is the best in your mag are the game
reviews and Agent 001.

I still have a few suggestions: Could
you bring out a Fast Track on
PowerPoint—I am real weak at it
(surprisingly!). Then, could you publish a
Digit Encyclopaedia again? It would be a
nice idea to publish each letter
separately in a month’s mag. In
addition, I’d like you to bring out
reviews on RAM.

Congratulations to you and the team
for bringing out the fantastic Sixth Sense
for your anniversary. I wish you luck!

Arun 

Hi Arun,
Glad to know that you love our magazine so
much. As for your requests, well, our October
issue did have a Fast Track to PowerPoint so
that’s done! In our November issue—this one—
Agent 001 looks at RAM, so that makes it two
down…

Digit Encyclopaedia: well, check out our
Fast Track for this issue—well, this is a different
take on it: it’s got almost everything covered
that ever happened in computing.

Do keep mailing us your feedback and
requests! 

— Executive Editor

Something For Everyone?
I have been reading your magazine for
quite some time. I have noticed that
with every month’s issue, in your
magazine, there are lesser and lesser
items in the included CD/DVD for
developers, and more and more for
gamers and others. While I can
understand the commercial interest for
inclusion of games in the CD/DVD, I
can’t understand your total negligence
of a vast number of the developer
community who as avidly wait for the
arrival of your magazine on the
newsstands.

For more than two and a half years
I have never seen your magazine
including any Fast Track booklet on
Adobe Flash, PHP & MySQL database
Web application development tutorials,
ASP, C# or the like. Also, there is very
little coverage on Linux. I’m sure there
are n number of just home users who
would like to know more about Linux—
for example, like how to install XMMS
on Linux, How to set up a LAN with
Linux (set up a SAMBA or NFS server),
how to configure a 56 kbps modem and
establish an Internet connection, how
to set up and use a printer, configure a
sound card, set up a wireless LAN, how
to use Bluetooth / infrared / USB-
enabled devices like a mobile phone to
get connected to a Linux PC/laptop to
transfer data/images/songs, etc!

Moreover, I would request you to
start a service, if possible, to send a
quick reply at the user’s e-mail address
against their problems which they send
for your Q&A section. Sometimes, one
needs to wait for two or three months
to get a reply to a PC / Laptop related
problem through your Q & A, which
actually requires immediate solutions.

Partha
Shillong

Hi Partha,
That’s a long list of Linux how-tos, and we
can certainly do some of them! The thing is,
we’re increasing the number of hands-on
articles, and we do have plenty of ideas—but
changing a format for a magazine does not
happen overnight.

About questions being answered
immediately—that would take a full-time team
of five! Yes, that’s the way it is—we simply get
too many questions. But I hope you notice
that we publish the most educative Q&As,
those that will help several readers, not just

the one who asked the question.
Finally, I’d like to say that we are not a

developer-centric magazine, and we simply
cannot please everyone. If you say you need
this, a gamer will write in and ask us for
more game reviews… mine is a tough job
indeed!

Hoping for your continued patronage.

— Executive Editor

You Are The Best: Q.E.D.!
I am a reader from the day  you started
this magazine. It had a different  then
then. Your story is one of “Survival of
the fittest.”: I had subscribed to other,
similar magazines as well but ended
with only you!

I am in Syndicate Bank as an I.T.
officer. Till date I have purchased three
desktops and now a laptop. I read your
magazine daily—all the pages—within a
period of 10—12 days. I use most of the
software you give on the CD and DVD.

We almost get suffocated by the
richness and variety of the material—
software, games, movies, etc., etc….
This month’s movie Zeitgeist is superb.

I never went to an institution to
learn IT, but self-learnt it through
books and magazines; a major share
goes to Digit. Thank you!

Arun Meshram
Nagpur

Like I’ve said earlier in this space,
Mr Meshram, it is letters like yours that keep
us going. I’m glad you like our content, but
I’m even gladder that our magazine has
helped you learn about computers and IT
without your needing to learn it formally!

— Executive Editor

Something For Everyone II
I am a civil engineer and a great fan of
your mag. I have been reading each
issue ever since I bought the first one
in May 2005. This is the first time I am
writing—in a letter full of requests.

One thing I would like to say is that
although you are a tech mag, civil
engineers and architects also use many
types of software. You have
unknowingly left an important lot
alone. I would like you to dedicate a
few pages of your mag to people who
are helping India grow rapidly (only
the tech part, I mean). If I am not clear,
then I mean, include some interviews
of people or a company like Arup (one
of the biggest engineering groups). I
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had read about it in one of your
competitor’s mag. They have provided
an article on this in 2005.

Second thing: I would like to see a
Fast Track to Linux—right from installing
any version of Linux like Fedora Core to
installing software on it. Also, a Fast
Track to character animation using any
free 3D modelling software like Blender
or Realsoft 3D or Lightwave 3D etc.

The cover design is always great, the
artwork like drawings,etc need to be
praised. The CD and DVD contents are
very satisfying, and let me tell you, I
have not purchased any software
recently because I now use the freeware
you give on your media and I don’t feel
purchasing any pirated stuff now.

Viplaw

Your requests merit very different answers,
Viplaw. First, about a Fast Track to 3D
animation—using various software—and such,
they are indeed in the pipeline. We’re trying
to cover as many popular topics as possible.
But regarding articles that would cater to,
say, civil engineers, it is purely a matter of
demand—and we’ll have to see what works
for us. I’m not dismissing it, but we will have
to take the time to look into it.

Thanks for writing in.
— Executive Editor

DVDs And DirectX
I am an avid reader of computer
magazines and have been buying Digit
issues on and off. Till date I have never
faced a problem with the CDs/DVDs
supplied with the issue, but as they
say, “There’s always a first time,” and
October’s issue of Digit was my first
introduction with a malfunctioning
DVD. I bought this issue from a vendor
in Chittaranjan Park, New Delhi. May I
request you to please send me a
replacement for the DVD of the issue.

The magazine is informative, but in
general, the topics that you cover tend
to be recurring—which is a bit
dissapointing. For example, graphics
cards is a topic which one gets to see in
the computer magazines often. The
introduction of DirectX 10 has not
brought about a huge change in the
gaming world. This may be a one-sided
view, but I do feel that this topic could
have been delayed.

It would be great if you could add
the full version of games as you done
with this issue. I came acrosss SKOAR!,
which does that, and the only problem
is that all the good games are in

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar Building
MIDC, TTC Industrial Estate, Nerul
Navi Mumbai 400 706

Digit will publish the best letters on these pages. Letters may be edited for clarity.
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For subscription queries, call the help desk at 
022-27629191 / 9200, fax 022-27629164, or 
send an e-mail to help@jasubhai.com

multiplayer format. In India the
Internet is still costly! If one can add
good single-player games, I am sure
it will add to your readership base.

Sudipta Chakravorty
New Delhi

Dear Sudipta,
I’m glad you’ve written in, but our

customer care desk does take care of
defective DVD problems—which, as you’re
aware, are bound to happen. In any case,
I’ll personally ensure your DVD is replaced.

Regarding DX10, well, some people
might say quite the opposite—that that’s
where gaming is moving to, and that we
therefore shouldn’t be stuck on DX9!
Finally, regarding full versions of single-
player games, I must tell you that sadly,
getting licenses for these is a very
expensive affair—we’d have to bump up
the magazine price hugely to compensate.

— Executive Editor

Take Thirteen
I am a regular reader of Digit. I read
the article “Take Ten” in the October
2007 issue of Digit. The article was
quite informative although the author
missed out on some of the best free
cross-platform games like Wolfenstein:
Enemy Territory, Urban Terror 4.0, and
America’s Army. Please have a look at
this excellent thread regarding these
free games: http://forums.erodov.com/
showthread.php?t=450

I hope this information is passed
onto the author of the article.

Raman

Hi Raman,
Well, we had only ten games to play with
(pun not intended), so some games would
have to be missed out... in any case, I’ve
passed on your link to the writer. I’ve also
published this here for our readers’ benefit.

— Executive Editor

The Fast Track To
Fast Track
I would like to own a copy of each of
your editions of Fast Track published
till date. If it’s possible, do inform
me regarding the procedure

Bhavya Jain

Hi Bhavya,
You can get all the Fast Track issues in PDF
format every year off our DVD. The next
one is due December 2007. Don’t miss it!

— Executive Editor

“Inevistable”?
I am an ardent reader of
your magazine, and am
surprised that I rarely
read letters from readers
acknowledging your
brilliant editorials. I am
being very frank when I say
that the article I look forward to
reading the most is your editorial. I
must compliment you on them, as every
time I find them awe-inspiring and
thought provoking.

I’d like to share with you my
thoughts on the Linux vs. Microsoft war.
The Mint distro you provided on last
month’s CD is what set off a chain of
thoughts in my mind. As I used Mint, I
was very pleasantly surprised by its
rock-solid stability, beautiful interface
and out of the box usability, It struck
me that Linux was improving at an
extremely fast rate. I say improving and
not progressing because progress can be
good or bad, but in the case of Linux,
every distro is undoubtedly better than
the other.

Now switching over to Microsoft for a
bit, we all have to accept that Vista was
very much  below everyone’s
expectations. Perhaps we all expected
too much, perhaps not. But the ground
reality is the fact that it has been a
whole nine months since the launch of
Vista, and look around, no it’s not
catching up. Vista took Microsoft over
five years to develop, and they released
an OS that did not have enough features
to make most people see reason enough
to upgrade. On the other hand, we have
so many new distros of Linux being
launched every month and each and
everyone with brand new, must have
features. Linux is clearly poised to take
the lead.

But why just poised? Why isn’t it?
There is one very simple, very obvious
reason. Software. If you want to play you
favourite game without hiccups, “stick
to Windows” is what even seasoned
Linux gurus will tell you. Same for your
favourite anti-virus, spyware scanner or
even your drivers. But things are indeed
changing. Slowly, Companies are
finding it harder and harder to ignore
the growing Linux user base.

At the end of the day, you and me
both know that eventually everyone is
going to upgrade to Vista. But the big
question is, will they do the same when
Microsoft releases it’s next OS? Or will
they double-click on the little install
icon in Ubuntu?

Omi

Letter 
of the
Month



People And Events That Grabbed The Headlines—For Better Or For Worse

We mentioned last
month that Sir Paul
McCartney doesn’t

use ATMs or e-mail. But that
doesn’t seem to stop people
from listening to and playing
his songs, and even imitating
him. Now the mail-free Macca
has signed a deal with
NowPlayIt.com, a download-
able video training service, to
hold budding bass players
through his tutorials.

The anti-Net Knight has
already recorded his first
tutorial for his song Ever Present
Past, from his recent album
Memory Almost Full.

Other artists who have
contributed tutorials to the site

include Blur, Athlete, Placebo,
and KT Tunstall. (Like you’ve
heard of them.) The tutorials
themselves consists of 30-
minute lessons—from the song-
writing process to playing
drum patterns, everything is
explained in £4 videos.

So is this to aid the cause of
his divorce compensation? £60
million is a reasonable figure,
we must say. But then we have
no idea, really, how much the
man has in his right royal bank
account, and besides, it could
well be the simple desire to
share sought-after knowledge.
Whatever the case, one can
now officially say one learnt it
from Paul!

Awise man once said:
“Boredom indicates a
temporary disconnect

with the universe.” And well,
since we’re trying to
disconnect you with the
universe anyway on this
page, why not do it the direct
way and bore you outright by
telling about yet another
leaked Internet video?

Warning: Some of the
“information” below is made up.
Reader discretion is advised, and
so is a salt shaker at hand.

So on we go: the list of
women—young, old, and in-
between—who have tried to
imitate Marilyn Monroe is
quite endless: be it on stage,
in music videos, porn flicks,
etc. Why, even sweet little
grannies have been known to
claim that just by dying their
white hair a little and
putting on $599.95 dentures,
they look like the original
upskirt woman. (Salt! Salt!)

Kylie Minogue, after her
long struggle with breast
cancer, is back in the studios;

she’s started recording for
her upcoming album, called
just “X”.

Now here’s the boring
point of our story: two songs
she wrote and recorded with
a Scottish DJ who goes by the
outrageously inane name of
Mylo were already on the
Net—and one of them was
available from Mylo’s
MySpace page. Silly of Mylo,
but it gels with his name.

A single called 2 hearts,
which was supposed to be her
comeback song—Minogue’s
first single since 2004—was
leaked, too. This one had
Minogue doing a pole dance.
(Use the salt shaker.) The
Austrylian Record Industry
Associ-eye-tion (no, really; the
RIAA does have competition
down there), in a feeble
attempt at order, removed
copies hosted anywhere in
Austrylia. Go ahead, mail
them at ARIA@some.aussies.
are.dumb that there exists
such a thing as a BitTor-
rent network.

When will the Internet
community get
mature? As in, when

will they say “cease and desist!” to
activities like the sharing of files
(much in the manner of how
young boys collect stamps) and
actually use their proof-of-adult
credit cards?

UK rock band Radiohead
decided to find out. It was a
fusion of many things: good
music (we presume), the desire to
get going with Internet culture
(they spell the album name three
ways on the cover, including “IN
RAIN_BOWS”), the noble emo-
tion of not charging $20 or so for
a CD, and more. Here’s what they
did: they released the album on
their site—www.radiohead.com—
and you could fill in any amount
you wanted in the “pay” box. 

About a third of the first mil-
lion downloaders did the square

thing and paid nothing. Some
misguided fans paid more
than $20. The average? An impres-
sive $8.

(a) What those who paid
more than $20 thinking, is our
open question to our readers.
Another open question:
(b) 2.4 lakh people got the album
off BitTorrent on the day of
release; why?

$0: Human; P2P: Divine

No News Is
Good News!

Lessons In Life After Linda?
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